GT STRUDL® Version 40
User Guide

CAD Modeler
Getting Started Guide

Release Date: November 2021

(¢ 4 HEXAGON

PPM






Notice

This CAD Modeler Getting Started Guide is applicable to GT STRUDL Version 40 and later versions for use on PCs under the
Microsoft Windows operating systems.

Copyright
Copyright © 2021 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved.

Including software, documentation, file formats, and audiovisual displays; may be used pursuant to applicable software license
agreement; contains confidential and proprietary information of Intergraph and/or third parties which is protected by copyright law,
trade secret law, and international treaty, and may not be provided or otherwise made available without proper authorization from
Intergraph Corporation.

U.S. Government Restricted Rights Legend

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was
developed at private expense and is "restricted computer software" submitted with restricted rights in accordance with
subparagraphs (a) through (d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal
Acquisition Regulations ("FAR") and its successors, and is unpublished and all rights are reserved under the copyright laws of the
United States. For units of the Department of Defense ("DoD"): This is "commercial computer software" as defined at DFARS
252.227-7014 and the rights of the Government are as specified at DFARS 227.7202-3.

Unpublished - rights reserved under the copyright laws of the United States.

Intergraph Corporation
305 Intergraph Way
Madison, AL 35758

Documentation

Documentation shall mean, whether in electronic or printed form, User's Guides, Installation Guides, Reference Guides,
Administrator's Guides, Customization Guides, Programmer's Guides, Configuration Guides and Help Guides delivered with a
particular software product.

Other Documentation

Other Documentation shall mean, whether in electronic or printed form and delivered with software or on Intergraph Smart Support,
SharePoint, or box.net, any documentation related to work processes, workflows, and best practices that is provided by Intergraph
as guidance for using a software product.

Terms of Use

a. Use of a software product and Documentation is subject to the Software License Agreement ("SLA") delivered with the
software product unless the Licensee has a valid signed license for this software product with Intergraph Corporation. If the
Licensee has a valid signed license for this software product with Intergraph Corporation, the valid signed license shall take
precedence and govern the use of this software product and Documentation. Subject to the terms contained within the
applicable license agreement, Intergraph Corporation gives Licensee permission to print a reasonable number of copies of the
Documentation as defined in the applicable license agreement and delivered with the software product for Licensee's internal,
non-commercial use. The Documentation may not be printed for resale or redistribution.

b.  For use of Documentation or Other Documentation where end user does not receive a SLA or does not have a valid license
agreement with Intergraph, Intergraph grants the Licensee a non-exclusive license to use the Documentation or Other
Documentation for Licensee’s internal non-commercial use. Intergraph Corporation gives Licensee permission to print a
reasonable number of copies of Other Documentation for Licensee’s internal, non-commercial use. The Other Documentation
may not be printed for resale or redistribution. This license contained in this subsection b) may be terminated at any time and
for any reason by Intergraph Corporation by giving written notice to Licensee.

Disclaimer of Warranties

Except for any express warranties as may be stated in the SLA or separate license or separate terms and conditions, Intergraph
Corporation disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability
and fitness for a particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed
a modification or amendment of such disclaimer. Intergraph believes the information in this publication is accurate as of its
publication date.

The information and the software discussed in this document are subject to change without notice and are subject to applicable
technical product descriptions. Intergraph Corporation is not responsible for any error that may appear in this document.

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used
or copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL
EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.



Intergraph is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data.
Users should verify for themselves that the data is accurate and suitable for their project work.

Limitation of Damages

IN NO EVENT WILL INTERGRAPH CORPORATION BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL,
SPECIAL, OR PUNITIVE DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF
REVENUE OR PROFIT, LOSS OF DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF INTERGRAPH CORPORATION HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

UNDER NO CIRCUMSTANCES SHALL INTERGRAPH CORPORATION'S LIABILITY EXCEED THE AMOUNT THAT
INTERGRAPH CORPORATION HAS BEEN PAID BY LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS
MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN
CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2)
YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION HAS OCCURRED.

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN INTERGRAPH LIMITS ITS
LIABILITY TO THE MAXIMUM EXTENT ALLOWED BY SAID LAW.

Export Controls

The Software Products and any software products obtained from Intergraph Corporation, its subsidiaries, or distributors, including
any technical data related to these products (“Technical Data”) are subject to the export control laws and regulations of the United
States. Diversion contrary to U.S. law is prohibited. To the extent prohibited by United States or other applicable laws, these
Intergraph Corporation software products and any software products obtained from Intergraph Corporation, its subsidiaries or
distributors, Technical Data and any derivatives of either, shall not be exported or re-exported, directly or indirectly (including via
remote access) under the following circumstances:

a. to Cuba, Iran, North Korea, the Crimean region of Ukraine, or Syria, or any national of these countries or territories.

b. to any person or entity listed on any United States government denial list, including, but not limited to, the United States
Department of Commerce Denied Persons, Entities, and Unverified Lists, the United States Department of Treasury Specially
Designated Nationals List, and the United States Department of State Debarred List. Visit www.export.gov for more information
or follow this link for the screening tool: https://legacy.export.gov/csl-search.

c. to any entity if Customer knows, or has reason to know, the end use of the software product is related to the design,
development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive
nuclear uses.

d. to any entity when Customer knows, or has reason to know, that an illegal reshipment will take place.

Customer shall hold harmless and indemnify PPM for any causes of action, claims, costs, expenses and/or damages resulting to
PPM from a breach by Customer or any user of the export compliance restrictions set forth in this Agreement.

Any questions regarding export or re-export of these software products should be addressed to Hexagon PPM, Export Compliance
Department, 305 Intergraph Way, Madison, Alabama 35758, USA or at exportcompliance@intergraph.com.

Trademarks

Intergraph®, the Intergraph logo®, Intergraph Smart®, SmartPlant®, SmartMarine®, SmartSketch®, SmartPlant Cloud®, PDS®,
FrameWorks®, I-Route, I-Export, Isogen®, SPOOLGEN, SupportManager®, SupportModeler®, SAPPHIRE®, TANK, PV Elite®,
CADWorx®, CADWorx DraftPro®, GTSTRUDL®, and CAESAR II® are trademarks or registered trademarks of Intergraph Corporation
or its affiliates, parents, subsidiaries. Hexagon and the Hexagon logo are registered trademarks of Hexagon AB or its subsidiaries.
Microsoft and Windows are registered trademarks of Microsoft Corporation. ACIS is a registered trademark of SPATIAL
TECHNOLOGY, INC. Infragistics, Presentation Layer Framework, ActiveTreeView Ctrl, ProtoViewCtl, ActiveThreed Ctrl,
ActiveListBar Ctrl, ActiveSplitter, ActiveToolbars Ctrl, ActiveToolbars Plus Ctrl, and ProtoView are trademarks of Infragistics, Inc.
Incorporates portions of 2D DCM, 3D DCM, and HLM by Siemens Product Lifecycle Management Software Il (GB) Ltd. All rights
reserved. Gigasoft is a registered trademark, and ProEssentials a trademark of Gigasoft, Inc. VideoSoft and VXFlexGrid are either
registered trademarks or trademarks of ComponentOne LLC 1991-2017, All rights reserved. Oracle, JD Edwards, PeopleSoft, and
Retek are registered trademarks of Oracle Corporation and/or its affiliates. Tribon is a trademark of AVEVA Group plc. Alma and
act/cut are trademarks of the AlIma company. Other brands and product names are trademarks of their respective owners.



Table of Contents

INOTICES ...ttt ettt st et ettt e h b es e b b st bbb ses bt e b eae st et ebebeseat sem et ee s eeenin iii
Table Of CONLENTS ..........oooiic et et s e b e e s b et sae s st seebe s eeenas v
O =l oY= - [ =T PRSI 10
00t I 10N i o To [V o1 { [ T OOV P ST PRPTOUPR 10
1.2. Installing CAD Modeler under Windows 10 .........ceeiviiieeiiiiieeiiiiieeesiieeesssieeesssneeeessnes 10
2. USING CAD MOGEIET ....oveieeiieeee ettt ettt ettt e e et e e e s bt e e e e s ata e e s entaeeessteeeessraeeeannes 13
2.1.  Overview of Using CAD Modeler and configuring AutoCAD/BFricSCAD ..........cccveeevenne 13
2.2, RUNNING CAD MOUEIEN ....uvvieieiiie ettt ettt e s bee e s e e s s sabee e e snneeas 13
2.3, Menu Bar and RiBDON Ar€a ........cooiiiiiieiie ettt 14
2.4. AUtOCAD/BFICSCAD COMMANAS ...cuvvviieiiieieeeeitie ettt ettt e e s s tbe e e s s bae e e s ssabeesssabeeesssnbeeas 15
2.5. AutoCAD/BricSCAD Drawing UNITS .....ccoeeeeiuieiirieeiiieeeeteeeereeereeesteeeeereeeeteeesereeeereeesveeenns 16
2.6. CAD Modeler COMMEANGS ....cooeiriieiierieenieesie ettt eesbee st seeeteesbeeseeesaeesanesbeereennes 17
2.6.1. U NS ettt ettt e et e s et e e e e e s et e et e e e e e e e abbtaeee e e e e e nnraaaeeeas 17
2.6.2. MLaEEITAIS .. ettt ettt sat e s e e sb e s e e st e e sbeeesaree s 18
2.6.3. LEVEIS .ttt sttt e b e e b e s ae e st sar e e b e neenree s 18
2.6.4. LCT4 o B T PP P PP UTUPPOPPROP 20
2.6.5. (@1 =T | AT =20 T Y[} £ PRPRPPPRRRRS 21
2.6.6. FINAING JOINES 1ot ree e e s aree e e 22
2.6.7. JOINE SUPPOITS ceeiiiii ittt e e e s s s s e e e e e s s s anbaaeeeeee s 22
2.6.8. o] gLl o o] o J=] o =TT 22
2.6.9. SECHIONS ettt 23
2.6.10.  Creating MEMDEIS. .....uiiii ettt e e e st e e e e rae e e e s aee e e e anes 26
2.6.11.  FINAING IMEMDEIS..cci ittt sttt eee e e eree e st e e e s rae e e e s aae e e s s beeeeenanes 27
2.6.12.  SPlitting MEMDEIS .. et ae e e e 28
2.6.13.  Splitting to Crossing MEMDETS .......cccuiieieciiee et 28
2.6.14.  MErging IMEMDEIS ......oeiiiiiiee ettt e e e eete e e e e eate e e e e eate e e e earee e e eneeeeeeanees 28
2.6.15.  MemMbEr ProPerti€s .....cciiiciiii ittt ettt e e e rae e e s e e e 28
2.6.16.  MEMDBEE FIIEEIS coonneeieeiee ettt ettt s st et saee s 32
2.6.17. Creating Shell Finite EIemMENtS........ccvveieiiiiiciiee et 33
2.6.18. Reverse INCIAENCE OFEr .....cccuiieiriiiiieieeieesee sttt 34
2.6.19.  FINAING SHEIIS ..ottt e e st e e e s eatae e e senraeeeeanes 34



2.6.20.
2.6.21.
2.6.22.
2.6.23.
2.6.24.
2.6.25.
2.6.26.
2.6.27.
2.6.28.
2.6.29.
2.6.30.
2.6.31.
2.6.32.
2.6.33.
2.6.34.
2.6.35.
2.6.36.
2.6.37.
2.6.38.
2.6.39.
2.6.40.
2.6.41.
2.6.42.
2.6.43.
2.6.44.
2.6.45.
2.6.46.
2.6.47.
2.6.48.
2.6.49.
2.6.50.
2.6.51.
2.6.52.

Y 11 e o T=T o R 34

JOINTS DUPIICALES ceeei i e s e e e bee e e e e ree e e e eareeas 35
o)1) K S To - T V=R 36
JOINES INTEIEIENCE.....eiiiie e e 36
V=T 00] o 1T S DIUT o] o=} < PSR UPR 37
MemMbers Zero LENGLN .......uvve it 37
PRYSICAl MEMDEIS. ... uiiiii ettt s e e e s s bee e e s nareeas 37
SHEllS DUPICAtES ...uvveiiieiiiee et e e s sbbe e e ssnsaeeeean 38
NAMES DUPHCAES .o eviiee ittt e e e bee e e s 39
RENUMBDET NAMES ..ttt ettt sre e s e 39
Database INTEEIILY c.ccuveeee ettt e e e e e e e are e e e araeas 39
MeShiNg AlONE @ CUMVE......uiiiii e e e e s 40
Meshing between tWo lINES .......coeivciiii i 42
Meshing between four lINES. ... 42
Meshing insSide @ POIYIINE ...eceeeieee e e 42
Meshing by extruding @ POIYIINE .......vviiieiieee e 44
MESHING USING 3 CUMVES ....vviiiiiiiiee ettt eeee et e e e svee e e e sbee e e e sbee e s s sbee e e ssareeas 44
N (V1D Yo 1V Y ol =Y o PP 44
Yo T I oL T = PP 45
EXPOrt to CAESAR ..., 46
Convert Lines/Polylines to Members/Shells .........cccoovveeiieicieecieeccee e 46
MOAEI WIZAId ..ottt sttt e sbe e e saree s 47
L€ (o8] o L3OO PRTRNN 48
SEIf = WERIZNT ... e et e e e et e e e e tbe e e s e ntae e e enreeas 49
LOBA CASES .ttt sttt ettt et e sttt s e sttt st e b e b e s bt e s bt e sat e st e et e e nbeenbeesaeena 49
JOINT LO@OS .ttt ettt st sa e st e e sab e s beeesareesareeeas 50
MEMDBET LOAUS. ... utiiiiiieitieeite ettt ettt et e et e st e s be e e sabeesbteesaneas 51
) 1= [ o = o [ TS PSPPSR 53
AT LOAM. .. ittt s s 53
WiNd LOAA ASCE 705.....co ittt ettt 55
WiNd LOAA ASCE 710..cciiuuieeeiiiiieeeiiieeessiieeesssreeessiaeeessereeesssabeeesssssenessnssenessnnsenas 57
NY=1 1 4L Toll Mo =T TSRO U PP PPTROTR 59
Load COMBINALIONS ....eeuiiiiiiiiieie ettt 60

Vi



2.6.53.
2.6.54.
2.6.55.
2.6.56.
2.6.57.
2.6.58.
2.6.59.
2.6.60.
2.6.61.
2.6.62.
2.6.63.
2.6.64.
2.6.65.
2.6.66.
2.6.67.
2.6.68.
2.6.69.
2.6.70.
2.6.71.
2.6.72.
2.6.73.
2.6.74.
2.6.75.
2.6.76.
2.6.77.
2.6.78.
2.6.79.
2.6.80.
2.6.81.
2.6.82.
2.6.83.
2.6.84.
2.6.85.

Standardized COmMDBINGTIONS ......uveveiiiiiiiiiiiii e reaeaeaabaaaesaaanes 61

Steel DeSigN ParameEters......cuuii ittt et e 62
LG =T (= I I USROS 63
=0 11 A C I PSPPI 64
Execute GT STRUDL ....ccoiiviiiiiiiiiiiiinic it 64
Read ANalysis RESUILS .......uiiiieiiiie ettt et e e e e 65
IMPOIT G e 66
SEEVIBWS ettt e s e e e e s e es 66
3D or Wireframe View of the Structure ........cccceevieienieniic i 66
Analytical/Physical MembBer VIEW.........cocuviiiieiiiieciee ettt e svee s 67
Colors and Visible EI@mMENtS ......cc.coviiriiriiiieeeeee e 67
1T o] 1V @ Lo Yo - PP PR 69
ANNOTATE ...ttt e 70
Select CAD Modeler’s @Ntities .......ueerveeeiiiiiieeriie et 71
Display Member LOCAl AXES........uuieicuieeeeiiiee et eetee e et e e e stee e e saree e e enaae e e aes 72
Display Member REIEASES .....ccuvveieeiiieeeee ettt et 72
Display SNell PIaNar AXES ......cuiicieiiiiiiiie s ccieee e eeieee e ertee et e e siree e e saree e s snae e e s e 72
Display JOINt SUPPOILS ..eiiiiieei ittt e s e e e srae e e e 72
Display JOINt LOAAS .....ueviieiiiie ettt ettt e e et e e e e nae e e e anes 73
Display Member LOAds ........uceiiiiieieciiee ettt e e et e e e e e e 73
Display SNEIl LOAAS ......ceeeecuiieeecieee ettt et e e et e e e e e e e 74
DisPlay Area LOAdS......uuiiiiciiieiiiieie e ecieee sttt tee e st e e st e e st e e e erre e e e sraee e e nanes 75
Display Deformed StrUuCTUIe ........ueiiicieie et 75
Annotate Joint DiSPlacemMENtS.....cccccuviiiiciiiie e e 76
Display DisplaCce@mMENTS......c.uviiiiiiiie ettt e 76
Display Member DIagrams .......ccuueeieciiieiiiieeececieee e ssiiee e st e e esiae e e e srree e s svaee s e nanes 77
Display Finite Element RESUILS.......cccciiiiiiiieie ettt 78
Display Finite Element Selection ReSUILS........cccvueeiiicieie e e 80
Display Member Code Check RESUILS ........veeiiiiiiieicieee e 80
RESUILS DAtash@ets .....ccuiieiiiiiieeieesee ettt s 81
20T oo = TU 1o [T TP PP PR 82
ClEar RESUILS LAY . .ciiiciieee it eitee sttt ettt e st e e s sba e s saaae e e s snbaeeesnnsaeeeean 82
VEISION ...eeviiiiiiiiiittt e 82

vii



T N1 o g T I T Y o] LI 3 USRS 83

70 O [ 014 o To [0 o] o DTSSR PO 83
3.2.  Open CAD Modeler and start WOrKing ........ccooceciiiiieeeiciceciiieee e e e eee s 83
3.3. Define the basic geometry of the model............ccvviiieiiiiic e, 84
3.4, Create the 15 flOOr. ...t sttt be e 89
3.5, Create the 2 flOOr....coiiuieiiciceee sttt 99
3.6, Create the 3™ flOOr ..ucuiuiiceeeeeieieetetee ettt bbbt as 101
O R O ¢ -1 N o = ol 1o V- R 104
. T O ¢ <= Y =4[ o =1 RS 109
3.9, Create an OPENING .ottt e e e e e e e e e et e e e e e e e e e e e e e e eeeeseeeeeeseeeeeees 114
3.10. O =F | (=INY U] o] o To ] o £ N 115
3.11. Check the MOdEl ... e 116
3.12. (DLl 1o Tl €T fo TU ] L PP 117
3.13. DEfINE LOAUS ...eeitieeiiee ettt ettt ettt e sb e et e e smb e e st e e s b e e sr e e e eneeesreeenns 120
3.14. GT STRUDL INPUL FIlE ettt s e 133
3.15. DiSPIAY RESUILS ....veieiiieie ittt et e e e e e e e e e sabr e e e e abre e e esasteeeenanenas 136
3.16. RESUILS DAtash@etsS .....ccocueiiiiiiiieieee ettt esbee e 144
3.17. (20T oo ol =TT [ [T PR 146
B V) (oY a T Y I 3= 0] o] (=R - 7 RS 148
A1, INErOUCTION ..ottt st st sttt b e b e sae e s eae e e s 148
4.2. Open CAD Modeler and start WOrKing .........ccocvuveeiiiiiieeiiiiee et sreee e 149
4.3.  Define the basic geometry of the model.......cccveiiiiiiiiiii e 149
4.4.  Create the bottom of the tank .......cc.eoiiiiiiiiini e 151
4.5. Create the walls of the tank ......c.cooiiiiiiiiii e 153
O TN O =T | £ I U o o] o 3N 160
4.7. Check the MOdel......ceiiiiieie ettt e s s 162
O T B 1Y £ YN €] o TU ] o LSRRt 163
4.9, DefiNe LOAAS ...ueeiiiiiiiiie ettt et e sar e s b e s neeesaree s 166
4.10. Create GT STRUDL INPUL FIlE ..eeeiiiiiee ettt st e stne e s s ntae e 171
4.11. DiSPIAY RESUILS ...vveeieeiiiie ettt et et e e e e e e e sabr e e e e abae e e enabeeeeesaneeas 175
4.12. RESUItS DAtash@ets ......cocueiiiiiiiiiieiiee ettt e 181
4.13. (20T oo ol 21U T [T PP PPP 182
T N1 o g T I T g Y o] L £ RS 183



6.

5.1, INErOTUCKION ...ttt sttt sb e s sane e 183
5.2.  Open CAD Modeler and start WOrking ..........cccceeeeeueiiiiiieee e et 183
5.3.  Define the basic geometry of the model...........ccvveeiiiiiieii e, 184
5.4, Create COIUMNS ...oiiiee ettt ettt e e st e s sre e e sare e sneeesanee s 188
5.5. Create beams and GIrdErs .......ieiiiiii it 190
LR T O ¢ T < -4 1o L= SRR 196
I A 0 1= 1 o =Y ] o] o Jo ] o £ 216
5.8,  DefiNg LOAAS ....eiiiiieiiieeiit ettt s et e sre e e saree s 217
5.9,  Perform @nalysSiS ...ccuiii ittt e e e s e areeas 218
5.10. Read @analysis FESUILS.....cccciiiei ettt e et e e br e e e b ee e e eareeas 225
5.11. Display analysis rESUILS .......ueiiiiiiee ettt e e e e e earee e e e areeas 225

Appendix — List Of COMMANAS ......ccuiiiiiciiieiciiee e e sbee e e 235



GT STRUDL® CAD MODELER
Getting Started Guide

1. Getting Started

CAD Modeler is an add-on to AutoCAD® or BricsCAD®, which allows you to create GT STRUDL
Input Files (GTI) graphically using their powerful CAD tools and graphical display capabilities and
also graphically review GT STRUDL results from an analysis and steel code check. AutoCAD® or
BricsCAD® must be installed in your computer before installing and running CAD Modeler. It is
highly recommended that you have AutoCAD/BricsCAD experience before using CAD Modeler.

1.1. Introduction
This document contains information about:

- Installing CAD Modeler

- Configuring AutoCAD/BricsCAD and running CAD Modeler for first time
- List of CAD Modeler Functions with detailed explanation for each one
- Tutorial examples

- Summary of CAD Modeler commands

1.2. Installing CAD Modeler under Windows 10
In order to install CAD Modeler check the box “Install CAD Modeler” on the form shown on the
next page during the GT STRUDL main installation procedure.

An AutoCAD version (2017-2022) or a BricsCAD version (Platinum or Pro 17.1.x, 18.1.x, 19.x, 20.x
or 21.x) has to be installed in the computer prior to CAD Modeler installation.

GTSTRUDL 40 Installation Opticns
Installation folder
| C:\Program Files\GTSTRIIDL

CAD Modeler

v Install CAD Modeler Cancel | Install |

CAD Modeler Installation can also be launched independently, after GT STRUDL installation, by
executing the file “CADM_setup.exe” which is in the CADModeler folder in the GTStrudl 40
installation directory. The following steps are common regardless if the installation was
launched from the GT STRUDL main installation or independently.
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The first screen is a welcome dialog that prompts you to choose at least one version of the
AutoCAD or BricsCAD CAD Modeler Interface to be installed depending on the versions of
AutoCAD or BricsCAD that are currently installed in your computer.

i setup - CAD Madeler 40 - *®

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Next when you are ready to continue.

Custom installation w
CAD Modeler Main Files 13.2MB A

BricsCAD v21 64-bit Interface 6.1MB

BricsCAD v20 64-bit Interface 6.1MB

[ BricsCAD v 19 64-bit Interface 5.9 MB

[ BricsCAD v 18 64-bit Interface 6.2MB

[ BricsCAD v 17 64-bit Interface 6.2MB

AutoCAD 2021 64-bit Interface

I:‘ AutoCAD 2020 64-bit Interface 5.7 MB

"1 AutoCAD 2019 &4-bit Interface 5.7MB ¥

Current selection requires at least 34.6 MB of disk space.

The next screen summarizes your selection and by pressing “Install” the installation procedure
starts.

i setup - CAD Madeler 40 - *®

Ready to Install
Setup is now ready to beain installing CAD Modeler on your computer.,

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Setup type:
Custom installation

Selected components:
CAD Modeler Main Files
BricsCAD w21 64-bit Interface
BricsCAD w20 64-bit Interface
AutoCAD 2021 64-hit Interface

< Back Install Cancel
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CAD Modeler is installed in the same installation directory with GT STRUDL, under the sub-
directory “CADModeler”. For example,“C:\Program Files\GTSTRUDL\40\CADModeler” is a
typical CADModeler installation directory.

When the copy process is completed, a new dialog named “Finalizing Setup” appears and you
are prompted to enter the corresponding AutoCAD and/or BricsCAD Installation Directories.

Setup ﬁ

Finalizing Setup

AutoCADA2021x64 Installation Directary

C:\Program Files\Autodesk\AutoCAD 2021 []

End | | Cancel |

Setup ﬁ

Finalizing Setup

BricsCADB2021x64 Installation Directory

C:\Program Files\Bricsys\BricsCAD V21 en_US []

End | | Cancel

Press the browse “..” button to find and select the file “acad.exe” or “bricscad.exe”, in the
AutoCAD or BricsCAD installation directory, and press “Open”. The name of the directory is
copied to the corresponding edit box, and by pressing “End”, the installation is complete.

12



2. Using CAD Modeler

2.1.  Overview of Using CAD Modeler and configuring AutoCAD/BricsCAD

CAD Modeler can only be launched directly by GT STRUDL; by initializing an instance of AutoCAD
or BricsCAD and automatically loading CAD Modeler ARX/BRX Application (CADModeler) in the
same instance. CAD Modeler creates a separate AutoCAD/BricsCAD user profile, named
“CADModeler”, so the CAD Modeler menus, icons and ribbons do not affect your standard
AutoCAD or BricsCAD environment, or other applications running on the top of them.

CAD Modeler commands can be accessed from the menu, from the ribbon area, or by typing the
specific command in the command prompt.

- If AutoCAD/BricsCAD Menu is not turned ON, you have to type "MENUBAR" in the
command prompt, and then enter 1.

- If AutoCAD/BricsCAD Ribbon is not turned ON, you have to type "RIBBON" in the
command prompt.

All GT STRUDL structural data, which are created using CAD Modeler, are stored in two files: the
.dwg file which contains the AutoCAD/BricsCAD information, and the .db file which contains the
structural data. The two files have the same filename (only the extension is different) and they
are linked together by CAD Modeler.

CAD Modeler creates a GT STRUDL Input File (.gti) and is able to send this .gti file to the main
instance of GT STRUDL, which sits on the background. When analysis is performed in GT STRUDL
and results are available for reading, CAD Modeler is able to load them from GT STRUDL DBX
(data base exchange) files.

Since CAD Modeler is launched and licensed by the main GT STRUDL application you are not
allowed to close the main GT STRUDL window. If GT STRUDL is closed, CAD Modeler outputs a
warning and CAD Modeler commands are no longer functional.

2.2.  Running CAD Modeler

CAD Modeler is launched from the GT STRUDL Welcome screen by selecting the “CAD Modeler”
icon in the Start a New Project group. A new instance of AutoCAD or BricsCAD, having CAD
Modeler automatically loaded, is created. You will be able to identify that CAD Modeler is
loaded successfully by having two additional menus (“GTS Modeling” and “GTS Display”) next to
the AutoCAD or BricsCAD main menus and the “GTS CAD Modeler” and “GTS Display” tabs in the
ribbon area.
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2.3. Menu Bar and Ribbon Area

CAD Modeler commands can be accessed from AutoCAD’s or BricsCAD’s Ribbon Area at the top
of the window by selecting the two tabs at the right: GTS CAD Modeler and GTS Display. CAD
Modeler now support BricsCAD version 20 including all new functionality and the dark scheme.

Home  sen otsle Pameine  Veew  Minsge  Ouipt | Coliberte  GTMedebng  GTidaply (s
Higher bevel @ Ganerste # Marg Finl et + 3 s OB A, Frame ] £ Annctate
s Avweies wsome T p | p o s B2 e
9 i L |1 T ecrom Gonerite rtcal Spit T o e ¥ " I B =, W ResdiBouts I fnshtealPhyuesl View *
F Allewis 0N B Suppot - Drign (W Joints Dupbcres = [ e Cumve 20urven” Etrde” Advanced 3 impon GT (@ Gptions © Cokn | (@ Clawr
Mectnl Leves Sy Merrter, Find/ChangeCheek  Shally Mg Adheanced  Geeups Leady GTSTRUDL Dnplay Iequre

Home  Insert Annotate  Parametric  View Manage OQutput Collaborate  GTS Modeling  GTS Display =~

X Units & Joint Supports |/ Deformed ~ [V Displacements [ Displacements [ Reactions A Frame AT 3D
& Jeint BT Shell o
> Member Local Axes /' Releases » wr Diagrams (%5 Code Check 51 Member Forces [l Stresses o = Analytical/Physical (@ Set View T
3 Member Area epo ear
& Shell Planar Axes o Elements & Selection BB SectionForces [ Code Check  Builder {57 Options C Colors
Display Model Display Loads Display Results Results Datasheets Report Display Clear

If the AutoCAD or BricsCAD menu is visible, then CAD Modeler commands can be accessed from
the Menu Area at the top of the window by selecting GTS Modeling or GTS Display.
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GTS Modeling

% Units
Import

B Materials

Cross Sections

Levels
Grid

Groups

Joint
Member

Shell

Soil Springs

Mesh Generation

Loads

Checks

Steel Design Pararneters
GT STRUDL

CAESARII
D Convert Lines/PolyLines to Members/Shells
#  Model Wizard

2.4. AutoCAD/BricsCAD Commands

You can use AutoCAD or BricsCAD commands, such as Move, Copy, Rotate, Mirror and Delete to

GT5 Display

Frame

3D Sections
Analytical/Physical
All Levels ON

Q!

Set View

Colaors...

] O

Annotate...

Member Local Axes
Display Member Releases
Shell Planar Axes

loint Supports

loint Loads
Mermber Loads
Shell Loads
Area Loads

Deformed Structure
Undeformed Structure
Displacements

Mermber Diagrams

Element Results

Element Results Selection
Member Code Check Results

NNdI=~ BEEH= FEN\NY

d

#|  Clear Results Layer
Results Datasheets
Options...

@ Current Version...

generate your model faster. The assumptions made in the use of each command are:

- Move: By moving a joint, the members and finite elements connected to the joint

“follow” this movement

- Copy: Joint, Member and Element Loads and Supports are not copied

- Mirror: Joint, Member and Element Loads and Supports are not copied or mirrored. The
Beta Angle of members is not mirrored. Element incidence order is mirrored so that

element’s orientation, that defines the Z Planar Axis, remains the same.
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Delete: If a joint is deleted, there is a prompt that asks for confirmation since members
and elements connected to this joint will automatically be deleted as well.

2.5.  AutoCAD/BricsCAD Drawing Units
It is recommended that you set the AutoCAD/BricsCAD drawing units to Decimal. This can be
done from the lower right corner of the main application window, as displayed in the next

image, or by typing the command UNITS.

Architectural
+ Decimal
Engineering

Fractional

Scientific

B ~ 4 | Decimal = []

& Drawing Units
Length Angle
Type: Type:
Decimal W Decimal Degrees W *

Architectural Precision:
Sets the current format for units of measure, The values include

Engineering : . : . : = [Nt
Fractional Architectural, Decimal, Engineering, Fractional, and Scientific. The
Sciertific Engineering and Architectural formats produce feet-and-inches

displays and assume that each drawing unit represents one inch.

Insertion scale | The other formats can represent any real-world unit.

nits to scale ins

Millimeters L

[E COrreETI.

Sample Output
1.5,2.0039,0 ]
3450 _

Lighting
Units for specifying the intensity of lighting:

Intemational L

Cancel Direction... Help

As written in AutoCADs’ documentation “The Engineering and Architectural formats produce
feet-and-inches displays and assume that each drawing unit represents one inch. The other
formats can represent any real-world unit”. Therefore, if you select Engineering or Architectural
formats you have to set CAD Modeler Length Units to Inches. (see Units Command)
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2.6. CAD Modeler Commands

2.6.1. Units

The following form is used to define the active units, either from ribbon command &K Units or
from the menu “GTS Modeling>Units” or by typing GTSUN I ts at the command prompt.

Units >
Length Force Angles
() Inches {in) () Pounds (bs) (@) Degrees
i) Feet (ft) (O Kips () Radians
(@) Meters (m) () Tons () Cydes
() Centimeters {cm) () Kilograme
() Millimeters {(mm) () Metric Tons Time
Temperature C.'J Mewtons @ Seconds
() Fahrenheit (®) KiloMewtons () Minutes
(@) Centigrade () MegaMewtons (" Hours
Sn:;:le nc'n-sh'un:tl_!ral CAD entities
(grids, structural lines, curves etc) Cancel

You can change the Units any time during working in CAD Modeler. Moreover, you can choose if
the non-structural AutoCAD/BricsCAD entities, such as grids, structural lines, curves, polylines,
etc will be scaled together with the structure whenever you change the length units.

As noted in 2.5, if the Drawing Units are in Engineering or Architectural format then you have to
set the CAD Modelers’ Length Units to Inches (in) using this Dialog.

The current units appear at the top of the main CAD Modeler window:

GTS CAD Modeler | M KN DEG FAH SEC | Drawing1.dwg

Note: Some Edit Boxes appear in yellow background and green fonts, like the one at the picture
below. You can use mixed units in the yellow edit boxes. For more information about Mixed
Units and the valid syntax, please read GT STRUDL GT Menu Guide.
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Joint Coordinates and Offsets
Coordinates

2487.85

1544.03

i

2.6.2. Materials
The following form is used to modify existing material properties or create new materials. You

. . . 2 Material
can select this command either from the ribbon command = arera or from the menu “GTS

Modeling>Materials” or by typing GTSMaterials at the command prompt.

X

Material

Material Properties

D Name E G Density Poisson CTE

1 Steel 1.9994800E+08 7.5842000E+07 7.6901000E+01 3.0000000E-01 1.1700000E-05
Concrete 2.4821100E+07 9.9284600E+06 2.3561600E+01 1.7000000E-01 9.90D0000E-06
Aluminum 6.8947600E+07 2.5855400E+07 2.6601800E+01 3.3000000E-01 2.34D0000E-05

AddMaterid | Delete Material oK | Cancel

2.6.3. Levels

It is optional to define Levels (stories) in your structure. However, it is recommended that you
do so when modeling industrial or other building-like structures as this will save you time during
the creation of your model. You can access the level properties dialog from the ribbon icon

=

Levels or from the menu “GTS Modeling>Levels” or by typing GTSLevels at the command
prompt.

Using the Level Properties form you can:
- Set the Height for each level, in current length units
- Define the visible status of each level: if Visible or not
- Add Levels to the model
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- Delete Levels from the model

- Detect Levels Automatically using an algorithm to detect levels along the height of the
structure by identifying locations having at least four horizontal members.

- Merge Levels, by selecting two or more levels and merging them to one.

- Define if the Vertical Axis is the global Z or global Y.

- Update Levels for All Entities, in order to assign the correct Level to each entity (joint,
member or finite element) depending on its coordinates along the height of the

structure.
Level Properties
Level Heights Options
Levels Height Elevation | Visible | AddLevel |
] 4 4000000 ||
2 3.000000  7.000000 [v | Delete Level |
3 3.000000 | 10.000000 |[v
| Detect Levels Automaticaly |
| Merge Levels |

Base Elevation 0.0000

Z Vertical Axis (glse )

[ ]update Levels for Al Entities

ok || concel |

After defining Levels, you can switch between levels by either using the “Visible” check boxes

from the Level Properties form, or using the dh Higher Level and ¥ Lowerlevel joone in the
ribbon area. You can also type GTSLeve lUp and GTSLeve IDown at the command prompt.

Moreover, you can define a grid system and/or generate vertical members (Columns) with a
single click. These commands will be explained below.

Finally, the current level, if defined, appears at the top of CAD Modeler window, next to the
Current Units.

GTS CAD Modeler | M KN DEG CEN SEC | Level: 2

19



2.6.4. Grid

A Grid system can be defined and used as a pattern for entering beams and columns. In order to
be able to enter a Grid, you must first specify Levels in your structure (see the Levels command
above). You can access the Grid dialog by expanding the “Levels” tab from the ribbon icon

Grid  or from the menu “GTS Modeling>Grid>Create” or by typing GTSGrid at the command

prompt.
Grid
Placement Angles Apply to Levels

® Hori o _ _ 0.00
(@) Horizontal (] Sidelong Grid Angle X-Axis : 1
2
Horizontal - Sidelong Angle : 50.00 3
Spadng 4

Labeling
Distance: | 7+0000
5.0000 Show Labels
©.0000
0.20
- Mumbers Distance : 1.00
Edit
: Pasition
Lesis (@) Left (") pight
Type
(®) Numbers () Letters
Start From : i W

OK Cancel

Using the Grid form you can:

Set different parameters for the Horizontal and Sidelong directions of the grid.

Define and control the spacing in each direction, by entering the desired spacing —
Distance of the new grid line and pressing Add button. Later on you can edit a specified
spacing or delete it, using the corresponding buttons Edit and Delete.

Define the Angle between the Grid X-Axis and the global X-axis

The Angle between the Horizontal and Sidelong lines (default equal to 90 degrees)
Control the Height of fonts

Control the Position of the labels

Control the Type of identification to be either Number or Letters

Control the Starting From item, which can be a number or letter depending on the Type.
Select the levels that this grid will be applied to. You can apply the grid to more than
one levels and/or have multiple grids per level.

By pressing OK, you are prompted to enter the Insert Point of the grid, meaning the coordinates
of the lower left corner of the grid. The grid lines are then created as shown in the figure on the
next page.
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You can also change the properties of an existing grid from the menu “GTS
Modeling>Grid>Change” or by typing GTSGridChange at the command prompt, and then
selecting the Grid to be edited.

2.6.5. Creating Joints

You can generate individual joints from the ribbon command B GEN€rEte op from the menu
“GTS Modeling>Joint>Generate Joint” or by typing GTSJoint at the command prompt. You
then must enter the X,Y,Z coordinates (separated by comma) or click at the corresponding point
at the screen. However, for frame structures, it is recommended to start generating members
(and joints will be automatically generated at their ends).

If you have already defined Levels at the structure, you can generate individual joints at the

current lever from the ribbon command & AtLevel or from the menu “GTS

Modeling>Joint>Generate Joint at Level” or by typing GTSJointLevel at the command
prompt. You then have to enter only X and Y coordinate (Z will be calculated using the current
Level’s Elevation).
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2.6.6. Finding Joints

You can find an individual joint from the ribbon command Find Jeint or from the menu “GTS

Modeling>Joint>Find” or by typing GTSFJID at the command prompt and enter the name of
the Joint. If the joint name exists, the joint will be selected (by clicking on “change”, you can
modify it without making a new selection).

2.6.7. Joint Supports

You can find an individual joint from the ribbon command B Suppert o0 from the menu “GTS

Modeling>Joint>Support” or by typing GTSJointSupport at the command prompt and
select the joint or the joints to be supported. The Joint Properties form then appears, where you
can define which degrees of freedom are fixed and also enter a spring value in case of elastic
supports. Using the Quick Selection, you can quickly define a Fixed, Pinned or Free Joint (by

default all joints are free)
Restraints & Spring values

Quick Selection : Pin W
Restraint Spring Restraint  Spring

Fu 01 Mmx a
Fy 0] My 0
Fz 0 [Imz .

2.6.8. Joint Properties

You can change the properties of a joint from the ribbon command "% Change Joint or from the

menu “GTS Modeling>Joint>Change” or by typing GTSJointChange at the command
prompt and select the joint or the joints to be edited or by double-clicking on an existing joint.

22



Jaint Properties X

Model  Joint Generalized Loads

General Joint Coordinates and Offsets
Name : Coordinates
Level: o L 1
'
0
2,
Rotation
theta X : I:I Restraints & Spring values
tewr: | O]
Quick Selection : w
tewze | O]
Restraint Spring Restraint  Spring
Groups [ IFx | 0 | [T | 0 |
Inactive Remove [IFy | 0 | [y | . |
Groups that joint belongs [JFz | D| [Imz | D|

Cancel Apply Help

The “Joint Properties” form appears, and at the “Model” tab you can enter the Name of the Joint
(up to 8 characters) the Level that the joint belongs (optional), the theta rotation angles for
rotated support joints, the Groups that the joints belongs to, the coordinates of the joint in the
current unit system, the restraints of the joint and the spring values.

If you select more than one joint, then “Multiple Selection” appears at the top of the Joint
Properties form, and all data entered in the form will be applied to all selected joints.

2.6.9. Sections

For models which contain frame members, you should select the cross sections to be added to
your project either from the default cross section library or by creating user defined prismatic
cross-sections or by importing user defined cross sections that have been created in GT STRUDL.

Prismatic cross sections can be created from the Menu “GTS Modeling >Cross

Sections>Prismatic” or by typing GTSPrismatic at the command prompt.
In the dialog shown below, you enter the cross-section properties in the current unit system.
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Prismatic Properties

MNew Section Properties

Section Mame (Up to 15 Characters) : Cancel
A I

Ay Ty :

Az Iz:

Sy Ey:

5z Ez:

Yd: Yo

id: IZc:

Shape Code :

You can access the existing cross section library (GT STRUDL tables) from the ribbon command

L

Sections  or from the Menu “GTS Modeling>Cross Sections>Table” or by typing GTSParams at
the command prompt.

Using the following form, where all GT STRUDL built-in TABLES are available, you select the cross
sections for your project by double clicking on them, at the right part of the screen. The list of
selected cross-section profiles appears at the left part of the screen and the selected profiles
have a large black dot in front of them.

User defined cross sections, that have been created in GT STRUDL, can be imported in CAD
Modeler from the Menu “GTS Modeling >Cross Sections>Import from User Dataset” or by typing
GTSOpenDS at the command prompt. Using the “Select User Dataset DS File” dialog you can
select the dataset file (*.ds) that includes the user defined cross sections to be imported. By
pressing “Open”, the cross sections of the selected .ds file are added to the available built-in
TABLES, presented in the previous paragraph.
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SS :;gg i;? ES:EE: h;;;'c W40x211  W3Sx135  W30x99 W24x162  WZIXSS W 16x 100
o _ W40x183 W33x387 W30x90 W24k 146 W21x48 W16x89
E-E] AISC 13th Edition 2005 Metric W40k 167 VW33x354 VW 27x539 W24x131 W21x57 W16x77
i AISC 9th Edition 1939 W40x149 W33x318 W27x368 W24k 117 W21x50 W16xET
@-F 1 AISC LRFD 3rd Edition v
L4 > £ >
Cancel
Moreover, you get a notification at the = Unigtrut
command prompt, regarding the number of = Uszer Defined Sections
tables that exist in the dataset. For example: L HvaISC14
“Number of tables in ds = 5”. Cac
e MYLUMT3
[ MYRECHSS

i T ABEAMY

Next time you select the command =&ctions
you will be able to see the user defined
sections at the bottom of the list.

Note: Whenever you import a TABLE of sections that has been previously imported in CAD
Modeler, all new data will overwrite previous TABLE section data.

Note: Whenever you use a User Defined Section in CAD Modeler, you must manually open the
corresponding .ds file in GT STRUDL prior to the “Execute GTSTRUDL” Command.
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2.6.10. Creating Members

Y

You can generate individual members from the ribbon command Generate or from the menu
“GTS Modeling>Members>Generate Beam Members” or by typing GTSBeam at the command
prompt. You must then enter the X,Y,Z coordinates (separated by commas or click at the
corresponding point at the screen) of the member start and then of the member end. Joints are
automatically generated at both member ends, unless a joint already exists at the specific point.
If so, the member is connected to the existing joint(s).

If you have already defined Levels at the structure, you can generate vertical members

l

(columns) at the current lever from the ribbon command Yertical or from the menu “GTS
Modeling>Member>Generate Vertical Member” or by typing GTSColumn at the command
prompt. You then have to enter only one point (starting top point) in the floor plan. The ending
bottom point will be automatically calculated, having the same X and Y coordinates, and Z
coordinate will be calculated by the current level’s height.

After giving the command the “Place Member” form appears, where you define the properties
of the member.

Note: Each time you create a member, the orientation of the cross section will appear in the
middle of the element, unless you clear it with command “Clear” (see 2.6.84).
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You can select:

- A Table Section from the list of
available sections in the
project, or give the dimensions

or Membar Dimansions: of the typical shapes available
or match the section properties

Cross Section
Table Section:
<5elect Table Section = w

Rectangle Concrete e o

of one existing member to save
or 5ame as Member: time typing the values.
<5elect Existing Member = w - The Material from the list of

available materials in the
Material project

- Common Member

Steel w . .

Releases configuration
Relemne Beta (o) - Beta angle (in degrees)

- To split intersecting members,

00 Pin-Pin ol along new member’s length,

including the new member

[«] Split Intersecting Members []Physical Member - To split ending members, if the
] 5piit Ending Members member starting and/or ending
joints are placed along existing

Place Member(s) == members.

- To place a physical member
Section Properties together with the analytical
members. If the new physical
I:I member is crossing other
B .

physical members, the new
I:I physical member will be split

into more parts.

I
H +_§ Then, you must click on the “Place
l Member(s) >>” button and start placing
_____ . members.

% B *

You can change the properties while
the command is active, and the next
member(s) will be placed using the new
values.

When you are done, press ESC to exit from the command. The form is hidden automatically.

2.6.11. Finding Members

. Find Memb
You can find an individual member from the ribbon command e ViEmBeEr or from the

menu “GTS Modeling>Member>Find” or by typing GTSFMID at the command prompt and
enter the name of the Member. If member name exists, the member will be selected (by clicking
on “change” you can modify it without making a new selection).
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2.6.12. Splitting Members

7

You can split a member into two or more parts from the ribbon command 5Pt or from the
menu “GTS Modeling>Member>Split Member” or by typing GTSSplitMember at the
command prompt and select the Member to be split. You then define “Distance for splitting the
member or the number of equal parts (negative number)”, entering:
- the position of the split, meaning the length of the 1% part starting from starting joints,
or
- the number of equal parts that will be generated after the split, by typing a negative
number. For instance, entering -3 means to split the original member into 3 equal parts.

2.6.13. Splitting to Crossing Members

You can Split Members to Crossing Members, after being placed. You select the member to be
spit and if there are any crossing members the selected member is split automatically at their
intersections. You can split a member into crossing members, from the ribbon command

x Split to Members
or from the menu “GTS Modeling>Member>Split to Crossing Members” or
by typing GTSSpl itToMembers at the command prompt and select the Member to be split.

2.6.14. Merging Members

You can merge two members to one member from the ribbon command / Merge or from the

menu “GTS Modeling>Member>Merge Members” or by typing GTSMergeMembers at the
command prompt and select two members. The two members must have a common joint
(middle). After merging the middle joint is NOT deleted and you have to delete it manually. This
joint can be removed manually, using AutoCAD’s/BricsCAD’s erase command, or by using CAD
Modeler’s “Remove Floating Joints” Command.

2.6.15. Member Properties

. . "T Ch Memb
You can change the properties of a member from the ribbon command ange VEMBEn or

from the menu “GTS Modeling>Member>Change” or by typing GTSBeamChange at the
command prompt and select the member or the members to be edited or by double-clicking on
an existing member.

The “Member Properties” form appears, and at the “Model” tab you can enter the Name of the
Member (up to 8 characters), the Level that the member belongs to (optional), the Type of the
Member (Space Frame or Space Truss), Starting and Ending Joints, Beta Angle, the Groups that
the member belongs to, the Cross-Section applied to this member and the corresponding
section properties, the Material of the member, member releases and elastic end connection
spring values, End Sizes and global Member Eccentricities.
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Member Properties x

Model  Section Properties Member Loads Member Temperature Loads Member Distrortions

General Section Properties Releases & Elastic Connection spring values

Mame : Section : Quick Selection : -
Level : Ax -

| |Ix: | | Start  Spring End  Spring
we | e | | om [ om[ °
Type - Incidences Az: | | Iz: | | Oy I:I Oy I:'
Type SaEETE - Sy | | Ey: | | Or:z I:l Or: I:l
Start 1 Sz | | Ez: | | v |:| [Imx I:|
T I P I = e P )
Beta Angle : l:l : | |Zc: | | [mz I:I [z l:l

Physical Member

Shape Code : I:I
End Sizes OR Member Eccentricities (Offsets)

Groups Start End
Material Properties

Inactive o Remove . I:I
Material ; |Steel | | Sizes : :

Groups that Member belongs
- |1.9994BE+DB|DEHSM| ?6.9[J:l| o I:I . I:I
N o [ ) R S
posson | ©?| 2 [ oa [ 9]

Cancel Apply Help

Using the “Section Properties” tab, you can define typical concrete shapes or other shapes that
appear in the next image. Shapes having the identifier “Concrete” should be used for thick
sections.
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If you select more than one member, then “Multiple Selection” appears at the top of the
Member Properties form, and all data entered in the form will be applied to all selected
members.

Physical Member Properties
Model | Section Properties | Member Loads
General Section Properties Releases & Elastic Connection spring values
MName : z d Section : | I[PE270 IPE European Quick Selection : W
1
Level ! A : 0.0045% | . L.6e-07 Start  Spring End  Spring
Ay 0.00164736 Iy : 4, 2e-06 |:| Fx 0 |:| Fx 1]
Type - Incidences Az 0.001838 Iz: 5.79e-05 DFY 0 DFY o
. 6,2222e-05 . 0 0 a
Type: | SPACEFRAME v S By: LFe L
ot . - 0.00042889 | L. o [ o] [Jux a
. 0.27 . 0.135
End : 18 Yd: ve: [Imy 0 [CImy o
. 0.135 . 0.0675
Beta Angle : =0 z: e OMz 0] Oue D
. 1.0
Physical Member PM000003 Shape Code :
End Sizes OR Member Eccentricities (Offsets)
Groups Start End
3 Material Properties
Inactive e Emove . [i] [i]
el Moo Material : | Steel b = Sizes :
Analytical Members
;g E. 1.99948e+08 Density 756,901 e 0 X i}
15 G 7.5842e407 | . | 6.49855¢-06 . [ 0
21 ' ' ' '
Poisson 0.3 Z: L Z: g

Cancel Apply Help

If you select a physical member, then “Physical Member Properties” appears at the top of the
Member Properties form, and you can modify the properties of the Physical Member. You can
only modify the Name, Beta Angle, Section Properties, Releases and Eccentricities. Any
modification applies to all analytical members, except Releases and Eccentricities that apply only
to the start of the first analytical member and to the end of the last analytical member.
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Moreover, you can see the list of labels of the Analytical members that are part of this Physical
Member.

If you apply any loads to the physical member, the load parameters are copied to each analytical
member belonging to it.

2.6.16. Member Filters

You can select members of the structure, that fulfill several criteria, using the icon Y Filter or
from the menu “GTS Modeling>Member>Filter” or by typing GTSFilterMembers at the
command prompt.

Members can be filtered forming queries of three different categories:
- Their Properties, that can be: Name, Level, Section, Material, Beta Angle, Group,
Release Statues, Kf values, Eccentricities and End Sizes
- Their Loading Data, that can be: Load Case, Load Type, Load Direction, Load Values and
Location.
- Their Analysis Results, that can be: Load Case, Member Forces Fx — Fy — Fz — Mx — My —
Mz for both ends and section forces Fx - Fy — Fz - Mx — My — Mz.

You can set multiple (up to 5) conditions of the same category using logical expressions (AND,
OR). For example, filter members that their section is IPE330 AND they belong to level < 3 AND
their beta angle is greater than or equal to 90.

After the query is formed, your press “Execute >>" and the IDs of the members fulfilling the
criteria appear in the “Results” list.

Filtered members may be:
- Added to any Group
- Selected as AutoCAD’s/BricsCAD’s selection (to be edited, moved, copied, moved etc),
using the option “Keep Selected after closing form”
- Made the only visible entities of the structure, by hiding all other entities, using the
option “Make them the only visible”
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Filter Members

SELECT Members oK
Section W = w | | IPE330 IPE European W Cancel
AND V| |Level v < v |3 v
AND % petg Angle v = W | |90 W
N W = L] W
W W = W hd
Member Loads (Units: kM, m) Member Results [ Section Forces
Y] v ] ] v ]
] Y] v ] ] Y] v ]
] ] v w ] ] v w
] Y] v ] ] ] v ]
v ] v v v ] v v
SQL Query (WHERE) Result
9
{ nSection ='2') 10 e
AND (nLevel <'3') 11
AND ( betatngle =='30") 12
13
14
15
15
Execute => Clear 17
13
19
Action 20
Ttems Selected: 70 21
ms Selec %
23
24
ADD To Group == v a5
28
[keep Selected after dosing form [1Make them the only Members Visible 23 w

2.6.17. Creating Shell Finite Elements

Shell finite elements are generated automatically using the meshing functions described below.
However, you can generate individual quadrilateral or triangle shell elements one by one.

&

Quadrilateral elements can be created using the icon * or from the menu “GTS
Modeling>Shell>Generate quad at joints” or by typing GTSShell at the command prompt.
You must then enter the X,Y,Z coordinates (separated by commas or click at the corresponding
point at the screen) of the four corners of the quad element. Joints are automatically generated
unless a joint already exists at the specific point. If so, the element is connected to the existing
joint(s).

: Chuad

Triangular elements can be created using the icon * s Mangle o1 from the menu “GTS

Modeling>Shell>Generate triangle at joints” or by typing GTSShellT at the command
prompt. You must then enter the X,Y,Z coordinates (separated by commas or click at the
corresponding point at the screen) of the three corners of the triangular element. Joints are
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automatically generated unless a joint already exists at the specific point. If so, the element is
connected to the existing joint(s).

2.6.18. Reverse Incidence Order
The Incidence Order (clockwise or counterclockwise) of selected shell elements can be reversed

using the icon [& Reverse 4 from the menu “GTS Modeling>Shell>Reverse Incidence Order” or
by typing GTSShel IReverse at the command prompt. The Incidence Order defines the
orientation of the Element’s Planar Z and Local Z Axes which then also affects the Local and
Planar X and Y Axes.

2.6.19. Finding Shells

T2 Find Shell
You can find an individual shell element from the icon ** " = or the menu “GTS

Modeling>Shell>Find” or by typing GTSFEID at the command prompt and enter the name of
the element. If the element name exists, the shell element will be selected (by clicking on
“change” you can modify it without making a new selection).

2.6.20. Shell Properties

You can change the properties of a shell finite element from the icon or the
menu “GTS Modeling>Shell>Change” or by typing GTSShellChange at the command
prompt and select the shell or the shells to be edited or by double-clicking on an existing shell
element.

Change Shell

The “Element Properties” form appears as shown below, and from the “Model” tab, you can
enter the Name of the Element (up to 8 characters), the Level that the element belongs to
(optional), the Type of the Element, Joint Incidences, the Thickness of the shell, the Groups that
the element belongs to and the Material of the element.
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Element Properties

Model | Element Loads

General Material Properties
Mame : 2 Material : | Concrete W
Level : L
E: 2.43211e+007 Density 23,5618
a: 9.92346e +008 cTE : 9,9e-008
Type - Incidences . 017
Poisson
Type : SBHQG b4
Groups
Joint 11 3
Inactive v Remove
Joint 2 4
Groups that Element belongs
Joint 3 B
Joint 4 18
Section Properties
Thickness : 0.2
Area :
Cancel Apply Help

If you select more than one element, then “Multiple Selection” appears at the top of the
Element Properties form, and all data entered in the form will be applied to all selected
elements.

2.6.21. Joints Duplicates

In order to erase joints that have the same coordinates (one on the top of the other) that may
have been generated by mesh generation functions, you have to check the model for duplicate
I:|n Joints Duplicates
joints from the ribbon command in the “Find/Change/Check” panel or select
“GTS Modeling>Checks>Joint Duplicates” from the menu or type
GTSCheckDuplicateJdoints at the command prompt. You then must enter the desired
merge accuracy (Enter Merge Tolerance <0.001000>). If duplicate joints exist in the structure, a
new dialog appears having the full set of duplicate pairs, where you can select the joints to be

merged or not as shown on the next page:
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Merge Joints

List Select Al
Joint Duplicate Merge
2 5 2
3 25 [v

| : =

2.6.22. Joints Floatings

Floating Joints are the joints that are not connected to any member or finite element, therefore
they may cause instability in the solution of the mathematical model. Use the ribbon command

- Joints Floatings in the “Find/Change/Check” panel or select “GTS Modeling>Checks>Joint
Floatings” from the Menu or type GTSCheckFloatingJoints at the command prompt,
floating joints are automatically identified, and using the corresponding dialog as shown below,
they can be deleted.

Floating Joints
Joint Deleted

2.6.23. Joints Interference

In order to check in order to search for joints close to a member, not connected to it, you can

/ Joints Interference
use the ribbon command in the “Find/Change/Check” panel or select
“GTS Modeling>Checks>Joints Interference” from the Menu or type
GTSCheckInteferenceJoints at the command prompt. You then must enter the desired
tolerance (Enter Check Tolerance <0.050800>).
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2.6.24. Members Duplicates

In order to check if two members are one on the top of the other (having common joints in any
order), you must check the model for duplicate members from the ribbon command

@ Members Duplicates

in the “Find/Change/Check” panel or  select “GTS
Modeling>Checks>Members Duplicates” from the menu or type
GTSCheckDupl icateMembers at the command prompt. If duplicate members exist in the
structure, a new dialog appears having the full set of duplicate pairs, where you can select the
members to be deleted or not as shown in the following figure. For all the selected pairs, one
member is deleted (the member first created is kept).

Duplicate Members x
Member Duplicate Delete
Unselect Al
3 ; v
4 6 [v

2.6.25. Members Zero Length

In order to check if a member has zero length, you can use the ribbon command
' Members Zero Length . .

in the “Find/Change/Check” panel or  select “GTS
Modeling>Checks>Members Zero Length” from the Menu or type
GTSCheckMembersZeroLength at the command prompt. Following the command
execution, you must enter the desired tolerance (Enter Check Tolerance <0.001000>) and then a
list of zero length members appears from where you can select which to delete.

2.6.26. Physical Members

Physical members in a frame model are consisted using two or more analytical members. In

order to check if physical members exist in the structural entities, you can use the ribbon
me=o=s Phycical Members

command in the “Find/Change/Check” panel or select “GTS

Modeling>Checks>Physical Members” from the Menu or type GTSCheckPhysicalMembers

at the command prompt. The five (5) checks that are performed with their corresponding errors

are as follows:

#1. Check that all members have the same Beta angle. If not, there is an error message:
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Physical Member %s: Member %s has inconsistent BETA angle

#2. Check that all members have the same cross section. If not, there is an error message:
Physical Member %s: Member %s has inconsistent CROSS
SECTION

#3. Checks that all member do not have internal releases. If not, there is an error messages:
Physical Member %s: Member %s has internal RELEASES
Physical Member %s: Starting Member %s has internal
RELEASES at its end
Physical Member %s: Ending Member %s has internal RELEASES
at its start

#4.Checks that there is a sequential order of members. If not, there is an error message:
Physical Member %s: Members %s (end) and %s (start) do not
have common joint (are not SEQUENTIAL)

#5.Check that all members form a straight line. . If not, there is an error message:
Physical Member %s: Member %s 1is not LINEAR with the
physical member

If all 5 checks are successful an informative message appears:
Physical Member %s: OK

2.6.27. Shells Duplicates

In order to erase shells that coincide (one on the top of the other) that may have been
generated by mesh generation functions, you have to check the model for duplicate shells from

@ Shells Duplicates

the ribbon command in the “Find/Change/Check” panel or select “GTS
Modeling>Checks>Shells Duplicates” from the Menu or type GTSCheckDuplicateShells
at the command prompt. If duplicate shells exist in the structure, a new dialog appears having
the full set of duplicate pairs, where you can select the shells to be deleted or not as shown in
the following figure. For all the selected pairs, one shell is deleted (the shell first created is kept).

Duplicate Shells pod
Shell Duplicate Delete
Unselect All
3 5 [v IIIIIIIIII
4 6 [v

Cancel
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2.6.28. Names Duplicates

In order to check if two joints have the same name or two members have the same name or a
member and a shell have the same name, you can use the ribbon command

® Mames Duplicates

in the “Find/Change/Check” panel or  select “GTS
Modeling>Checks>Names Duplicates” from the Menu or type GTSCheckNames at the
command prompt. If duplicate names exist in the structural elements, a message appears in the
command prompt as follows:

Joints 4 and 4 have the same Name

Joints 5 and 5 have the same Name
2 Duplicate Names Found

2.6.29. Renumber Names

It is often convenient to have continuous numbering (labeling) of joints members and elements.
In order to renumber the names of structural entities in ascending order (only if their name is an

J:: Renumnber Mames
integer), you can use the ribbon command ’ in the “Find/Change/Check”

panel or select “GTS Modeling>Checks>Names Duplicates” from the Menu or type
GTSRenumber at the command prompt. Following the command execution, you mmust
decide whether or not you want to renumber joints and members/elements by typing yes or no
(y or n) to the following questions:

Renumber Joints? (Yes/No)
Renumber Members and Elements? (Yes/No)

2.6.30. Database Integrity

In order to check that all CADM entities in a DWG have a unique database record, you can use

% Database Integrity
the ribbon command in the “Find/Change/Check” panel or select “GTS
Modeling>Checks>Database Integrity” from the Menu or type GTSCheckDatabase at the
command prompt. There may be database records, without a dwg entity, or the opposite, dwg
entities without a database record. This may happen in very extreme cases (for example, a
power supply failure while saving, or out of disk space, etc). Entities/records with a problem are
deleted and you get an information message such as the one below:

Error Fixed: Joint %s deleted from DWG
Error: Joint %s does not exist in database
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2.6.31. Meshing along a curve

You can create several members along any selected AutoCAD/BricsCAD linear entity, that can be

a Line, an Arc or a Circle, from the ribbon command “urve
Modeling>Mesh Generation>1D Along Line or Curve or Circle” or by typing GTSMesh1D at the

command prompt.

Select Mesh Properties

Generate

(®) Members Elements

Material | Steel W

Element Attributes

0.20

Type EPHOQ Thidkness

Member Attributes

Type |FRAME v Beta 0.0

Section b4

Spading U Direction

(®) Uniform 4 w

(i variable
Defined by Line/Curve
Spading V Direction
® Uniform 4
Variable
Defined by Line/Curve
Spading W Direction
® Uniform 4
Variable
Defined by Ling/Curve
Labeling

Maore >= U Primary Direction

Preview Create Close

o
4]

o
1D

After selecting the AutoCAD/BricsCAD linear
entity the Mesh Properties dialog appears,
where you can define:
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The Material of the members to be
generated.

The Type of the members (FRAME or
TRUSS)

The Cross-Section of the members
from a list of previously selected
project sections.

The Beta angle that defines the
orientation of the cross-section in 3D
space.

The number of members, to be
generated, that can be equally
spaced (uniform) or may have
variable spacing.

The Labeling (optional) of the joints
and members to be generated
(“Enter Labeling Rules” form), where
you can set the First ID for joints and
members and their labeling prefix.

By clicking “Preview” you are able to
preview the members to be
generated (without creating any
entities).

By clicking “Create” the members are
generated and the Mesh Properties
form is closed.

or from the menu “GTS



By selecting Variable spacing, the “U1-Curve Spacing” form appears, where you can enter the
Total Number of Spaces, and the Length of each part, either in absolute distance or as a
percentage of the line or curve’s total length using the dialog shownbelow:.

U1-Curve Spacing
Current Totals
Total # of spaces : 0 Curve Length : SR T
Current # Spaces : ! Current Length : L LELLLL
Remaining # Spaces : 0 Remaining Length : 1847.034685
Variable Spadng
# Spaces Distance or Percent )
W

The “Enter Labeling Rules” form allows you to set the First ID for joints and members to be
created and their labeling prefix. Note that the total length of the label cannot be more than 8
characters. Element and member labels (IDs) must be unique — you can’t have a member and
element with the same label (ID).

Enter Labeling Rules

Properties

Joints Prefix I:I

First Joint's ID L

Elements Prefix

First Element's ID

Members Prefix

First Member's ID

< <= Apply Calculate IDs
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2.6.32. Meshing between two lines
You can create Members or Finite Elements between two selected AutoCAD/BricsCAD linear

5%
a
2D
entities such as Lines or Arcs, from the ribbon command 2YY€5 or from the menu “GTS
Modeling>Mesh Generation>2D Between 2 Lines or Curves” or by typing GTSMesh2D2L at the

command prompt. You are then asked to select two AutoCAD/BricsCAD curves that will define
the U and V boundaries of the Mesh.

The dialog has the same options as in the 1D mesh command and in addition you can also
define:
- Members or Elements to be generated (for Members the options are the same as in 1D)
- Type of Finite Elements, from the available GT STRUDL Finite Element library
- Thickness of Finite Elements
- Spacing in both the U and V directions

2.6.33. Meshing between four lines
You can create Members OR Finite Elements between four selected AutoCAD/BricsCAD linear

i

2D
entities, that can be Lines or Arcs, from the ribbon command 4“4 or from the menu “GTS
Modeling>Mesh Generation>2D Between 4 Lines or Curves” or by typing GTSMesh2D4L at the
command prompt. You are then asked to select four AutoCAD/BricsCAD curves that will define
the U1, U2, V1 and V2 boundaries of the Mesh as shown in the figure below with U2 opposite
U1 and V2 opposite V1:

The dialog has the same options as in the 2D mesh between two curves command.

2.6.34. Meshing inside a polyline

You can create Finite Elements inside an AutoCAD/BricsCAD closed curve, that can be a Polyline
v} a

=] a

=} a

20
or a Circle, from the ribbon command A" or from the menu “GTS Modeling>Mesh
Generation>Inside Polyline” or by typing GTSMesh2DPoly at the command prompt. You are

then prompted to select the closed AutoCAD/BricsCAD polyline or circular curve.
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After selecting the AutoCAD/BricsCAD entity the Mesh Properties dialog appears, where you

define:

Generate

Material |Steel

Element Attributes

Type |SBHTG * |Thickness

E {

Mesh Geometry

External Boundary obj-581

0.000000

External Boundary Edge Size

Maximum Element Edge Size 0.50

Minimum Element Edge Size 0.000000

< I

Mesh Quality | Very Low

Internal Boundaries Internal Joints

Add +| Remove -

Multi+| | Multi - Add | |[Remove

Spacing Extrude Direction

Liniform 5
Variable I:I
Defined by Curve, Size: 3.242418

|:| Sweep Function

Labeling

More ==

Preview Clear Create Close

The Material of the elements to be
generated

Type of Finite Elements from the
available GT STRUDL Finite Element
library

Thickness of Finite Elements

The Maximum Element Edge Size along
the Boundary. CAD Modeler will
generate additional joints along the
boundaries so that there is no finite
element edge, along the boundary
curve, longer than the entered value.
You can have the boundary curve to be
split in smaller parts than the Max, or
not. Additional splitting may be required
if you try to increase the quality of the
finite element mesh.

The quality of the triangles that are
going to be generated.

Add one or multiple (Multi+) internal
closed boundaries (polylines or circles),
or open boundaries (arcs or lines). If a
closed internal boundary is selected
there is a question asking if you want
the elements inside the boundary to be
removed (treat it as a hole) or not.
Moreover, you will be asked a question
regarding the size of elements along the
internal boundary curve, that can be O,
so as to follow the current value of the
“Maximum Element Edge Size”, or it can
be a positive number which defines the
maximum length along the internal
boundary, or it can be a negative integer
which defines the number of equal parts
that the internal boundary will be split.

NOTE: Internal boundaries may intersect the external mesh curves, but it is
recommended that you manually spit the external curve at this point
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- Add internal joints (points) that will be additional corners of the finite element mesh.

- Labeling, Preview and Create functions are identical to the ones of the previously
described meshing forms.

2.6.35. Meshing by extruding a polyline
You can create Finite Elements by extruding an AutoCAD/BricsCAD closed curve, that can be a

3D
Polyline or a Circle, from the ribbon command E4™de o from the menu “GTS Modeling>Mesh
Generation>3D Extrude PolyLine” or by typing GTSExtrudePoly at the command prompt.
You are then prompted to select AutoCAD/BricsCAD curves, first the extruded curve, and then
the curve which defines the extrude direction which can be either a line or polyline. The finite
elements will be generated on the extruded surface.

The “Mesh Properties” form is similar to the “Meshing inside a polyline” properties form but you
must also define the “Spacing Extrude Direction”, meaning the parameters that control the size
of elements along the extrude direction. Uniform and Variable options are suitable if the
extrude entity is a line. “Defined by Curve, size” is suitable if the extrude entity is a polyline, so
that it is enforced that joints will be generated at the intermediate points of the polyline.
Labeling, Preview and Create functions are identical to the ones of the previously described
meshing forms.

2.6.36. Meshing using 3 curves
You can create Members OR Finite Elements between three selected AutoCAD/BricsCAD linear

L&

3D
entities, that can be Lines or Arcs, from the ribbon command 3turves or from the menu “GTS
Modeling>Mesh Generation>3D Between 3 Lines or Curves” or by typing GTSMesh3D3L at the
command prompt. You are then asked to select three AutoCAD/BricsCAD curves that will define
the U, V and W boundaries of the Mesh.

The dialog has the same options as in the 2D mesh command, between 2 lines, with the extra
parameters for the meshing in the W direction.

2.6.37. Array 3D Advanced
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You can create copies along the vertical direction, similar to AutoCAD’s and BricsCAD’s ARRAY

Array 3D
commands from the ribbon command “##"¢? o by typing GTSMesh3D3 at the command
prompt. This optimized command is useful for large models, or for multiple copies, when the
default AutoCAD’s and BricsCAD’s command take a lot amount of time. It produces the same
result in significantly reduced time.

2.6.38. Soil Springs

211

Soil
You can create soil springs on individual/multiple shell element(s) from the icon P9 or by
typing GTSFoundationSprings at the command prompt and select the corresponding shell

element(s). After selection the “Soil Springs” dialog appears, where you can:

- Define in-plane spring ratio of Ks value if the “in-plane (orthogonal) springs” option is
checked. The in-plane spring ratio will be applied to the two remaining directions, other
than the selected.

- Define the direction of springs (in global system).

- Append new spring values in case of keeping the existing ones and adding the new ones.
Else, the new values replace the existing ones

- Define the value of modulus of subgrade reaction Ks.

After pressing “Place Springs”, a legend appears showing the Ks values distribution on the shell
elements. By double clicking on each node, you can see the value of Ks in “Restraints and Spring
Values” section of the Model tab in the “Joint Properties” dialog box. Note that if the spring’s
degree of freedom is not restrained by the user then it is restrained automatically.

General Information Ks Values
[]in-plane (orthogonal) springs 000 . 008
I plane Spring Ratio 008 015
015.. 0.23
Direction 0.23..03
(") Global X (") Global Y (®) Global Z 031..038

032 .. 046

[+] Append Existing Spring Values 045 054
0.54.. 0E2

Modulus of Subgrade Reaction 0E62.. 0E9
e 0.69.. 0.77
077 .. 085

= 0.85..0.92

Place Springs == 092..1.00
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2.6.39. Export to CAESAR |l

The current drawing can be exported into CAESAR Il Modeler (str file) from the menu “GTS
Modeling>CAESAR II> Export STR” or by typing GTSEXpOrtSTR at the command prompt. You
select the members to be exported and an STR File is generated. Immediately after the log file
appears on the screen. A typical log file is:

GT STRUDL Version 2018.R1

GTS2CII Version 2018.R1.01

GTS2CII Binary Dir

C:\\Program Files (x86)\GTStrudI\2018RI\Utilities\GTS2CII\
Project Dir F:\\HexagonPPM\CaesarlI\PlantStructure\

Total Number of Sections: 6

Total Number of Joints: 170

Total Number of Members: 233

The model will be saved in 1 STR file(s)

File

F:\\HexagonPPM\Caesarl I\PlantStructure\\PStructure_0708 0l.str
created

If the cross sections used in CAD Modeler (and GT STRUDL) are not available in CAESAR’s section
library you get a warning like this:

WARNING: Section L1x1x1/4 is not available in Cll, please use another

one or edit
F:\\HexagonPPM\Caesarl I\PlantStructure\\PStructure 0708 0Ol.str file
manually

2.6.40. Convert Lines/Polylines to Members/Shells
Convert lines and polylines to members and shell elements through the utility “DXF converter”,

Convert Lines to Members
from the ribbon command or by typing GTSDXFRead at the

command prompt. This command is not limited to DXF Files, but you can create new lines and
polylines on the DWG that is currently open and convert them to structural members. Or open
an existing DXF or DWG, select some lines and polylines, and convert them to members and
elements.
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Import Model in CAD Modeler?
DXF - GTSTRUDL Converter Version 3.1.1 = = p

D:\Hexagom\DXFReader\Run\DXFReader.dxf Mumber of Joints Read: 243

= 477 Line 2 Polygon entities found!
MNumber of Members Read: 477

Output File: b:\Hexagon\DXFReader\Run\bXFReader gti

Mumber of Shell Elements Read: 2
Done! 243 nodes 477 members 2 elements are created

MNumber of Sections Read: 0

% Create Joirts, Members and/or Finite Elements

Mumber of Groups Read: 0

© Create Construstion Poirits, Lines for Meshing

Mumber of Load Cases Read: 0

Read »» | Properties |

Mumber of Load Combinations Read: 0

2.6.41. Model Wizard

You can now use Model Wizard to create and import the model to CAD Modeler. This option is
very useful if you want to create a typical tank and further edit it in CAD Modeler, or append it
into an existing model. You can start the Model Wizard from the ribbon command

'/", Madel Wizard
or by typing GTSModelWizard at the command prompt.

GT5trudl ModelWizard 4.2 >

To start using Modelwizard, select a structure type from
the palette below.

%o

Plarne Frame Braced Frame Space Frame

AR

Finite Element Circular Plate Bridge Trusz

Mesh

©

!

——
o ——

L

T ank. Waulk / Rect Tank Continuous Beam

&

:

K Cancel




2.6.42. Groups

It is optional to define Groups in your model, but it is strongly advised to do so, since it will be
easier to control the display and modeling of parts of your structure. Each Group is defined as a
set of joints, members and finite elements. Each structural entity can belong in more than one
group. Moreover, Groups defined in CAD Modeler are exported to the GT STRUDL Input file
(.gti), meaning you can also use them in GT STRUDL analysis and design commands.

You have to first define the name of each group from the ribbon icon Lt or from the menu
“GTS Modeling>Groups>Manage” or by typing GTSGroups at the command prompt.

Using the Groups Form you can:
- Set the Name of each Group (NOTE: not larger than 8 characters, due to a GT STRUDL
limitation)
- Add Groups to the model
- Delete Groups from the model

- Define if this Group is corresponding in a “Physical” member definition (used in Steel
Design commands).

Groups

Group Properties

D Mame Physical

Add Group

1 [ ety

2 Beams [

3 Girders [
4 Bracing [

5 Slabs [ Cancel

After defining a group you can add joints, members and shell elements to it using the
commands:
W +Joi .
i +Joints ribbon icon, or “GTS Modeling>Groups>Add Joints” or by typing GTSGroupJoints
at the command prompt

o
=L ribbon icon, or “GTS Modeling>Groups>Add Members” or by typing

GTSGroupMembers at the command prompt

a3
i ~Shells bon icon, or “GTS Modeling>Groups>Add Shells” or by typing GTSGroupShells

at the command prompt
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2.6.43. Self - Weight

or from the menu “GTS Modeling>Loads>Self Weight” or by typing GTSSelfWeight at the
command prompt.

Self Weight or Dead Loads The “Self-Weight” form appears where you
can define:

Load Information

- the global direction of the self-weight

Mame : SW v
Description : | 5% Weight - the load factor (default = 1.0) for the
self-weight
Create Mew Save [ Modify Delate . . ..
- if the self-weight of finite elements
Loads applied parallel to this Global Axis will be taken into account or not

(") Negative Y (") Positive Y

(®) Negative Z () Positive Z

() Negative X () Positive X
EacEnE 1 Indude Finite Elements

2.6.44. Load Cases

A new load case can be created from the ribbon command :H e or from the menu

“GTS Modeling>Loads>Load Cases” or by typing GTSNewLoadCase at the command prompt.
The “Load Case” form appears as shown below where you can enter new load cases, modify
existing ones, or delete them.

Load Case *
Load Case Information
Load ID (up to 8 chars) : Eerriimiise >
Description : | Live Load | Save [ Modify
Load ID List : Delete
PL
Exit
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Design variable associates the Load Case with the Design Load Variable. This information can be
used later on, when creating the standardized load combinations.

Create New

D Deadload

DI Weight of ice

E Earthquake load

F  Fluid loads having well - defined pressures and maximum heights or depths

FAl Flood loads Fain V - Zones or Coastal A - Zones

FAZ Flood loads F a in noncoastal A - Zones

HA  Lateral pressure load, H, due to earth, ground water, or bulk materials, when H adds to the primary variable(ive) load effect
HR  Lateral pressure load, H, due to earth, ground water, or bulk materials, when H resists the primary variable(ive) load effect
L Liveload

LR Rooflive load

R Rainload

5 Snow load

T  Self straining load, such as a temperature load that causes thermal stresses

W Wind load

WI  Wind - on - ice load

AK  Extra ordinary event load, such as blast, fire, etc,

M Motional load

L100 Live load that is permitted to be less than or equal to 100 psf.in & given load combination

LE¥ Loading conditions associated with LEX are live loads L that are treated as EXdusive loads in the creation of the standardized loading combinations

2.6.45. Joint Loads

A Joint Load can be entered from the ribbon command g Joint or from the menu “GTS
Modeling>Loads>Joint Load” or by typing GTSJointLoad atthe command prompt. You then
have to select the joint or the joints that the load will be applied to.

At the “Joint Generalized Loads” tab you can apply joint loads or displacements. On the left part
of the form, you can see a list of all available load cases: Load cases having loads already applied
to the specific joint appear at the top list box. Load cases that do not have any loads applied to
the specific joint appear at the bottom list box. Next to the name of each load case there is a S
symbol followed by the total number of joints that are already loaded in the specific load case.

Joint Properties *

Model  Joint Generalized Loads

Applied Load Cases Loading
A — ]
PL S Point Load $[1] Losd Case i | Pt E——
Description : | Paint Load Save [Modify
Loads in this Load Case : |1 el Delete

Applied Load Values

rrcex: | O] e [ ] e
vomentx: [ O] womentv:[ ] womentz:[ 0]
Applied Displacement Values
i [ ] [ ] [ ]
LL SLive Load 5[0] Tran X : Tran : Tran Z:
rox: | L owee [ ] e [ ]

Cancel Apply Help
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2.6.46. Member Loads

A Member Load can be entered from the ribbon command =+ MEMEET o0 £rom the menu “GTS

Modeling>Loads>Member Load” or by typing GTSBeamLoad at the command prompt. You
then have to select the member or the members that the load will be applied to.

At the “Member Loads” tab or the Member Properties form as shown below, you can apply
member loads. In the left part of the form you can see a list of all available load cases: Load
cases having loads already applied to the specific member appear in the top list box. Load cases
that do not have any loads applied to the specific member appear in the bottom list box. Next to
the name of each load case there is a $ symbol followed by the total number of members that
are already loaded in the specific load case. The load distribution can be Concentrated, Uniform,
Linear or Triangular and it can be applied in any local member or global direction. The Location
can be entered in fractional terms (0: start, 1: end) or absolute terms in current length units
measured from the start of the member.

Member Properties

Model | Section Properties | Member Loads | Member Temperature Loads | Member Distrortions

Applied Load Cases Loading

eesione ] LL Create New

Load Case @

Description : Live Load Save [ Modify

Loads in this Load Case : 1 v Delete

Load Distribution

() Concentrated Member Start

) LW
(®) Uniform :

() Linear — L1

L2
Empty Load Cases (_) Triangular

FL & Foint Load [0]

Load Type and Direction Loading Magnitude Loading Location from Start

@ Force I:':':I " Olecal Vi -5 (® Fractional L1:

() Moment @z (®clobal V2 - () Absolute 12:

Cancel Apply Help

Using the “Member Temperature Loads” tab, you can define Axial or Bending temperature
change along a part of the member, similar to the “Member Loads” tab as shown on the next

page.

Finally, using the “Member Distortions” tab, you can define concentrated of uniform distortion
of the member in any direction along the member as shown on the next page.
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Member Properties

| Model | Section Properties | Member Loads | Member Temperature Loads | Member Distrortions |

(@)% Axial Uniform through cross-section
()Y Bending Vary through depth Change :

()7 Bending Vary through width

Location: Length experiencing temperature change
Empty Load Cases

LL §Live Load $[0] ®) Fractional (% 0-1) Starting Location : EI

FL & Point Load £[0]
() Absolute (len) Ending Location :

Applied Load Cases Loading
odcase: |
Description : | | | Save [ Modify |
Loads n s Losd Case:
Temperature Change

[ ok || cancl
Member Properties
| Model I Section Properties I Member Loads | Member Temperature Loads | Member Distrortions |
Applied Load Cases Loading
Load Case : I:I
Description : | | | Save [ Modify |
Loads in this Load Case : -
Distortion Type Distrortion Direction - Value
() Concentrated (@ Displacement (@)X
OY  value :
(@) Uniform (_)Rotation (@)
Distortion Location
Empty Load Cases @) Fractional (% 0-1)  LA: III
LL & Live Load &[]
PL % Point Load &[0] () absolute (Len) B
oK | | Cancel Apply
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2.6.47. Shell Loads

A Shell Load can be entered from the ribbon command MY Shel or from the menu “GTS
Modeling>Loads>Shell Load” or by typing GTSShel ILoad at the command prompt. You then
have to select the shell or the shells that the load will be applied to.

Using the “Element Loads” tab of the Element Properties form, you can apply element loads. In
the left part of the form, you can see a list of all available load cases: Load cases having loads
already applied to the specific element appear in the top list box. Load cases that do not have
any loads applied to the specific element appear in the bottom list box. Next to the name of
each load case there is a $ symbol followed by the total number of elements that are already
loaded in the specific load case. The Force type can be Body, Surface or Edge, in any Local,
Planar, Global or Projected direction with uniform or variable values.

Element Properties
Model | Element Loads
Applied Load Cases Loading
Load Case: | 11 Create New
Description : . general
Loads in this Load Case : bl Sicoshd
Force Type Direction System Load Distribution Values (B or 5)
(O Body Ox (O Local (®) Uniform vl -1.00
i () Planar V2
(®) Surface Oy ~
) (®) Global (O Variable w31
() Edge @z () Projected v
Empty Load Cases
lo1sf) |
OK . Cancel App Help

2.6.48. Area Load

An Area Load can be entered from the ribbon command W Area or from the menu “GTS
Modeling>Loads>Area Load” or by typing GTSAreaload at the command prompt.
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Area Load

Generate

Mame : ALl ¥

o Area Load 1
Description :

Create Mew Save [ Modify Delete

Load - Direction

Load Value :

Global Direction Perpendicular to the Loading Plane :

.;:;. ¥ .;:::;. ¥ .;:.:;. 7

Plane Tolerance : 0.0508

Elevation

Plane Perpendicular at :

(®) value (coordinate)

() Joint
Distribution

(®) Two way X

() One way ¥

Customn  y =2 -" pp L

Advanced Features

Define Qutline Region ==

Exdude Area ==

Ignore Members ==

Display => Clear Cancel

Using the Area Load form you can
define:

- The Name of the Load (up to 8
characters)

- The description of the load

- The Loading Value in current
units (force/length?). A positive
value is applied in the negative
global DIRECTION.

- The Global direction of the
loading plane (X, Y or Z) and the
tolerance

- The position (Elevation) of the
plane, defined by a coordinate
or an existing Joint. All
members belonging to the
plane having this elevation are
located and loaded by GT
STRUDL.

- The Distribution of the load
(one way or two way)

Advanced Optional Features:

- Outline Region: Select the
members that form the closed
perimeter of the loaded area. If
an Outline Region is defined
then the area load is applied
ONLY to the selected area and
NOT to the whole plane having
the elevation defined above.

- Exclude Area: Internal openings
or islands not being loaded may
be specified by selecting the
members that define the
perimeter of the excluded area.

- Ignore Members: Select members that you do not want to be loaded (eg bracing

members)

By selecting “Display >>" you are able to graphically view the loaded area, marked with a

yellow hatch pattern.



2.6.49. Wind Load ASCE 705
You can define Wind Loads using a similar form with GT Shell. A Wind Load can be entered from

o]

== Wind Load ASCE 703

L

the ribbon command - or from the menu “GTS Modeling>Loads>Wind
Load ASCE 705” or by typing GTSWindLoadsASCE705 at the command prompt.

B Wind Load Generation ASCE 7-05 *

Wind Load ID: I Wix Delete Wind Load |

Description: I Wind Load X

General Wind Load Data | Member Wind Load Data

Active Units: ™M KN DEG SEC StdMASS Change Unitsl
—Design Wind Speed

v IZD  mph " m/s Gust Factor (G): IU.SE

—Elevation Axis

Gy 7z Wind Direction Angle: IU
Directionality Factor (Kd): I 1

—Exposure Category
#8 Cc Cp Importance Factor (I): Il
— Topographic Factor
& e o
" K1,K2, K3 K1 |0 Kz |0 K3: [0

Minimum Velodty Pressure (QZmin): | 0.478803

Gross Area (Aqg): I 0
Added Force Area (AFadd): I 0

Review Data |
Save Commands

Report Wind Load | Only

Save Load I Done Help
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In addition, you can select members (to apply loads) interactively with mouse picks in the CAD
environment.

# 7 Wind Load Generation ASCE 7-05 H

Wind Load ID: |WLx Delete Wind Load |

Description: I Wind Load X

General Wind Load Data  Member Wind Load Data I

Active Units; M KN DEG SEC StdMASS Change Unitsl
Select Members | Selected Members: I 123

Wind Load Compaonent Type: I Industrial Frame LI

—Afand Cf Parameters

¥ Properties " Round D: IU

" Rectangle B: Iu H: ||:|

i aAf: IEI—

Hetrs: IU— Dctrs: IU— C-T-R-5 T I—
THice: Ioi THins: IU—

CDg: Ioi

—Misc. Parameters/Cverrides

Add to Member Data | Clear Member Data | Delete Selection

Review Data |
Save Commands

Report Wind Load | Only

Save Load I Daone Help
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Active Units *
Length Force Rotation Temperature Time Mazs
£ Inches " Pounds " Radians " Fahrenheit ¢ Seconds f* Standard b ass
" Fest " Kips * Dearees * Centigrade " Minutes " Grams
" Millimeters ® T " Cycles " Hows " Kilograms
" Centimeters B (TR " Metric Tons
f Meters " Metric Tans
" Mewtons
* KiloMewtans
" Megahlewitons QK. | Help Cancel

2.6.50. Wind Load ASCE 710

=" Wind Load ASCE 710
A Wind Load can be entered from the ribbon command - or from the

menu “GTS Modeling>Loads>Wind Load ASCE 710" or by typing GTSWindLoadsASCE710 at

the command prompt.
B Wind Load Generation ASCE 7-10 X

Wind Load ID: | WLx Delete Wind Load

Description: | Wind Load X

General Wind Load Data ] Member Wind Load Data

Active Units: M KM DEG SEC StdMASS Change Units

Design Wind Speed

v: |20 & mph " mjs Gust Factor {(G): |0.85

Elevation Axis

~y @2 Wind Direction Angle: 0
Directionality Factor : |1
Exposure Category ty (5

@B CcCc D

Topographic Factor
® Kzt Kzt: |0
K1, K2,K3 ki [0 K |0 k3 [0

Minimum Velocity Pressure (QZmin): | 0.766085
Gross Area (Ag): |0

Added Force Area (AFadd): |0

Review Data

Save Commands
Report Wind Load ‘

Only

Save Load | i Done | Help
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|87 Wind Load Generation ASCE 7-10

Wind Load ID: I Wix Delete Wind Load

Description: I Wind Load X

General Wind Load Data  Member Wind Load Data |

Active Units: M KN DEG SEC StdMASS Change Uniisl

Select Members | Selected Members: I 123

Wind Load Component Type: I Industrial Frame LI

—Afand Cf Parameters

' Properties  Round D: ID—

" Rectangle  B: [0 H: [0

T

Hetrs: IU Dctrs: IU CTR-SID: I
THice: IU— THins: IU—

CDg: |0

—Misc, Parameters/Overrides

Kz: | 0 cf: | 0
qz: |0 FD: |1
Add to Member Data | Clear Member Data Delete Selection

Review Data |
Save Commands

Report Wind Load | Only

Save Load I Done

Help
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2.6.51. Seismic Load

You can define Seismic Loads using a similar form with GT Shell. Seismic Loads can be entered

Jlilw- Seismic Load

from the ribbon command

Load” or by typing GTSSeismicLoading at the command prompt.

or from the menu “GTS Modeling>Loads>Seismic
In addition you can

select joints (to define story heights) interactively with mouse picks in the CAD environment.

B Seismic Load Generation

Load X Name I SLX

Load ' Mame I
Description ISeisrnic Load Global Description I Description I

X

Load Z Marne I

Lateral Seismic Factor (LSF) | 1.00

wertical Seismic Fackor (¥SF) | 0.00

Standard —General Data
¢ ASCE7-05 Height Axis &y Cz
& ASCET7-10 — Story Heights
Story heights from ¢~ values % Joints  Tolerance |0.6096 IMehers j
EXISTING 17 35 55 7797 117 _l
~Load
Direction W % (Lateral) Iy Nz

Seismic Weight Load I s - l
Seismic Dead Load lm

" Spedified Response Coeffident (Cs) sD5 I

¢ Response Coefficent from Standard

—Ground Motion — Spectral Response Accelerations

Site Class IB: Rock 'l
Long Period (TL) I 12 Seconds
@ 55, 51fomMap |UsA -

Risk Category [Iv: Essential Faciities v |

Latitude I 36

Longitude I -85 Degrees

s | st a
€ sos | 51 | 51 | g
- Seismic Forces
% Fundamental Period from Standard |SMR: Steel Moment-Resisting =l
Analysis Mode, Direction k3 I i I z I

" spedfied Fundamental Period (Ta) I Seconds

Response Modification Coeffident (R) | 3.5

Accidental Torsional Factor (ATMF) | 1.00 Redundancy Factor (RF) | 1.00

Help
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2.6.52. Load Combinations

A new load combination can be created from the ribbon command # Combinations or from the

menu “GTS Modeling>Loads>Load Combinations” or by typing GTSLoadCombination atthe
command prompt. The “New Load Combination” form appears where you can enter new load
combinations. For each Load Case or Load Combination, that appears in the left list box, you
define a factor and using the “ADD>>" button the selected load case is added in the
combination.

When all load cases are added, press the “STORE” button to store the load combination.
Using the same form, you can also Edit an Existing Load Combination (remember to press

“STORE” after you are done with the modifications). You can also Delete an Existing Load
Combination using this form.

New Form Load or Load Combination

Load Information Type

Mame : CBl (®) Load Combination

Description : Load Combination 1 () Form Load
Combine

Sy (Self Weight) SW 1.35000

LL (Live Load) LL 150000

FL (Point Load PL 1.50000

'SW' 1.35000 'LL' 1.50000 'PL' 1.50000
ADD ==
Delete
Factor : Item
1.00000

STORE |/

All Formed Loads or Combinations

Done
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2.6.53. Standardized Combinations

You can Create Standardized Combinations using exactly the same form with GT Shell.
Standardized = combinations can be entered from the ribbon command

% Standardized Combinations

or from the menu “GTS Modeling>Loads>Standardized
Combinations” or by typing GTSLoadCombinationStandardized at the command
prompt.

B | Create Standardized Load Combinations *

Standard (Code)

Definitions of DLVs ASCE 7-10LRFD «

Assodations | Create Loads

Unassocated Loads Loads Assocated with Design Load Variables (DLVs)

Load ID | Description DLV | Associated Load IDs |
D1 D1 D
D2 D1 DI ‘or'
F F E 'E1'E2 'E3

F

Assocdate == FAl 'FA1

FAZ

HA  'HA'

HR. 'HR'

Remove L s
Assodation LR LR1

R

5 )

T T

W 1

Reset WL WIT Wiz

AR

M N1 N2

L100

LEX 'LEX1'LEXZ

Help
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B | Create Standardized Load Combinations *

Standard (Code)

Definitions of DLVs ASCE 7-10LRFD +

Associations Create Loads

Combination Selection Load Creation Options
v All Combinations {* Load Combinations Start ID
; ¥ Print Load Combos Report
¥ Ice Loading Check " Form Loads Load Group | ASCEF10L
Selection of Basic Combinations Reference for All Derived Combinations
| Basic Combinations | | Derived Combinations A
CITIb. 1 14D Cmb. 1 14D +F)+T
Cmb. 2 1.2(0 +F) + L.6L + 1.6LEX +0.5(LR or Sor R) +0.5HR + 1
v . . . .
[cmb. 2 1.2D + 16L +0.5(RorSor R) - <Ice» 1.2(D +F) + L.6L + LELEX + 0,201 + 0.55 + 0.9HR
[ACmb. 3 1.2D + 1.6(R or S or R) + (L or 0.5W) Cmb. 3 1.2(D +F) + L6(R or Sor R) +L +0.51100 +LEX +0.9HR
Cmb.4 1.2D +W +L +0.5{ R or SorR) Cmb.4 120D +F) +W +L +0.50100 +LEX + 0.5{LR or SorR) + C
[Wlcmb. 5 1.2D +E 4L 40.25 120 +F) +W +L +0.50100 + LEX +0.5(LR or Sor ) + =
[Cmb. 6 0,90 +W 1.2(D +F) +0.5W +L +0.5.100 +LEX + 0.5{LR or 5 or R)
[Wlcmb. 7 0,90 +E <Ice> 1.2(D +F) +DI +WI +L +0.5L100 +LEX +0.55 +
o S+ Cmb. 5 1.2(0 +F) +E +L +0.5L100 +LEX +0.25 + 0.5HR + 1.6H
Bcmb. 8 12D +AK +0.50 +0.25 Cmb. & 0,90 +W +0.9HR + 1.6HA +T
Cmb. 9 LD +N+L+0.25 0,90 +W + 2.0FA1 +0.9HR + L.6HA +T
0.90 +0.5W +FA2 +0.9HR + L.6HA +T
<Ice>0.9D +DI +WI +0.9HR + 1.6HA +T
Prab 7 MM AFY L F LN aOHD 4 1 EH& 1T 4
< >
oK Help

2.6.54. Steel Design Parameters
You can specify steel design parameters for AISC14, EC3, 1S800, CSA-2014 and all other codes.

Steel design parameters can be defined from the ribbon command - — or menu “GTS

Modeling>Steel Design Parameters” or by typing GTSSteelDesignParameters at the
command prompt. Parameters can be applied to ALL members or to specific members that can
be selected interactively with mouse picks in the CAD environment.
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rg Steel Design PARAMETERS Command

CODE Name IECJ_m

=

Units

METERS

— O X

KILONEWTONS

Commonly Used | All parameters | Alphabetic |

Fe
Parameter Name Parameter Values (Default
Walues)
Print-K YES

Buckling Length Parameters

—Member List Processing

All Members

o |

The parameter value "Computed"
means that the parameter value
is computed during the CHECK or
SELECT command. An alternate
value may be specified.

UMNITS | Cancel |
L Computed Member List Selection
Computed
FRLY 1.0 Help |
FRLZ 1.0 Zame as Previous Member
List
Flexural-Torsional Buckling Parameters |
LX Computed
] -
Help
LZ Selected Order | Alphabetic
Unbraced length for buckling -
about the local Z axis of the Parameter Names | Parameter Values r;argber, Joint or UNTS
profile. The default is computed
as the length of the member. CODE EC3-2005 ALL MEMBERS
LZ 2 WMEMBER 32 31 305 |METERS KILONEWT(Q

2.6.55. Create GTI

A GT STRUDL Text Input file can be generated from the ribbon command
menu “GTS Modeling>Create GT.STRUDL GTI” or by typing GTSEXportGTI at the command
prompt. In the “Create GTSTRUDL Input File” dialog, you can enter the filename of the GTI File
and add additional commands to your GTI file, such as the Stiffness Analysis command to
perform a static analysis automatically and commands which control the analysis results data
that can be imported into CAD Modeler immediately after the analysis is complete.
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Create GT.STRUDL Input File

GTI Commands
STIFie : F:\00.5TRUDL Europe\05-ATLAS \Models\Southern\PG2. gt
[ perform stiffness Analysis

Append Other GTI FilesMacros

+
Up
Down
[ ]copy Commands from GTI Files/Macros (not CINPUT)
Create Commands to Read Results
[ |read Joint Displacements
[ |read Member Forces
[IRead Section Forces Mumber of Sections: 10
[ |read Section Displacements Mumber of Sections: 10
["|read Finite Element Results
[ |read Code Check Results

Moreover, you can append additional GTI Files or Macros at the end of the GTI file of the model.
For example, additional GTI files may include static or dynamic analysis commands, result
output commands or member design commands. If you check “Copy Commands from GTI
Files/Macros (not CINPUT) then the above mentioned files or macros will be copied in your GTI
file. Otherwise, there will be a reference to them, with a CINPUT command.

2.6.56. Edit GTI

The GT STRUDL Text Input file can be edited from the ribbon command B Edit GTI or from the

menu “GTS Modeling>Edit GT.STRUDL GTI” or by typing GTSEditGTl at the command
prompt. The previously created GTl is opened for editing using the default text editor.

2.6.57. Execute GT STRUDL

GTSTRUDL can be launched, to process the previously created GTI, from the ribbon command

GTS

or from the menu “GTS Modeling>Edit GT.STRUDL GT/I” or by typing GTSExecuteGTI
at the command prompt.
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2.6.58. Read Analysis Results

After performing the stiffness analysis in GT STRUDL, results can be read back to CAD Modeler,

5= cults
from the ribbon command # Read Results or from the menu “GTS Modeling>Read GTSTRUDL

Results” or by typing GTSResultsGT1 at the command prompt.

“Read GTSTRUDL Results” form appears, where you can choose to import Displacements,
Member Forces, Section Forces, Section Displacements, Finite Element Results and Code Check
Results. Depending on your selection a set of GTI DBX commands are created in the edit boxes
shown below. If you have selected the same options in “Generate GTI” command, then the DBX
commands are already included in your GTI file. Else, they should be copied and pasted into GT
STRUDL main window. Do not press OK before the writing of the files in the GT STRUDL main
window has completed.

Read GT.STRUDL Results
Read DEX Results
F:\00.5TRUDL Europe'05-ATLAS\Documentation

GTI Directory :

Read Joint Displacements

Read Member Forces
Read Section Forces Mumber of Sections: 10
Read Section Displacements Mumber of Sections: 10

[ |Read Finite Element Results

Type of element result : <ALL =
Surface : <ALL >
[ |Read Code Chedk Results
GT1 Commands

Carresponding GT STRUDL commands:

DX BINARY

WRITE REPLACE JOINT RESULTS JOINTS EXISTING

WRITE REPLACE MEMBER. RESULTS MEMBERS EXISTING

WRITE REPLACE SECTION FORCES M5 10 MEMBERS EXISTING

WRITE REPLACE SECTION DISPLACEMENTS GLOBAL M5 10 MEMBERS EXISTING
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By pressing OK you will get the confirmation message “Results Loaded Successfully”
at the command prompt. Else, you will get an error message informing you about the type of
analysis results that are missing and the corresponding DBX full path file names.

2.6.59. Import GTI

An existing GTI file can be imported it into CAD Modeler from the menu “GTS Modeling>Import>
GT.STRUDL GTI” or by typing GTSGTIRead at the command prompt. Note that the GTI should
be generated by the command “File>Save>Text Input File...” from GT STRUDL main menu.

2.6.60. Set Views

You can switch between different 2D or 3D views of the structure from the ribbon command

@ Set View or from the menu “GTS Display>Set View” or by typing GTSSetView at the

command prompt.

It is strongly recommended to use Z as the vertical axis, so as to be able to use all built-in
AutoCAD or BricsCAD functions for Views (Top, Bottom, Left, Right, Isometric, etc). However, if
you use Y as the vertical axis, you can use this form to have identical 2D and 3D views, as in
GTMenu.

View Dialog n

View Options

[ ]Z Az Up
Available Views :

TS XY Plane along -Z axis
GTS ¥Z Plane along - axis
ETS ¥Z Plane along -X axis

2.6.61. 3D or Wireframe View of the Structure

You can switch between the 3D view or wireframe view of the structure.

You can view the 3D display of your model from the ribbon command “E or from the menu
“GTS Display>3D Sections” or by typing GTSSet3D at the command prompt. When 3D view is
selected, all members appear as solid cross sections and shell elements are displayed in 3D view
taking into account their thickness.
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You can view the wireframe display of your model from the ribbon command A, Frame or from
the menu “GTS Display>Frame” or by typing GTSSetl1D at the command prompt. When the
wireframe view is selected, all members and shell edges are displayed as lines.

If some parts of the structure are hidden (i.e. using Level’s form) you can display the whole

All Levels OM
structure from the menu “GTS Display>All Levels ON” & AllLeve or by typing

GTSSetAllVisible atthe command prompt.

2.6.62. Analytical/Physical Member View

You can turn ON or OFF the physical member view of the structure. When Physical Member
view is turned ON, all analytical members belonging to a physical member are hidden and the
physical members are displayed instead, as single objects. You can use copy, edit and move
commands on the physical member objects and they apply to analytical members as well.

You can switch between the physical or analytical member view of your model from the ribbon

command = AnabticalPhysical - o from the menu “GTS Display>Analytical/Physical” or by typing
GTSDisplayPhysicalMembers atthe command prompt.

2.6.63. Colors and Visible Elements
You can control the color of each member or element, and its visibility from the ribbon

command © Colors or from the menu “GTS Display>Colors” or by typing GTSColorView at
the command prompt.

Using the tab “Sections” in the “Color Options” form shown below, you can assign a different
color for each cross-section profile and set its visibility to ON or OFF. By pressing “Reset Colors”,
all colors are set to defaults. By clicking on the color value cell a pop-up dialog appears, where
you can select the color that you want to be assigned to this section. If you select “BYLAYER” or

256 then the color is assigned by the color set at GTS Disaplay>Options @ Options , as
explained in 2.6.64.
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Color Options

Sections Groups

Categories

Sections Visible
HE320B
IPE330
IPE120

BheB0n5

Mote:  you set a colorto 256 (BYLAYER) then the coloris defined by the color set
at View > Options Dialog

CncheckALL | [ CreokALL |

ok | [ Goos ]| oh

Using the tab “Groups” in the “Color Options” form, you can assign a different color for each
group and set its visibility to ON or OFF. Moreover, you can set a color for entities that do not
belong to any group (UnGrouped data). For entities belonging to more than one groups, the one
that appears last in the color list is the one that defines it’s color and visibility.
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Color Options
Growes

Categores

Groups Visible

Columns

Beams
Girders
Bracing

UnGrouped data

Mote: f you set a color to 256 (BYLAYER) then the color is defined by the color set
at View > Options Dialog

ff @ member/shell/joint belongs to maore than one groups, the one that appears last
in this list is the one that defines its' color and visibility

reveck ALL | | CreckALL

Note, that if the “Sections” tab is active when pressing “OK”, then the colors will be selected
according to the “Sections” tab. If the “Groups” tab is active when pressing “OK”, then the
colors will be selected according to the “Groups” tab.

2.6.64. Display Options

You can set the display options from the ribbon command & Options . £0m the menu “GTS
Display>Options” or by typing GTSDisplay at the command prompt. Using the “Display
Options” form shown below, you can:

- set which objects will be visible or not

- set object colors

- set which labels will be visible or not

- set font sizes for labels. NOTE: Font sizes are defined in length units, except Annotation
fonts that are entered in Points.
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- set type of Annotation Format: Decimal, Exponential or Generic (automatic) and the
number of decimal places

- set object sizes

- set the shrink factor for finite elements and members. This option makes it is easier for
you to detect members that lie along finite element edges.

Do Not Display Thickness in 3D. If you check this option, elements will be displayed as

being 2D instead of a 3D display which shows the thickness of the elements. This option
may increase the display speed in very large finite element models.

Display Members as Analytical or Physical (see 2.6.62)

Display Options

Visible Objects Visible Labels

Joints Joints

Members Members

2D Elements 2D Elements

30 Elements 3D Elements
Label Settings - Font Sizes Object Sizes

Toints : 9.842520 TJoint - 1.968504

Members : 2842520 Load Arrowhead (pts): 10.00000

2D Elements : 2842520

20 Hements » Q,842520 Display Members [ Elements

i : 1.0 LY

Aemskaion (i) - 10000000 Shrink Factor :

Annotation Format: | Decimal = [ |Do Mot Display Thickness in 30

Dedmal Places : 2 ¥ Members As: Analytical v

Scale Factors

Concentrated Load (pts) : 72.000000

Distributed Load (pts) : | /2000000

2.6.65. Annotate
You can display information related to your model from the ribbon command k7 Annotate or

by typing GTSAnnotate at the command prompt. The “Annotate” form appears where you
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choose the type information needed, press the “Annotate” button and select the corresponding

entities.

Annotate

Ingquire
(@) Coordinates

{_) Dimensions [ Distance
(") Joint Names
() Member - Element Names

(") Member Forces

Arrowhead (pts): 10000000
Font Size (pts) : 10.000000
ik Close

2.6.66. Select CAD Modeler’s entities

The available inquire options are:

Coordinates of a specific Joint or
AutoCAD/BricsCAD Point. Immediately after
selecting this you have to select one Joint or
Point.

Dimension/Distance between two Joints or
AutoCAD/BricsCAD points. Immediately after
selecting this you have to select two Joints or
Points.

Joint Names to display the name of a specific
joint. Immediately after selecting this you
have to select one Joint.

Member or Element Names. Immediately
after selecting this you have to select one
Member or Shell.

You can also control the size of the fonts (in
points) and the arrowhead.

You can use all AutoCAD’s/BricsCAD’s selection functions (window, crossing, pick, etc) to select
CAD Modeler’s structural entities. In addition, there is a command to help you selecting entities,
having functionality similar to GTMENU. You can access this command from the ribbon

command & Select by typing GTSSelect at the command prompt. The “GTS Select”

form appears where you can set the selection options.

GTS Select - Bounded Line Selection: All entities
that lie on a Line
Select Options - UnBounded Line Selection: All
®Line @ Bounded entities that lie on a Line or its
extension
) Plane - Bounded Plane Selection: All entities
) that lie on a Plane
() valume () UnBounded - UnBounded Plane Selection: All
entities that lie on a Plane or its
Filter Options extension

-  Bounded Volume Selection: All
entities that are located inside a
Volume

Joints [ |Members [ |Elements

- UnBounded Volume Selection: All
entities that are located inside a
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Volume or its extension

Moreover, you can choose to filter only Joint, Members and Elements during the selection.

2.6.67. Display Member Local Axes

You can view the local axes of all members from the icon >" Member Local Axes (Ribbon GTS

Display) or from the menu “GTS Display>Member Local Axes” or by typing
GTSDisplayLocalAxes at the command prompt and immediately after you click at the
point where you want the legend to be displayed.

In the legend, the X axis is displayed in cyan, Y axis in red and Z axis in yellow. The size of the
arrow and its arrowhead is controlled by the value given at Display Options > Object Sizes > Load
Arrowhead and the size of the legend fonts is controlled by the value given at Display Options >
Label Settings — Font Sizes > Annotation (pts) (shown in 2.6.64).

2.6.68. Display Member Releases

Releazes
You can view the member end releases of all members from the icon / Release (Ribbon GTS

Display) or from the menu “GTS Display>Member Releases” or by typing
GTSDisplayReleases at the command prompt.

A text identifying the released degrees of freedom appears next to members having releases. No
text appears for members that do not have releases. The size of the legend fonts is controlled by
the value given at Display Options > Label Settings — Font Sizes > Annotation (pts) (shown in
2.6.64).

2.6.69. Display Shell Planar Axes

M7 Shell Planar Axes
You can view the planar axes of all shell elements from the icon i (Ribbon

GTS Display) or from the menu “GTS Display>Shell Planar Axes” or by typing
GTSDisplayPlanarAxes at the command prompt and immediately after you click at the
point where you want the legend to be displayed.

In the legend, the X axis is displayed in cyan, Y axis in red and Z axis in yellow. The size of the
arrow and its arrowhead is controlled by the value given at Display Options > Object Sizes > Load
Arrowhead and the size of the legend fonts is controlled by the value given at Display Options >
Label Settings — Font Sizes > Annotation (pts) (shown in 2.6.64).

2.6.70. Display Joint Supports

You can view the support status of each joint from the icon g Joint Supports (Ribbon GTS

Display) or from the menu “GTS Display>Joint Supports” or by typing GTSDisplaySupports
at the command prompt.

A red arrow is displayed for the translational restrained degrees of freedom and a yellow arrow
is displayed for the rotational restrained degrees of freedom. The size of the arrow and its
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arrowhead is controlled by the value given at Display Options > Object Sizes > Load Arrowhead
and the size of the legend fonts is controlled by the value given at Display Options > Label
Settings — Font Sizes > Annotation (pts) (shown in 2.6.64).

2.6.71. Display Joint Loads

You can view the joint loads applied in the structure from the icon i Joint (Ribbon GTS

Display) or from the menu “GTS Display>Joint Loads” or by typing GTSDisplayJointLoads
at the command prompt.

Display Loads The “Display Loads” form appears where you
can select the desired Load Case, the Scale
Load Case Factor for Joint Loads, Arrowhead Size and
PL W the Font Size. The “Show” button displays the
load arrows, and the “Clear” button erases

Display Loads Applied To them.

Joints [ |Members [ | Elements

Display Options

Scale Factor Concentrated (pts) 72.000000
Scale Factor Distributed (pts) : |~ = 0°0000
Arrowhead Size (pts) : 10.000000
Font Size (pts) : 8.000000
Show Clear Close

2.6.72. Display Member Loads

You can view the member loads applied in the structure from the icon o Member (Ribbon GTS
Display) or from the menu “GTS Display>Member Loads” or by typing
GTSDisplayMemberLoads at the command prompt.
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Display Loads

Load Case
PL W

Display Loads Applied To

[ ] Joints Members [ | Elements

Display Options

Scale Factor Concentrated (pis) 72.000000

Scale Factor Distributed (pts) 72.000000

Arrowhead Size (pts) : 10000000

Font Size (pts) : 8.000000
Show Clear Close

2.6.73. Display Shell Loads

The “Display Loads” form appears where you
can select the desired Load Case, the Scale
factor for Concentrated or Distributed
Member Loads, Arrowhead Size and the Font
Size. The “Show” button displays the load
arrow, and the “Clear” button erases them.

ri—u A
You can view the finite element loads applied in the structure from the icon &oArea (Ribbon
“GTS Display>Shell Loads” or by typing
GTSDisplayElementLoads atthe command prompt.

GTS

Display) or from the menu
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Display Loads The “Display Loads” form appears where you
can select the desired Load Case, the Scale

Load Case factor for Concentrated or Distributed
11 W Member Loads, Arrowhead Size and the Font
Size. The “Show” button displays the load

Display Loads Applied To arrow, and the “Clear” button erases them.

[ ] 3oints [ ] Members Elements

Display Options

Scale Factor Concentrated (pts) 72.000000

Scale Factor Distributed (pts) : | 000000

Arrowhead Size (pts) : 10.000000

Font Size (pts) : 10.000000
Show Clear Clase

2.6.74. Display Area Loads

T A
You can view the area loads applied in the structure from the icon &Area (Ribbon GTS

Display) or from the menu “GTS Display>Area Loads” or by typing GTSDisplayArealoads
at the command prompt. Loaded areas appear in yellow solid hatch. If you want to display only
one area load, you can use the area load command (2.6.48) to bring up the area load dialog,
select the specific area load and click “Display >>".

2.6.75. Display Deformed Structure

You can view the deformed shape of the structure from the icon I (Ribbon GTS

Display) or from the menu “GTS Display>Deformed Structure” or by typing
GTSDisplayJointDisplacements at the command prompt. You must then immediately
select the load case, press ENTER, and then give the desired scale factor.

Select Load Case

Load Case

<5elect Load Case > W

i Undef d
You can switch back to original view from the icon L (Ribbon GTS Display) or from

the menu “GTS Display>Undeformed Structure” or by typing
GTSResetJointDisplacements atthe command prompt.
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Note that Deformed Structure can be displayed in both 3D and Wireframe views of your model
and that you can also switch between levels using the Levels Form or the Upper Lever, Lower
Level icons.

2.6.76. Annotate Joint Displacements
At the deformed state, you can annotate joint displacements of the structure from the icon

el - -
Annotate Displacements

(Ribbon GTS Display) or by typing
GTSAnnotateJointDisplacements at the command prompt. This command is valid
when the deformed shape of the structure is visible, where you select a joint and then a point in
screen for annotation position.

2.6.77. Display Displacements

You can view the displacements of the model (including a member’s deformation between

joints) from the icon F7 Displacements (Ribbon GTS Display) or from the menu “GTS
Display>Displacements” or by typing GTSDisplaySectionDisplacements at the
command prompt.
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Displacements The “Displacement” form appears where you
can select:

Load Case f Load Combination )
- The desired Load Case or

SW S Self Weight W L.
Combination
- The Scale factor
Display Options - The Font Size (in pts) for Annotations
0.100 and the Annotation Format.
Scale Factor (Values) - Choose to display the model or Hide
Font Size (pt) : 10.00 it, so that the deformed shape is
Annotation Format:  Dedmal ¥ clearer.
Decimal Places - y - The “Display >>" button displays the

deformed shape for the Vvisible

[ Hide Model members and elements. If there are

any hidden members or elements

their deformed shapes are not
displayed.

Annotate = Legend > - The “Annotate >” button allows you
to annotate any value on the
deformed shape by fist clicking on
the deformed shape curve and then

Display ==

Animation Options

Frames : at the position that annotation will

Animation Speed % : 1 w be placed.

— - The “Legend >” button allows you to
Generate Animation

Frames

:
o
T

place a legend on screen, having
information about the load case.

Clear Close - The “Generate Animation Frames”
button creates the animation frames
that can then be played in a loop by
using the “Animate>>" button.

2.6.78. Display Member Diagrams

Di g
You can view the force and moment diagrams from the icon T Ciagram (Ribbon GTS Display)

or from the menu “GTS  Display>Member  Diagrams” or by typing
GTSDisplayMemberForces atthe command prompt.
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Member Diagrams

Load Case [ Load Combination

SW S Self Weight W
[ |Envelope
Values

MZ Moment W

Display Options

Scale Factor (Values) 0.100
Font Size (pt) 10.00
Annotation Format: | Dedmal ~
Decimal Places : 2 ~

[ |Label Max &Min [ _|Positive Sign

Display ==
Annotate = Legend =

Clear Close

The “Member Diagrams” form appears where
you can select:

The desired Load Case or
Combination

The Envelope option and the load
cases that form the envelope.

The Forces or Moments to be
displayed (FX, FY, FZ, MX, MY, MZ)
The Scale factor

The Font Size (in pts) for Annotations
and the Annotation Format.
Automatically Label Maximum and
Minimum values for each diagram
Choose the direction of the diagrams
by switching the Positive Sign.

The “Display >>" button creates the
diagram for the visible members. If
there are any hidden members their
diagrams are not displayed.

The “Annotate >” button allows you
to annotate any value of the diagram
by first clicking on the member
diagram curve and then at the
position that annotation will be
placed.

- The “Legend >” button allows you to place a legend on the screen, having information

about the load case and member diagram.

2.6.79. Display Finite Element Results

You can view the finite element results from the icon i Elements (Ribbon GTS Display) or from
the menu “GTS Display>Element Results” or by typing GTSDisplayElementResults at

the command prompt.

NOTE: Hardware graphics accelaration may cause AutoCAD to incorrectly display the colors of

the contour. In such a case it is recomemded that you turn OFF Hardware Accelartion, during
displaying the stress contours, by typing the command GRAPHICSCONFIG. You can turn it

back ON afterwards.
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Graphics Performance

Hardware Setup
Video Card: NVIDIA GeForce GTX 660M

Dwriver Version: 9.18.13.697

Effects Settings

Hardware Acceleration

Disable hardware acceleration only if you are expenencing

graphics issues or have an incompatible video card,

Element Results

Load Case
PL & Pressure load W
Type
Resultants v
Mxx W
Middle "
Display Options
Scale Factor (Values) 0.100
Font Size (pt) 10,00
Annotation Format: | Dedmal w
Decimal Places : 2 W
Display ==
Annotate = Legend =
Animation Options
Frames : 7
Animation Speed %6 ; 10 W
Generate Animation o
Frames il LLlES
Clear Close

Virtual Device: gdi13.hdi(Software)

o

The “Element Results” form appears where
you can select:
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The desired Load Case
The desired item to be displayed:

Stress, Strain, Resultants, Principal
Stress, Principal Strain, Principal
Membrane Resultant, Principal

Bending Resultant, Von Misses

The component of the desired item to
be displayed, i.e. Sxx, Syy, Szz

The Location: Top, Middle or Bottom
surface of the element which s
defined by the local or planar z axes of
the shell element. The top surface is
in the positive z direction.

The “Annotate >” button allows you to
annotate any value of the diagram by
fist clicking on a joint and then at the
position that annotation will be
placed.

The “Display >>" button creates the
contour and a popup legend showing
the limits of each color.

The “Annotate >” button allows you to
annotate any value of the diagram by
first clicking on the member diagram
curve and then at the position that
annotation will be placed

The “Generate Animation Frames”
button creates the animation frames
(contours and displacements) that can
then be played in a loop by using the
“Animate>>" button.



2.6.80. Display Finite Element Selection Results

You can view the finite element results of selected elements from the icon E selection
(Ribbon GTS Display) or from the menu “GTS Display>Element Results Selection” or by typing
GTSDisplayElementResultsSel atthe command prompt.

This command is similar to the “Display Finite Element Results” of the previous paragraph. The
only difference is that you have to give a selection of members for the contours. This is useful in
cases where you want to examine only one surface of the structure, so display the limits of the
specific area. Or, if you do not want to take into account stresses from elements not belonging
to a specific plane.

NOTE: An “Execute GTI” command, including stiffness analysis, must be given prior to this
command.

2.6.81. Display Member Code Check Results

You can view the pass/fail result of a Steel Code check or design from the icon Code Check

(Ribbon GTS Display) or from the menu “GTS Display>Member Code Check Results” or by typing
GTSColorCodeCheck at the command prompt. You must then select the members to be
displayed (or “ALL” for all of them).
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Code Check Results The “Code Check Results” form appears
where you can select:

DI_S_I_jlayTEXt - The text to be displayed for each
\® None member, giving additional
() Actual/allowable Stress Ratios information such as stress ratios,
(7) Controlling Stress Code Provision controlling provisions and KL/r ratios.

- The Font Size (in pts)

O Actual/alowable KLfr Ratios - Limits for the Values to be displayed

() Controling KLjr Code Provision (in example All of them, or Greater
Than a given value, or Less Than a
S — given value).

- The “Display >>" button regenerates
the view and members which passed

() Greater Than 0.00 the code check will appear in blue,
those that fail the code check will

() all

LA — appear in red and those that were
not included in the code check will

EaiRar I appear in white
Font Size {pt) 10.00 - The “Legend >” button allows you to
place a legend on screen, having

Display =3 information about the colors used.
yegend > When vyou press the clear button,
member colors remain blue and red for
Clear Close

your convenience. If you want to change
them go to GTS Display > Colors.

2.6.82. Results Datasheets
In addition to the graphical display of results, you can also view the results in datasheets from

item “Results Datasheets” of the menu or ribbon tab “GTS Display”. In the table below, you can
find all the available results that can be viewed in datasheets and the corresponding command.

Description Menu Item Command
. GTS Display>Results _ _
GTSDataSheetJointDis
Displacements Datasheets> Displacements P
Member Forces GTS Display>Results GTSDataSheetMemberForces
Datasheets> Member Forces
Section Forces GTSDBpmy>Reﬂ4“ GTSDataSheetMemberForces
Datasheets> Section Forces
Reactions GTSDBpmy>Reﬂ”§ GTSDataSheetReactions
Datasheets> Reactions
Stresses GTS Display>Results GTSDataSheetStresses
Datasheets> Stresses
GTS Display>Results
GTSDataSheetCodeCheck
Code Check Datasheets> Code Check
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For example, click on the icon B Displacements (Ribbon GTS Display) or from the menu “GTS

Display>Results Datasheets>Displacements” or by typing GTSDataSheetsJointDisp and
the “GTSTRUDL — Joint Displacement Datasheet” dialog appears where you can filter, sort, write
results to text file or change results units as shown in figure below:

B GTSTRUDL - Jeint Displacement Datasheet, display Units: Meters Degrees m} X
File Edit Columns Filter Sort Units Help
Joint Load Trans X | Trans ¥ Trans Z Rotation X Rotation ¥ | ~
1 SW a. a. -0.0000138
2 W 0. -0
2 W 0.t -0.
4 SW 0.0 -0.
5 SW 0.t -0.
€ SW 0.0 -0.
7 W 0. -0.0000245 .
2 sW a. -0.0000541 0.0000053
E] SW 0. -0.000030% -0.0000440
10 SW 0. -0.0000478 0.0000193
11 SW a. —-0.000042¢ -0.00002283
1z W 0. -0.0000353 0.0000310
1z sW a. -0.0000511 -0.000020€
14 SW 0. -0.0000470 0.0000164
15 W 0. -0.0000420 -0.0000298
1 SW a. —-0.0000307 0.0000055
17 W 0. -0.00003594 0.0000016
1z SW a. -0.0000175 -0.0000173
1% SW a. -0.0000125 0._0000066
20 W 0. -0.0000321 0.t I
Zl SW a. -0.0000101 -0,
2z W o. Q.0 0.
23 SW 0.0 0.0 a.
24 W 0. 0.0 0.
25 W 0.t 0.0 0.
2¢ SW 0.0 0.0 a.
27 SW 0. 0.0 0.
2a SW a. -0.0000073 0.0000003 w
£ >

2.6.83. Report Builder

Report
You can generate your reports by calling Report Builder from the icon Builder (Ribbon GTS

Display) or by typing GTSReportBuilder at the command prompt. GT STRUDL Report
Builder is self-contained software, which allows you to generate reports graphically from DBX GT
STRUDL database files on the top of GT STRUDL software. CAD Modeler automatically generates
the necessary DBX files and launches Report Builder. You can find more information on how
creating your report in the GT STRUDL® Report Builder Getting Started Guide.

2.6.84. Clear Results Layer

You can clear the displayed output (Display Model, Display Loads, Display Results), hide the

Legend form of the contours and return to model from the icon <& Clear (Ribbon GTS Display)
or from the menu “GTS Display>Clear  Results Layer” or by typing
GTSDisplayResultsClear atthe command prompt. This command should be given after
any of the previous “display” commands.

2.6.85. Version

The current version of CAD Modeler can be displayed by selecting from the menu “GTS
Display>Version” or by typing GTSVersion at the command prompt. The current version will

be displayed at the command line: The current version of CAD Modeler is
XXXX
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3. Tutorial Example #1

3.1. Introduction
The modeling of a three story building using CAD Modeler shown below is demonstrated in a
step-by-step process.

3.2.  Open CAD Modeler and start working

Step #1. Launch GT STRUDL by selecting the icon “CAD Modeler” in the Welcome to GT STRUDL
dialog shown below. The version of AutoCAD/BricsCAD selected during the installation will be
automatically launched, together with CAD Modeler’s menus and ribbons.
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Welcome to GT STRUDL -O=x

B Cpen Learn mere about GT STRUDL ) Hide Details o = a 7] -
0 Ee. GT Menu CAD Modsler Command Mode Model Wizard Base Plate Wizard { *
Bk i e al 4 mesign Gy model Analyzs & design com ¥ g CADWore®
~ gl cplal oo o M o e e ad HEXAGON P
iz Options wtaace Neeatal s ta tructural snaktt Lstng & fints slarnant anad PPM
and swsgn sppetacn
What is GT STRUDL?
..... Introduction to GT STRUDL €&
View an informative webinar on the new licensing
syslem presented on January 28, 2020 by cheking
Ctart a Mew Project é
here.
i GT
Alirmited satesaan af the product thit can be wsed s an
[ 1 FH ﬁh L] X mtroduction to the mast fraquently used features
Ty, —
ﬁ‘ﬁ P ] .
T Webinars
<fy —
_| : | / Q= .,I.,
GF Menu CAD Modeler Commari Mode Motlel Wizard Eate Plate Wizsrd
CAD-Dased Modaling for Struciural Cnginsges:
Working Directory February 20, 2020°
Medem Lean Project Execution. Bayond
Connecting Design 1o Engmasrnn i
DAGTOAN Testing\ 2020-04-27_UTC-U3-22-5TVGTS 2020 Shell MOU6Y_gti Ca Siructurad and Piging Recorded I

813

Racant

On-Demand Wekbingr, CT STRUDL VWebinar:

Model Your Way wi

Date: December 13. 2015

On-Demand Webinar GT STRUDL Webinar: Lean

arkfiow with Intargragh Smart 30

Recorded Date; October 18, 2018 v

< >

Step #2. Make sure that CAD Modeler’s ribbons and menus are visible.

oin Paamainc Vi Mlidge Cutpid  Colabee T iciring | GMGipley -
T Ak Hoghelewd B Geerste I [ / # Mege. | g Find loirt = t m . ) Edmloput File A Frame £ | Aenceme
AR ST SRR ¥ e Chunge bt = > 3 Rescfiein 2= AnshScalPhysical (D Setview S Selest
Grid Setiors, Gamerate Verical Salt . W Lk Cose Earoe 3
& Mleah 0N B Suppen Design | 1% sointa Dupcates = Extrude’ e 5 v dnput File GESTRUDL (3 Impon 6T b Dptiens O Colon | (3] Cheie
Madel Levek Joaray Mamban Find!Change/Chack hele Mashang Advanced  Groups GrImey Duplay Inguee

If AutoCAD’s/BricsCAD’s menu is not visible, type MENUBAR at AutoCAD’s/BricsCAD’s
command prompt, then 1 and press <ENTER>.

If AutoCAD’s/BricsCAD’s ribbon area is not visible, type RIBBON and press <ENTER>.

Ribbon commands will be used in this tutorial example. However, since all ribbon commands
appear in the menu area, you can use the menu bar as well.

3.3. Define the basic geometry of the model

M Units

Step #3. Define the correct Units by pressing the icon
KiloNewtons in the Units Form.

and select Meters (m) and
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Units >
Length Force Angles
() Inches {in) () Pounds (lbs) (®) Degrees
(I Feet (ft) () Kips () Radians
@ Meters (m) O Tons O Cydes
() Centimeters {cm) () Kilograms
() Millimeters {mm) () Metric Tons Time
Temperature () Mewtons (®) Seconds
() Fahrenheit (®) KiloMewtons (I Minutes
@ Centigrade l:::l Megahewtons l:::l Hours
Scale non-structural CAD entities
(grids, structural lines, curves etc) Cancel

Step #4. Enter the cross-section profiles that will be used at the model by pressing the icon

XL

Sections  Click on the European list and then on the HEB table of profiles. Select the profile

HE3208B that will be used for the columns, by double clicking on it.

85



W] alsc 13th Edition 2005
-] AISC 13th Edition 2005 Metric
f-f] AISC gth Edition 1389

-] AISC LRFD 3rd Edition

-] AISC gth Edition Metric

-] AISC 8th Edition 1978

-] AISC 7th Edition 1952

v ] AISC 6th Edition 1953

E] aNSI Pipe

[#~F] Brazilan Standard, NBR 5884:2000
-] British Standard 5350

ElEl European

----- Q) sQHOLLOW
----- O CIHOLLOW
----- v BSEQANGL
----- N BSUMANGL
..... I BSEQDBAN
----- ~~ B55LDBAN
..... —wr— RSl NRAN

HEB

HE100B
HE120B
HE140B
HE150B
HE130B
HE200B
HE220B
HE240B
HE260B
HEZ50B
HE300B
HE340B
HE360B
HE400B
HE4508
HES00B
HES50B
HEGOOB
HEG50B
HEFO0B
HEZ00B
HESO0B
HE1000B

= European
T HE&
T HEEB
& HE3Z0B
T HEM
T IPE
® |PE330
® IPE120
T EUROPE&M
Cu
[ REHOLLOW
) SQHOLLOW
O CIHOLLOW
" BSEQAMGL
® EOxE0=5
* BSUMAMGL
ar BSEQDBAM
=~ BS5LDBAM
=~ BSLLDBAN

Cancel

The profile is added to the project and it appears in the left list-
box having a black dot in front of it.

Using the same procedure, add 3 additional profiles: IPE330, for
beams, IPE120 for the girders from table IPE and 60x60x5 for
the bracing from the table BSEQANGL. Press OK to close the

form.

Note: You can add additional profiles at any time by following
this procedure and also view the full list of profiles used in your

model and add more profiles if needed.
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Step #5. Define the 3 levels of the model by pressing the icon L&¥Els  Press the Add Level button
3 times to add 3 levels to your model. Modify the height of the 1% level by selecting the Height
cell of the 1% Level and entering 4.

Note: Some Edit Boxes appear in yellow background and green fonts, like the one at the Level
Heights. You can use mixed units in the yellow edit boxes. For more information about Mixed
Units and the valid syntax please read GT STRUDL GT Menu Guide

Make sure that Z Vertical Axis option is checked and press OK to close the form.

Level Properties X
Level Heights Options
Levels ] Elevation | Visible | Add Level |
| Delete Level |
| DetectLevels Automaticaly |
| Merge Levels |

Base Elevation 0.0000

[+]z vertical Axis (else 1)

[Jupdate Levels for All Entities

ok | cancel

Step #6. Enter a Grid that will help you enter the columns quickly by clicking on the icon ©rid
The grid is going to have 3 spaces (6m, 5m, 6m) in the horizontal direction (X) and 1 space (5m)
in the sidelong direction (Y). Enter 6 in the Distance text box and press the Add button. Repeat
by entering 5 and Add, and 6 and Add.
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Flacement Then, click on Sidelong in the Placement area
to enter the spacing in the Y direction, and

(®) Hori (s
®) Horizontal ) Sidelong enter 5 and Add.
Spacing By pressing OK you are prompted (command
= prompt) to enter the Insert Point for the grid.
Distance: | 5.0000
6.0000 Type 0,0,0 and press <ENTER>.
5.0000
5.0000

Add

The grid is created, having its upper left corner A-1 at the point 0,0,0.

@

(@

® ® © @

You will be able to view the grid by pressing the Top Icon in
AutoCAD’s View Cube or BricsCAD’s Chair Icon, or preferably by
typing Z (for Zoom), E (for Extents) and press <ENTER>.

-
v

Note: In order to be able to snap at the intersection of the grid lines, while placing columns,
make sure that the AutoCAD’s/BricsCAD’s Object Snap is ON, and the Intersection mode is
enabled. Type OSNAP in both AutoCAD and BricsCAD to set the various snap settings. Shown
below is the ObjectSnap tab in AutoCAD’s Drafting settings dialog.
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[[]Object Snap Tracking On (F11) Endpoint

Object Snap On (F3)
Object Snap modes Midpoint
Center
O Endpoint B []insertion Select Al Node
v [ Midpoirt b []Pependicular Clear Al Qriten
Intersection
{3y [Center 77 [ Tangent Insertion
Perpendicular
P
@ [ Node ¥ [INearest Tangent
£ [ Quadrart E [ Apparent intersaction RS _
E0mMELnc center
Geomet t
d Intersection “w I:l Parallel Apparent intersection
) Extension
- |:| Bxtension Parallel
0
p I\) To track from an Osnap point, pause over the point while in a "
éf command. Atracking vector appears when you move the cursor. Off
Ta stop tracking, pause over the paint again. £ Settings..

ESMNA

BricsCAD’s Snap Settings

AutoCAD’s Snap Setting

3.4. Create the 1% floor

i

Step #7. Start entering the columns by clicking on the icon Vertical  The dialog Place Member
appears that helps you to quickly select properties for the members that are going to be
entered.

Cross Section

Table Section:
HE320E HEE European

or Member Dimensions:

<Select Shape=

or Same as Member:

<Select Existing Member =

Material
Steel

Releases

Fix-Fix W

Place Member(s) ==

Beta (o)

Select HEB320B as the cross section for the
columns. Make sure that Material is set to
Steel, Releases to Fix-Fix and the Beta angle is
0. There is no need to close this dialog
manually.

Press the “Place Member(s) >>” button.

Click at the intersection point between line A
and line 1 (point A-1) and the column will be
placed at this position.

Repeat the same procedure by clicking at the
points B-1, C-1, D-1, A-2, B-2, C-2 and D-2.

When you are done, press ESC to exit the
Vertical column command. The Place
Member form is automatically hidden.
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2 Note: Each time you create a member the
orientation of the cross section will appear in
the middle of the element, unless you clear it
with command “Clear” (see 2.6.84).

Step #8. You can easily change to an isometric view of the structure by pressing the small house
icon in AutoCAD’s View Cube or the small arrow “Top Front Left” of the following image in
BricsCAD’s View Chair. As you can see in the isometric view below, column members 1 to 8 were
created together with joints 1 to 16 at their ends. Each column is 4.00m long, as defined in Level
Properties (height of the first floor).

T

W > {E . 7 a
vl
L2
= Q.
Top Front Left
Wes
AutoCAD’s View Cube for Isometric View BricsCAD’s View Cube for Isometric View

90



91




Y

Step #9. Start entering the beams, along X axis, by clicking on the icon Generate  The Plgce

Member form appears.

Cross Section
Table Section:
IPE330 IPE European

or Member Dimensions:
<5elect Shape =

or Same as Member:

<5Select Existing Member >

Material
Steel

Releases

Fix-Fix W

Split Intersecting Members

[ ] split Ending Members

Place Member(s) ==

Beta (o)

30

[ | Physical Member

Select IPE330 as the cross section and
make sure that Material is set to Steel,
Releases to Fix-Fix and the Beta angle is
90. You have to set the Beta angle equal
to 90 degrees in order to orientate the
local Y axis of the IPE cross section along
the Z global axis. Moreover, make sure
that the option Split Intersecting
Members is checked and then uncheck
Split Ending Members.

Press “Place Member(s) >>" button.

Starting Point (x,y,z) message appears,
asking you to enter the coordinates or
click on a specific point on screen. Click
on Joint 2 at the top joint of column 1 at
position A-1.

Then you have to define the Ending Point (x,y,z) so click on joint 8, as shown in the picture

below.
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Members 9, 10 and 11 will be created.

s

S

All three beams along X axis were generated with only two clicks of the mouse: at joints 2 and 8.
The beam from joint 2 to joint 8, was split into three parts, between joints 2, 4, 6 and 8, since
joints 4 and 6 (columns at positions B-1 and C-1) intersect this member.

Since the command is still active, you are prompted to enter the Starting Point (x,y,z), repeat the
same procedure by clicking on joint 10 (top of column at position A-2), and then click at joint 16
(top of column at position D-2). Members 12, 13 and 14 will be created.
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Step #10. Enter the beams, along Y axis. The command Generate Beams should be still active,

/

else you can call it again by clicking again on the icon Generate | Keep the same settings at the
Place Member Form, as in the previous step, regarding the cross section and Beta angle, but do
NOT click on Split Intersecting Members. Press the “Place Member(s) >>" button.

The prompt message Starting Point (x,y,z) appears, asking you to enter the coordinates or click
on a specific point on screen. Click on the Joint 2, that is the top of column at position A-1. In
order to define the Ending Point (x,y,z) click at joint 10 (top of column at position A-2). Member
15 is generated.

Repeat the same procedure by clicking on the joints 4 and 12 to generate member 16, joints 6
and 14 to generate member 17 and joints 8 and 16 to generate member 18. Then, press ESC to
terminate the command.
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Step #11. Create an arc on the right side of the structure:
Type ARC and

- in order to Specify start point of arc or
[Center]: click on joint 8,

- to Specify second point of arc or
[Center/End]: type @2,-2 and press
<ENTER> and

- to define the end point of arc: click on joint
16.

o
4]

1D

Step #12. Generate Members along the Arc: Click on the icon ““™¢ and when the prompt
message Select Curve (Line or Arc) appears, click on the Arc that you have created in the
previous step.



Select Mesh Properties The Select Mesh Properties form appears
where you enter:

Generate .
Material : Steel

(@) Members Elements Beta Angle: 90

Material | Steel W - Section: IPE330
- Spacing U Direction: Uniform 8
Element Attributes
Type BPHQ Thickness e
This command is going to generate 8 linear
Member Atiributes members equally spaced along the arc.
a0 .
Type |[FRAME ¥ Beta You can press the Preview button to see the
Section |IPE330IPEEuropean W ||« members as they will be generated.
Spacing U Direction Press the Create button and 8 members,
named 19 to 26, were created and 9 joints,
(®) Uniform 8 v named 17 to 25 were created along the arc.

Ll Note that joints 17 and 25 are created on
Defined by Line /Curve the top of joints 16 and 8 correspondingly.
Later on, they are going to be merged

together by deleting duplicate joints.

Step #13. Hide Grid: Since the Grid is no longer needed it can be hidden using
AutoCAD/BricsCAD commands to freeze the layer GRID_LAYER. This can be done by clicking on
the Home Tab and then selecting the GRID_LAYER from the drop down list of layers and clicking
on its freeze icon.

Insert  Annotate  Parametric  View Manage Output Plug-ins Online  Express Tools  GTS CAD Mot

S D@ 8w Orowe +1m - 4 @8R BEEBS

< IR s i Mi ("] Fillet - 59| | Unsaved Layer Stat M
Line Polyline Circle  Arc ?J S ﬂlh et '_—| I i nsa‘lure i T
M M = [A Stretch [ Scale BB Amay - @ || ) a0 v|
Draw ~ Modify ~ || & o [l GRID_CIRCLES
[-] [Custom View] [2D Wireframe] | Q o rﬁh . SLA L= uEe |
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Step #14. Turn OFF labeling:

Visible Labels Click on the icon & Options in the ribbon bar and
[ Joints then uncheck the Visible Labels option for Joints,
Members and 2D Elements.
[ |Members
Now labeling is turned off and it is easier and faster to
[ ]2D Elements view and control the model.
3D Elements

Note: You can also delete or hide the Arc line as it is no longer needed. It can be deleted by
selecting it with the mouse, and then presssing the keyboard button <Delete>. Be carefull not to
select any members or joints, but only the Arc line.

Step #15. Mirror the structure: Switch to a floor pan view, by pressing the TOP of AutoCAD’s
View Cube or BricsCAD’s View Chair.

Then, type MIRROR and when you get the notification Maintain incidence order (Yes/No). Press
Yes to maintain the local coordinate system when mirroring.

NOTE: This option is very useful when mirroring structures having shell finite elements and the
mirror line lies along the element’s XY plane. If you choose to maintain the incidence order, then
after the mirroring the local Z axis of the source and copied finite elements have the same
orientation.

You are then immediately prompted to Select objects: (AutoCAD) or Select entities to mirror:
(BricsCAD) select the right part of the structure, but not the members and joints that are on the
mirror line. In order to make this selection, make the 1% and the 2"¢ click of the mouse at the
points 1 and 2 as shown in the picture below and press <ENTER>. You will get a confirmation
that 44 objects were found (or 45 if you still have the arc).

4

\

When you get the message Specify first point of mirror line (AutoCAD) or Start of mirror line
(BricsCAD): click on the joint at points 3 and then Specify second point of mirror line (AutoCAD)
or End of mirror line (BricsCAD): click on the joint at point 4 as shown in the picture above.
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Then, press <ENTER> and reply to the question Erase source objects? [Yes/No] <N> (AutoCAD)
or Delete the original entities? [Yes-Delete entities(Yes)/No-Keep entities(No)] <No-Keep entities>
(BricsCAD) so as not to delete the right part of the structure. The structure after the mirror
command will look like the following picture:

Step #16. Switch to 3D View: Press the house (AutoCAD) or chair (BricsCAD) icon to change the

fl': Color

view to Isometric, and type Z and E (Zoom, Extents). Click on the icon * to set different

colors for each profile.

Sections Groups

Categories
Sections Color |‘u‘i5i|::lle |
HE3208 161 v
IPE230 191 v
IPE120 v
60x60x5 50 v

Press OK to close the Color Options Dialog. Each cross section will now have a different color.

Press the icon “F to display the 3D solid view of the model, replacing the wireframe view:
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Press the icon R to switch back to wireframe view to be able to process CAD Modeler’s
and AutoCAD’s/BricsCAD’s commands faster.

Step #17. Save your Model: In order to save your model just use AutoCAD’s or BricsCAD’s save
command and store the DWG using any filename that you want.

3.5. Create the 2" floor

Step #18. Copy the members and joints of the 1° floor to the 2"%: Type the command COPY and
when asked to Select objects: type ALL, so that everything is selected. You will get a verification
with the number of objects/entities selected and then press <ENTER>.
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In order to Enter base point or [Displacement/mOde] <Displacement>, click at the base of any
column such as point 1 in the picture above.

In order to Enter second point : click at the top of the same column such as point 2 of the picture
and then press ESC in order to terminate the copy function.

All entities of floor 1 are now copied to floor 2.

Step #19. Correct the Z coordinates of the 2™ floor: The copied columns are 4.00m long, since
they were copied from the 1* floor. In addition, the Z coordinate of the beams is equal to 8.00m
instead of 7.00m. Therefore, all copied joints that have Z coordinate equal to 8.00m should be
moved 1.00m lower.

Switch to FRONT View, by clicking on AutoCAD’s view cube or BricsCAD’s view chair and make
sure that you are in the World UCS by typing UCS and W.

Type MOVE in order to initiate AutoCAD’s/BricsCAD’s move command and when asked to Select
objects (or entities), click on points 1 and 2, as shown in the picture below, selecting all the
entities that belong to the top of the 2™ floor. You will get a notification about the selected
entities and press <ENTER>.
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In order to Enter base point or [Displacement] <Displacement>: click ANYWHERE on the screen.
It makes no difference where you click since relative coordinates will be use to define the
displacement.

In order to Enter second point: type @0,0, -1 and press <ENTER>.

Now the height of the 2™ floor is correct and equal to 3.00 meters.

Note that you can reach the same result by switching to the 2™ Level using the icon

A Higher Level and start entering the columns one-by-one, as you did in the 1° Level. Columns

will then have the correct height (3.00m), since the height of the second Level is defined equal
to 3.00m when the levels were defined in a previous step. Then, copy only the beams from the
1% Level to the correct position. However, it is somewhat faster to copy everything and then fix
the Z coordinate with a simple MOVE command as you did in the previous steps.

3.6. Create the 3™ floor

Step #20. Copy the members and joints of the 2™ floor to the 3™ : Type the command COPY and
when asked to Select objects/entites: click on the similar two points that were used in the
previous MOVE command as shown in the following figure.
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Since this is a crossing window, the columns are automaticallly selected. You will get a
notification about the selected entities and press <ENTER>.

In order to Enter base point: click ANYWHERE on the screen. It makes no difference where you
click since relative coordinates will be used to define the displacement.

In order to Enter second point: type @0, 0,3 and press ESC.

Now the 2" floor is copied to the 3™ one. There is no need to correct the Z coordinates as was
done when the 2™ floor was moved since the second and third levels have the same height.
Press the ESC button to exit the Copy command.
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Step #21. Assign Level Properties:

Options Since all members were created from Level 1 using COPY
commands, all of them belong to level 1 and their correct
Level property should be assigned.

Delete Level %

Detect Levels Automaticaly Click at icon Levels  check the option Update Levels for
All Entities and press OK.

Add Level

Merge Levels
Now every Member or Joint has the correct Level

Base Elevation 0.0000 property depending on its Z coordinate.

You can switch between the levels of the model using the

Z Vertical Axis (glse Y) _
A Higher Level and W Lower Level

icons. The current
[]Update Levels for All Entities level appears in the top caption of AutoCAD’s screen.

You can make whole structure visible by clicking at the
icon 7 all Levels ON

Step #22. View and Save your model: Press the house icon to change the view to Isometric, and
type Z and E (Zoom, Extents).

Press the icon B to display the 3D solid view of the model, replacing the wireframe view as
shown in the following figure:
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Save your model, using a different file name (Save As...). By saving your model with a different
name each time, it is easier to back up to a previous state of the model.

3.7.

Create bracing

Step #23. Place bracing members at the front:

Press the icon

and AutoCAD’s/BricsCAD’s commands faster.

104

Levels Height Elevation | Visible
1 4000000 4000000 ||V
2 3.000000  |7.000000 [
3 3.000000 | 10.000000 ([

" to switch back to wireframe view to be able to process CAD Modeler’s

=

Click at icon Levels —check the
visible property for level 1 and
uncheck it for all other levels and
press OK.



Make sure that “Level :1” appears at the top of CAD window, else use the

W LowerLevel ;0504 to move to Level 1.

A Higher Level and

Y

Now only Level 1 is visible and it is easier to add the bracing members. Click on the icon Generate

and the Place Member form appears.

Select 60x60x5 as the cross section and
make sure that Material is set to Steel,
Releases to Fix-Fix and Beta angle is 0.

Press the “Place Member(s)>>" button.

Click on the joint located at Point 1 of the
following image.

Click on joint located at Point 2 and the
first bracing member is created.

Click again on joint located at Point 2 and
then on the joint located at Point 3 and
the second bracing member is created

Cross Section
Table Section:
o0x60x5 BSEQAMNGL European W

or Member Dimensions:

<5elect Shape = W

or Same as Member:

=5elect Existing Member = W
Material

Steel W
Releases Beta (o)

Fix-Fix W 0 W

split Intersecting Members [|Physical Member

Split Ending Members

Place Member(s) ==

Click on the joint located at Point 4, click on the joint located at Point 5 and the third bracing

member is created.

Click again on the joint located at Point 5, click on the joint located at Point 6 and the fourth

bracing member is created.
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Press ESC to terminate the Generate Beam command.

T Ch Memb
Step #24. Change the properties of the Bracing Members: Click on the icon ange Member

in the Find/Change/Check panel and when asked to Select objects: click on the 4 bracing
members created in a previous Step and press <ENTER>.

The Member Properties [Multiple Selection] form is displayed. Now, change the type to SPACE
TRUSS and press OK.
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Member Properties [Multiple Selection] X

Model  Section Properties  Member Loads Member Temperature Loads  Member Distrortions

Mx Mx

My My

<Gelect Type = Sz Ez:
Start SPACE FRAME
¥d | | Yo
End :

d: | | Zc:
Beta Angle :
Shape Code : I:I
End Sizes OR Member Eccentricities (Offsets)

Groups Start End
Material Properties

General Section Properties Releases & Elastic Connection spring values
Mame : I:I Section : | Select Section= Quick Selection : FixFix
Level : I:l Ax: | | Ix: | | Start End
Ay | | Iy: | | Fx Fx
Type - Incidences Az | | Iz: | | Fy Fy
Type: |SPACETRUSS  ~ sy | | By: | | Fe
| | eo | |
| |
| |

I
U

Mz Mz

Physical Member

Inactive o Remove

Material ; | <Select Material> e Sizes : I:I I:I
Groups that Member belongs

E: | |Density| | X I:I X I:I

6 | | cre: | e Ty ]

passn | 2

4

Cancel Apply Help

This modification applies to all selected members.

Step #25. Copy bracing member to the back: Type COPY and when asked to Select
objects/entities: click on the 4 bracing members created in a previous Step and press <ENTER>.

In order to Enter base point: click on the Joint at Point 1 of the following image.
In order to Enter second point: click on the Joint at Point 2 inf the image on the next page.

Press ESC to terminate the COPY command.
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Step #26. View and Save your model: Press the icon G to display the 3D solid view and then

fl': Colors

the icon and OK. The model looks like as shown in the following image:
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Save your model, using a different file name (Save As...).

Make the entire structure visible by clicking at the icon B All Levels ON

A Fram

Click on the icon . to switch back to the wireframe view.

3.8. Create girders
A Higher Level

icon move to

Step #27. Split the beam members at the top level: Clicking on the
level 3. The current level is displayed at the top caption of AutoCAD/BricsCAD:

GTS CAD Modeler | M KN DEG CEN SEC | Level: 3

7

Click on the icon =Plit

then press <ENTER>.

and click on the members A and B as shown at the following image, and

In order to define the Distance for spliting the member or the number of parts (negative
number), enter -8, so that the beams A and B will be split into 8 equal parts.

7

Click again on the icon 5Pl and click on the members C and D as shown at the following
image, and then press <ENTER>.
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In order to define the Distance for spliting the member or the number of parts (negative
number), enter -4, so that the beams C and D will be split into 4 equal parts.

Y

Step #28. Place girder members at the top level: Click on the icon Generate and Place Member

form appears.

Cross Section

Table Section:
IPE120 IPE European W

or Member Dimensions:

<Select Shape = W

or Same as Member:

<Select Existing Member W

Material

Steel W

Releases Beta (o)

Fix-Fix W 20 W
Split Intersecting Members [IPhysical Member

[] 5plit Ending Members

Flace Member(s) ==

Select IPE120 as the cross section and make
sure that Material is set to Steel, Releases to
Fix-Fix and Beta angle is 90.

Press the “Place Member >>" button.

Click on the joint located at the point 1 of the
following image. Click on the joint at point 2
and the girder member is generated.

Having the command still active, click on the
joints at points 3 and 4 and another girder
member is generated.

Continue by clicking on joints at points 5 and
6 and another girder member is generated.

Continue by clicking on joints at points 7 and
8 and another girder member is generated.
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Continue by clicking on joints at points 9 and 10 and another girder member is generated.
Continue by clicking on joints at points 11 and 12 and another girder member is generated.
Continue by clicking on joints at points 13 and 14 and another girder member is generated.

Make sure that the option “Split Intersecting Members” is ON, so that common joints will be
created along the previously created X-direction girders. Click on the joint located at point 15
and then click on joint at point 16 and the girder member is generated. Existing girders are split.

Repeat the procedure:

Click on the joint located at point 17 and then click on the joint at point 18 and the girder
member is generated. Existing girders are split.

Click on the joint located at point 19 and then click on the joint at point 20 and the girder
member is generated. Existing girders are split.

19 245

8

14

Press ESC to terminate the Generate Beam Command.
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Step #29. Add eccentricities to the Girders: Press the icon B to display the 3D solid view and

then the icon G Colors and OK. The model looks like:

Click on the Top Icon on AutoCAD’s View Cube or BricsCAD’s View Chair to switch to the top
view in order to be able to select girder members easily.

. . "% Ch Memb ) . .
Click on the icon ANIEEMEET Jnd when asked to Select objects: click on the 2 Points of

the following image, to select all girder members, and press <ENTER>.
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The Member Properties [Multiple Selection] form is displayed so you may now specify member

eccentricities.

End Sizes OF. Member Eccentricities (Offsets) Note: Some Edit Boxes appear in yellow
End background and green fonts, like
Eccentricities. You can use mixed units in the
yellow edit boxes. To understand this feature

enter 0.25 for the Z Starting Eccentricity and
X: I:I 25cm as the Z Ending Eccentricity.
Z: Z: Press OK.

Sizes :

I

Now the deformable axis of the girder
members has been moved 0.25m up in the Z
direction.

Switch back to the isometric view by clicking on the House icon on AutoCAD’s Cube or
BricsCAD’s Top Front Left at view Chair to see the result. The girder members now sit on the
upper flange of the beam members.
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3.9. Create an opening
Step #30. Delete a joint to create an opening: Select the Joint Located in Point A of the image

above and press the DEL key.

Warning: All structural entities (members, elements, etc) connected to this Joint will also be
deleted? (Yes/No) appears and continue by pressing Y and <ENTER>.

The Joint is deleted together with all members connected to the joint.
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3.10. Create Supports
Step #31. Support the joints at the base of the model:

Make the entire structure visible by clicking at the icon P All Levels CMand press Z and E (Zoom
Extents).

Switch to the FRONT View, by clicking on Front on AutoCAD’s cube or BricsCAD’s chair.

Click on the icon 8. Support and select the window by clicking at points 1 and 2 in the following

image. All the bottom joints are selected and press OK to finish the selection.
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Restraints & Spring values

Quick Selection Fin

Restraint Spring Restraint
Fx [ Jmx

Fy [Imy

Fz [ Mz

3.11. Check the model

Spring

1

The Joint Properties [Multiple Selection] form
appears.

Select Pin using Quick Selection, and Fx, Fy
and Fz are automatically checked.

Press OK.

All the bottom joints are now pinned and
have an orange color instead of green to
indicate that they are supported.

Step #32. Check for duplicate joints: In order to check for joints having the same coordinates,

. . nn Joints Duplicates
click on the icon

at Ribbon Area.

, under the “Check” Drop Button, located in Find/Change/Check

For the Merge Tolerance <0.001000>, just press <ENTER> to accept the default value.

The Merge Joints form appears where you can see the list of joints having the same coordinates.
Make sure that Merge option is checked for all pairs and press OK.
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Merge Jaints

List SEIECt J!'u"
Joint Duplicate Merge
Unselect all
8 25 [v &
16 17 F

1,

Cancel

By entering the same command again, for the 2™ time, you should get the notification that 0
duplicate joints found .

Step #33. Check for floating joints: In order to check for joints not connected to the model, click

.

on the icon «- Joints Floating: , under the “Check” Drop Button, located in Find/Change/Check at
Ribbon Area. If your model was created as described so far, you should get a notification 0
floating joints found.

Note: You can also run all other checks of the same drop list, to check for Interference Joints,
Duplicate Members, Zero Length Members, Duplicate Names and Database Integrity. You should
not get any errors or warnings.

3.12. Define Groups

Step #34. Create Group Names: It is optional to define Groups in your model but it is strongly
recomended to do so since it will be easier to control the display and selection for parts of your
structure.

Click on the icon in the Groups panel and the Group dialog appears.

Groups
D Name | Physical
; - m
2 Beams I_
3 Girders I_ III
4 [

Cancel

Press the Add Group button and enter Columns as Name of the group.
Press the Add Group button and enter Beams as Name of the group.

Press the Add Group button and enter Girders as Name of the group.
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Press the Add Group button and enter Bracing as Name of the group.

Press OK to close the form.

Step #35. Add Columns to their Group.

3 Col Categories
Click on the icon C Colors :
and make 0n|y proﬂ]es Sections Color |1||Iri5ib|E |
HE320B  visible by  |HE3208 161 v
unckecking all others. IPE320 191 [
IPE120 [
BOXE0XS 50 |
Press OK. p—
F -}
Select Group Click on the icon =i *Members the Groups
panel and make sure that the Group Columns
Group . .
is selected as the active group.
Columns W

To verify that the group is applied correctly,
you can double click on a column and in the
Member Properties form, you will be able to
see its Group definition.

Step #36. Add Beams to their Group:

Select everything on the screen in a full
window and press the Enter key.

Groups
Inactive Remaove

Groups that Member belongs

Columns

Click on the icon C Colors Categories
and make only profiles Sections Color |‘u’i5ible
IPE330 visible by unckecking HE3208 161 [
all others. IPE320 197 I_
IPE120 B
60x605 50 [
Press OK.
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Select Group

Group

Beams

Step #37. Add Girders to their Group:

Click on the icon C Colors
and make only profiles
IPE120 visible by
unckecking all others.

Press OK.

Select Group

Group

Girders

==
Click on the icon =l and make

sure that the Group Beams is selected as the
active group.

Select everything on the screen in a full
window and press the Enter key.

Categories
Sections Color Visible
HE3208 161 [
IPE320 191 [~
IPE120 v
60605 50 [~
-
Click on the icon v +Members and make
sure that the Group Girders is selected as
the active group.
L

Step #38. Add Bracing to their Group:

Click on the icon © Colors
and make only profiles
60x60x5 to be visible by
unckecking all others.

Press OK.

Select everything on the screen in a full
window and press the Enter key.

Categories
Sections Color Vizible
HE320B 161 [
IPE230 191 [~
IPE120 H
60x60x5 50 [v
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e =
Select Group Click on the icon =i “MEMBES 14 make
sure that the Group Bracing is selected as the

Group .
active group.

Bracing W

Select everything on the screen in a full
window and press the Enter key.

3.13. Define Loads

Step #39. Define Self Weight: Click on the icon == >€fWeight 54 the Self Weight dialog
appears. Enter:

- SWas Name

- Self Weight as the Load Description

- Negative Z as the Global Axis for the direction of the load
- 1.0 as Factor

- Check Include finite elements

and press Create New to create the new loading and then OK to close the dialog.

Self Weight or Dead Loads

Load Information

MName : = A
P
Descriplion - Self Weight
Create Mew Save [ Modify Delete

Loads applied parallel to this Global Axis

() Negative ¥ () Positive ¥
(®) Negative Z () Positive Z
() Negative X () Positive X
Factar : L Indude Finite Elements
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:'E] Load Cases

Step #40. Define Load Cases: Click on the icon and the Load dialog appears.

Enter:

- LLas Name
- Live Load as the Load Description
- L as Design variable

and press Create New.

Load Case

Load Case Information

Load ID (up to 8 chars) : L

| Live Load | Save [ Modify

Description @

Enter:

- PLas Name
- Point Load as the Load Description

and press Create New.

Load Case

Load Case Information

Load ID (up to 8 chars) : Design variable : b i Create New

Description : | Point Load Save [ Madify
Load D List; Delete

Press Exit to close the dialog.
Step #41. Apply Live Loads: Live Loads will be applied only to Beam Members, therefore click on

. 2 Col . . .
the icon C Colors . Select the 2" Tab in order to colorize members by their group and make

only the Group Beams visible and press OK.
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Sections | Groups

Categories
Groups Color |‘u’i5i|::||e
Columns 161 [
Beams M v
Girders [
Bracing 50 D
UnGrouped data 7 v

Click on the icon

«t+ Member Using a full window, select all entities that appear on screen and

press <ENTER> to finish with the selection.

The Member Properties [Multiple Selection] form appears having the tab “Member Loads”
active.

Click on LL at the “Empty Load Cases” list box and then enter

Uniform as the Load Distribution
Force as Load Type

Z Global as Direction

-5asV1

Fractional as Location

0.0asll

1.0asL2

Press Create New and the number 125 appears next to the $ symbol the Empty Load Cases list
box. This is a notification that 125 members are loaded in Load Case LL.
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Member Properties [Multiple Selection] X

Model Section Properties Member Loads  Member Temperature Loads Member Distrortions

Applied Load Cases Loading
Description | Live Load | Save [ Modify
Loads in this Load Case : a7 Delete
Load Distribution
() Concentrated Memh?' Start
W
@ Uniform :
O Linear — L1
h L2
Empty Load Cases O Triangular
LL % Live Load $[0
PL £ Point Load $[0
(o] Load Type and Direction Loading Magnitude Loading Location from Start
®Force 8SQ Ood Wi (®) Fractional L1:
f
(O Moment ®z @ clbal VI () Absolute 12:
oK Cancel Apply Help

Press OK to close the dialog. Member Loads appear in red arrows. To clear the arrows select

& Clear from the GTS Display Ribbon Tab.

By double clicking on one beam and then selecting the Member Loads tab and clicking on LL at
the Applied Load Cases List Box, you will be able to view and edit the existing loading values of
the specific beam.

. . 5 Col . . . .
Click on the icon G e , select the 1°* Tab in order to colorize members by their section and
then select everything to be visible and press OK.

Sections Groups

Categories
Sections Color |Uisi|::||e
HE3208 161 v
IPE330 191 v
IPE120 v
B0xB0S 50 v

F
Step #42. View Live Loads: Click at the icon A, Frame to switch to the wireframe view.
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On the Menu Bar, click on GTS Display>Display>Member Loads and the Display Loads form
appears:

Display Loads n Select LL as the Load case and leave the other

display options at their default values.

Load Case
| LL $Live Load v|

Press Show and the loading arrows are
Display Loads Applied To displayed.

[ ] 3oints Members [ ]Elements

Display Options Click on Clear when you are done and Close
to exit from the dialog.

Scale Factor Concentrated (pts)
Scale Factor Distributed (pts) :

Arrowhead Size (pts) : !

1

Lad L
] [ ] =] =]

Font Size (pts) :

Clear Close
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Click at the icon B to display the 3D solid view.

Step #43. Apply Joint Load: A Joint load will be applied to the Joint located at Point A of the
following image.
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Zoom closer to the specific point using AutoCAD’s/BricsCAD’s zooming functions.

Click on the icon g Joint

, click on the joint at A and press <ENTER> to finish with the selection.
The Joint Properties form appears having the tab “Joint Generalized Loads” active.

Click on PL in the “Empty Load Cases” list box and then enter -3 for Force Z as shown in the Joint
Properties form on the next page.

Press Create New, and the number 1 appears next to the $ symbol in the Load Cases list box.
This is a notification that 1 joint is loaded under the Load Case PL.
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Joint Properties

Maodel  Joint Generalized Loads

Applied Load Cases Loading
Load Case : Create New
Description : | Point Load Save [ Modify

Loads in this Load Case : b Delete

Applied Load Values
Force X : I:I Force ¥ : I:I Force 2
vomentx: || wementr: || wemezi| ]
Applied Displacement Values

Empty Load Cases
wanx: || menvs | ] meez: [ ]
potx: | | orevs | ] etz [ ]

LL ELive Load iﬁ

Cancel Apply Help

F
Step #44. View Joint Load: Click at the icon g to switch to wireframe view.

On the Menu Bar, click on GTS Display>Jont Loads and the Display Loads form appears:
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Display Loads Select PL as the Load case and leave the
other display options at their default values.

Load Case
PL W

Press Show and the loading arrows are
Display Loads Applied To displayed.

Joints [ | Members [ |Elements

Display Options Click on Clear when you are done and Close
to exit from the dialog.
30
Scale Factor Concentrated (pts)
Scale Factor Distributed (pts) : 0
Arrowhead Size (pts) : 10
Font Size (pts) : 10
Show Clear Close

Click at the icon I to display the 3D solid view.

Step #45. Define Area Load for Level 1: An area load equal to 1.0kN/m? along the vertical
direction will be applied to whole level. Switch to Level 1 by clicking on the icon W Lower Level

untill “Level 1” is displayed.

W area Load |

Click on the icon in the Loads panel of the ribbon.
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Area Load H Type:

Generate - AL1 as Name
Mame : ALL v - Area Load Level 1 as Description
Description : | o0 o2 Level 1 | - 1.0 asLoad Value
Create New | | Save [ Modify | | Delete | - Z as Global Direction
- 4.0 as Elevation (the elevation of
Load - Direction level 1)
Load Value : - Two way as Distribution
Global Direction Perpendicular to the Loading Plane :
% Oy (CF
0.0508 Press Display >> and the loaded areas that
Flane Tolerance : . . .
were automaticaly detected are displayed in
Elevation yellow solid hatch, as shown below.

Flane Perpendicular at :

(®) Value (coordinate)

() Joint

Distribution
(®) Two way X

D One way Y

Custom x 0:0000 . 0.0000

Press Clear to remove the solid hatch pattern and then OK to store the area load AL1.
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Step #46. Define Area Load for Level 3: An area load equal to 1.0kN/m? along the vertical
direction will be applied only to the two middle openings. Switch to Level 3 by clicking on the
A Higher Level

icon untill “Level 3" is displayed.
) ) Area Load .
Click on the icon L in the Loads panel of the ribbon.
Area Load [ x | Type:
Generate - AL3 as Name
Name : AL3 M - Area Load Level 3 as Description
Desgipﬁgn E Area Load Level 3 = 1.0 as Load Value
Create New Save [Modify Delete - Z as Global Direction
- 10.0 as Elevation (the elevation of
Load - Direction level 3)
Load Value : 1.0000 - Two way as Distribution
Global Direction Perpendicular to the Loading Plane : Press “Define Outline Region >>" and you are
Ox Oy ®z prompted to select the members that define
Plane Tolerance : | 0"0508 the outline region of the area load. Click on

the 6 members at the perimeter of the two
Elevation . . .
middle openings, as shown at the image

Flane Perpendicular at :
P below.

(®) Value (coordinate) 10.0000
() Joint
Distribution

(®) Two way X

() One way ¥

Custom ¥

Advanced Features

Define Outline Region == Reset

Exclude Area = Reset

Ignore Members == Reset

Display >>= Clear oK Cancel
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Press Display >> and the loaded area will be displayed in yellow solid hatch, as shown below.

Press Clear to remove the solid hatch pattern and then OK to store the area load AL3.
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¥ Combinations

Step #47. Define Load Combinations: Click on the icon and the

Combination dialog appears. Enter:

- (CB1asName

- Load Combination 1 for the Description of the Load Combination
- Click on SW, Enter 1.35 as the factor and press ADD>>

- Click on LL, Enter 1.5 as the factor and press ADD>>

- Click on PL, Enter 1.5 as the factor and press ADD>>

- Press Store

- Press Done to close the dialog.

Load

MNew Form Load or Load Combination

Load Information Type

Mame I:l Design variable :

Description | | (") Form Load

(®) Load Combination

Combine

SW (Self Weight)

LL (Live Load)

PL (Point Load)

AL1 (Area Load Level 1)
AL3 (Area Load Level 3) ADD ==
CB1 (Load Combination 1) 'Sw" 1.35000 LL' 1.50000 'PL' 1.50000

Factor : Item

All Formed Loads or Combinations

Delete

CB1 (Load Combination 1) '5W" 1,35000 'LL' 1.50000 'PL' 1. 50000

Edit Delete

Dane
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3.14. GTSTRUDL Input File
Step #48. Create GTI: Save your model as “Tutorial_Example_1.dwg” and click on the icon ﬁ

and the Create GT STRUDL Input file dialog appears. Keep the default GTI filename, check all
options except “Read Finite Element Results” as shown in the following image and press OK.

Create GT.STRUDL Input File

Export to GTI

Create GTI File - iocumentationWersion20 19YExample 0 1§y =06 ) = | |

{®) Export Whale Model (") Export Portion of the Mode|

(will be prompted for Selection)
Perform Stiffness Analysis

Append Other GTI FilesMacros

3
Up
Daown

[ ] copy Commands from GTI Files/Macros (not CINPLUT)

Create Commands to Read Results
Read Joint Displacements
Read Member Forces
Read Section Forces Mumber of Sections: 10
Read Section Displacements Humber of Sections: 10

[ |read Finite Element Results

Read Code Check Results

carcl

Step #49. View/Edit GTI: Click on the icon — 2t 6T

step will be opened by the system’s default text editor.

and the GTI file created in the previous
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Step #50. Execute GT STRUDL: Click on the icon - and the GTI file created in the previous
step will be sent to GT STRUDL main program that is waiting in the background.

Stiffness analysis is automaticaly performed and DBX result files are automaticaly created.

In order to demonstrate the use of the command that reads back design results, add the
following commands into GT STRUDL main window (note that the steel design Parameters are
incomplete)

PARAMETERS

CODE EC3 ALL MEMBERS

CHECK ALL MEMBERS AS BEAM

DBX BINARY "Tutorial Example 1.25" REPLACE

WRITE REPLACE CODE “Tutorial_Example_1.25" MEMBERS EXISTING

The result of the CHECK ALL MEMBERS command shown above is that members 148 149
150 151 152 153 154 155 FAILED CODE CHECKS

In addition, you can enter GTMenu to view the model and the results as described in the
GTMenu User Guide. After selecting the View button and checking Z-Up, and then selecting
View 1, the structure is displayed in GTMenu as shown below.
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7 Gliew.  GTView x

(\

XN

A\

Step #51. Read Results from GT STRUDL: In CAD Modeler, click on the icon and

the Read GT.STRUDL Results dialog appears. Check all options except “Read Finite Element
Results” as shown below and press OK.

%9 Read Results
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Read GT.5TRUDL Results >

Read DEX Results

GTI Directory : D\ Examples\GTSTRUDL Exampled 1

Read Joint Displacements

Read Member Forces
Fead Section Forces Mumber of Sections:
Read Section Displacements Mumber of Sections:
[ ]Read Finite Element Results

Type of element result : <ALL=

Surface : <ALL=

Fead Code Chedk Results

GTI Commands

Correspanding GT STRUDL commands:

DBX BIMARY

WRITE REPLACE JOINT RESULTS JOINTS EXISTIMG

WRITE REPLACE MEMEBER. RESULTS MEMBERS EXISTING

WRITE REPLACE SECTION FORCES NS 10 AUTOMATIC MEMBERS EXISTING
WRITE REPLACE SECTION DISPLACEMENTS GLOBAL NS 10 MEMBERS EXISTIMG
WRITE REPLACE CODE MEMBERS EXISTIMG

Cancel

Note: You should get an information message “Results Loaded Successfully”

3.15. Display Results

tep . Display Deformed Model: on the Menu Bar, click on ] ribbon tab “
Step #52. Display Deformed Model he Menu Bar, click on | Deformed  ibbon tab “GTS

Display”) and then select SW as load Case and press ENTER twice. The deformed structure will
be drawn as shown below.
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Repeat and select PL as the Load Case and the deformed structure appears as shown in the

following image:
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N Annotate Di splacements |

Note: You can Annotate the Joint displacements by clicking on the © icon,
If Deformed

that is located under the in the ribbon and the selecting a joint and annotation

possition.

|: Undeformed

Click on (ribbon tab “GTS Display”) to return to the original undeformed position

of the model.

F
Step #53. Display Section Displacements: Click on the icon R to switch back to the
wireframe view. Click on F ¥ Displacements (ribbon tab “GTS Display”).

Select:
- SWas Load Case
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Displacements - 0.1 as Scale Factor
- 10.00 as Font Size (default)

Load Case [ Load Combination - Annotation Format: Exponential

SW § Self Weight v - Check Hide Model
Press “Display >>" and zoom at the upper left

Display Options end of the structure as shown in the image

0.100 below.

Scale Factor (Values) : '

" >Il H

Font Size (pt) : 10.00 Press “Annotate and click on any part of
the deformed shape curve and then at the

Annotation Format: | Exponential v position that you want the annotation to be

Decimal Flaces : 2 ~ displayed.

[¥/] Hide Model Press on “Legend >” and click at any part of
the screen to place the legend of the
diagram.

Display ==
Annotate = Legend =

Animation Options

Frames : 7

Animation Speed % 1 ~

Generate Animation P
Frames S
Clear Close

139



X:—2.92e-07
T:—5.66e—-07

Displacements M Z:=1.11e—04
Load @ SW @:2.67e+00

Self Weight

<
>

2.46e—08
5.73e—08
—2.08e—03
1.67e—=01

e
e
2
@

”

In order to display the animation press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

In order to exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.

wr Diagrams

Step #54. Display Member Diagrams: Click on (ribbon tab “GTS Display”).
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Member Diagrams Select:
- SWas Load Case

Load Case / Load Combination - MZ Moment as Value to be displayed
SW & Self Weight v - 0.1 asScale Factor
- 10.00 as Font Size (default)
[ |Envelope
Press “Display >>" and zoom at the upper left
Values end of the structure as shown in the image
MZ Moment W below.

Press “Annotate >” and click on any part of

Display Options the yellow MZ Moment curve and then at the

Scale Factor (Values) 0.100 position that you want the annotation to be
displayed.

Font Size (pt) 10.00

Annotation Format: | Decimal i Press on “Legend >” and click at any part of
the screen to place the legend of the

Decmal Flaces : 2 ~ diagram.

[ |Label Max &Min [ _|Positive Sign

Display ==
Annotate = Legend =

Clear Close
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MZ:—0.58 . Moment 7 KN/M
@:3.00
@:0.77 Load @ SW
Self Weight
MZ:—1.24
@:0.00

In order to exit the command, press the “Clear” Button and then the “Close” button.

v
Step #55. Display Code Check Results: Click on & Code Check (ribbon tab “GTS Display”) and

select all mebers by typing ALL and pressing <Enter> twice.
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Code Check Results Select:
- Display Text: Actual/Allowable Stress

Display Text Ratios
- All Values
I Mone i
i - 4 as Font Size
i®) Actual/allowable Stress Ratios
Press “Display >>" and the following image is
drawn with the bracing members that failed

the check (149 to 155) appearing in red and

() Controlling Stress Code Provision

(") Actual/allowable KLjr Ratios

(") Controling KL/r Code Provision members that passed the check appearing in
blue.
Values In order to exit the command, click the
(@ Al “Clear” Button and “Close”.
() Greater Than 0.00
{(JLess Than 0.00

Display Options

Font Size (pt)

Display ==

Legend >

Clear Close
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3.16. Results Datasheets
Step #56. Except from the graphical display of results there is an option to view them in
datasheets from the item “Results Datasheets” of the menu/ribbon tab “GTS Display”.

Click on the icon B Displacements

and the “GTSTRUDL — Joint Displacement Datasheet” dialog
appears where you can filter, sort, write results to text file or change results units as shown in

figure below.
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B ' GTSTRUDL - Joint Displacement Datasheet, display Units: Meters Degrees O x
File Edit Columns FEilter 5ort Units Help

Joint Load I Trans X | Trans ¥ ITrans 2 I Rotation X I Rotation ¥ | L]
1 SW 0.0aaa 0.0aaa 0.0000 —-0.000215% 0.0000245
2 SW O.0aa0a 0.0aaoa —0.0000 0.0004223 0.0000347
3 SW 0.0000 0.0000 0.0000 -0.0002020 0.0001%08
4 SW 0.0aaa 0.0aaa —0.00a0 0.0004311 —-0.0003151
5 SW O.0aa0a 0.0aaoa 00000 —-0.0001381 —-0.000150%
€ SW 0.0000 0.0000 —0.0000 0.0004323 0.0003413
7 SW 0.0aaa 0.0aaa 0.0000 —-0.0003753 —0.0003€70
=) SW O.0aa0a —0.a0aa —0.0000 0.0009405 0.0007478
] SW 0.0000 0.0000 0.0000 0.0001757 -0.0000570

1a SW —0.00a0 0.0aaa —0.00a0 —0.000444¢ —0.00004€€
11 SW O.0aa0a 0.0aaoa 00000 0.0001593¢ 0.0001102
1z SW =-0.0000 -0.0000 -0.0000 -0.0004358 -0.000400€
13 SW 0.0aaa 0.0aaa 0.0000 0.0001575 —-0.0002277
14 SW —0.00aa —0.a0aa —0.0000 —0.000433% 0.000z€08
15 SW 0.0000 0.0000 0.0000 0.0004€ls -0.0004304
1€ SW —0.00a0 —0.aaao —0.00a0 —-0.00085937 0.000&8344
13 SW —0.00aa —0.a0aa —0.0005 —-0.5755841 —-0.181€357
13 SW =-0.0000 -0.0000 -0.004€ -0.3254073 0.08358498
za SW —0.00a0 —0.aaao —-0.00585 —-0.05€5121 0.551&€254
z1 SW —0.00aa —0.a0aa —-0.0117 —0.0000572 0.78200€5
22 SW =-0.0000 -0.0000 -0.00385 0.0567753 0.5517€z20
z3 SW —0.00a0 —0.aaao —-0.004€ 0.3252377 0.084048¢€
z4 SW —0.00aa —0.a0aa —0.0005 0.5758475 —0.1t1458¢
Ze W 0.000a0 0.0aa0d 00000 -0.00045%27 -0.0005444
z7 SW 0.0aaa 0.0aaa —0.00a0 0.000z2704 0.0004355
ze SW 0. Qoo Q.ooo0 0.0000 —0.0007150 0.0001e20
z5 W 0.000a0 0.0aa0d =0.0000 0.0001€30 -0.0002131
30 SW 0.0aaa 0.0aaa 0.0000 0.0003€13 0000378z L¥]
< >
B Reactions

Click on the icon and the “GTSTRUDL — Reactions Datasheet” dialog appears
where you can filter, sort, write results to text file or change results units as shown in figure

below.

8 GTSTRUDL - Joint Reactions Datasheet, display Units: Meters KiloNewtons O >
File Edit Columns Filter Sert Units Help
Joint Load Force X | Force ¥ Force Z Moment X IHomeﬁ
1 W -0.000
3 W -0.000
B SW -0.000
7 SW 0.000
5 SW 000
11 5W 0.000
13 W -0.000
15 SW 0.000
26 W 0.000
28 SW 000
30 SW -0.000
3z W -0.000
34 SW -0.000
26 W -0.000
1 LL -0.000
k] LL -0.000
5 LL -0.000
7 LL -0.000
k] LL 0.000
11 LL -0.000
13 LL 0.000
15 LL 0.000 &7
£ >
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Click on the icon Results Datasheets > = Code Check and the GT STRUDL Code Check Results”

dialog appears

0 GT STRUDL Code Check Results - o IEl
File Edit Celumns Filter Sort Mot Checked Help
Member | B/F | Load Section Loc | Crit Ratio | Crit Prowv | Stress Ratio | Stress Prov | EL/r Ratio EL/r Prov | Properti s
148 FRIL CBlL 7.211 3.395 EL/r 0.76& 5.5.1 3.385 EL/x &0x60x5
145 FRIL CBl &.403 3.015 EL/r 0.%81 5.5.1 3.015 EL/x &0x60x5
150 FRIL CBl &.403 3.015 EL/r 0.977 5.5.1 3.015 EL/r &0x60x5
151 FRIL CBlL 7.211 3.395 EL/r 0.751 5.5.1 3.385 EL/x &0x60x5
152 FRIL CBlL 7.211 3.395 EL/r 0.7e8 5.5.1 3.385 EL/x &0x60x5
153 FRIL CBl &.403 3.015 EL/r 0.952 5.5.1 3.015 EL/x &0x60x5
154 FRIL CBl &.403 3.015 EL/r 0.973 5.5.1 3.015 EL/x &0x60x5
155 FRIL CBlL 7.211 3.395 EL/r 0.755 5.5.1 3.385 EL/x &0x60x5
1 Pass CBl1 4.000 0.z393 EL/r 0.lo0z 5 0.233 EL/x HE3Z0B
2 Pass CBlL 4.000 0.233 0.l02 5. 0.233 EL/r HE3Z20B
3 Pass CBl1 4.000 0.z393 0.lo0z 5 7 0.233 EL/x HE3Z0B
4 Pass CBl1 4.000 0.z393 0.134 5 4(2) 0.233 EL/x HE3Z0B
5 Pass CBl1 4.000 0.z393 0.lo0z 5 0.233 EL/x HE3Z0B
& Pass CBl1 4.000 0.z393 0.lo0z 0.233 EL/x HE3Z0B
7 Paas CBl1 4.000 0.z393 0.lo0z 0.233 EL/x HE3Z0B
8 Pass CBl1 4.000 0.z393 0.134 0.233 EL/x HE3Z0B
9 Pass CBl1 0.000 0.93%9 0.331 0.333 EL/x IPE330
10 Pass CBl1 0.000 0.782 0.z43 0.782 EL/x IPE330
11 Pass CBlL &.000 0.93%9 0.43% 0.333 EL/x IPE330
12 Pass CBl1 0.000 0.93%9 0.351 0.333 EL/x IPE330
13 Pass CBl1 0.000 0.782 0.z43 0.782 EL/x IPE330
14 Pass CBlL &.000 0.93%9 0.43% 0.333 EL/x IPE330
15 Pass CBl1 0.000 0.782 0.205 0.782 EL/x IPE330
1§ Pass CBl1 0.000 0.782 0.205 0.782 EL/x IPE330
17 Pass CBl1 5.000 0.Z205 0.205 0.000 it IPE330
18 Pass CBl1 5.000 0.lag 0.lee 0.000 it IPE330
13 Pass CBl1 0.000 0.z4%9 0.z4%9 0.000 it IPE330
20 Pass CBlL 0.871 0.1z7 0.1z27 0.000 it IPE330
21 Pass CBlL 0.871 0.1z7 0.1z27 0.000 it IPE330
22 Pass CBlL 0.871 0.1z7 0.1z27 0.000 it IPE330
23 Pass CBlL 0.871 0.1z7 0.1z27 0.000 it IPE330
24 Pass CBlL 0.871 0.127 0.127 0.000 il IPE230
25 Pass CBlL 0.871 0.1z7 0.1z27 0.000 it IPE330
26 DPass CBlL 0.871 0.z4%9 5.5.3 0.z4%9 0.000 it IPE330
27 Pass CBl1 4.000 0.z393 EL/r 0.lo0z 0.233 EL/x HE3Z0B
28 Pass CBl1 4.000 0.z393 EL/r 0.lo0z 0.233 EL/x HE3Z0B
23 Pass CBl1 4.000 0.z393 EL/r 0.135 0.233 EL/x HE3Z0B
30 Pass CBl1 4.000 0.z393 EL/r 0.lo0z 0.233 EL/x HE3Z0B
31 Pass CBL 4.000 0.233 EL/r 0.l02 0.233 EL/r HE3Z20B ¥
L4 >

3.17. Report Builder

Report
Step #57. Click on the icon Builder to generate the report of this structure by calling Report

Builder. Report Builder is launched in a separate window. You can find more information on how
creating your report in the GT STRUDL® Report Builder Getting Started Guide (Help Icon on the
right top corner on Report Builders’ window).

146



Load Data

Summary of Loadings

Lengeh M Force: KN, Angle: DEG, Tempevature: DEGC , Time: SEC




4.  Tutorial Example #2

4.1. Introduction
The modeling and analysis of the tank shown below is demonstrated in a step-by-step process

using CAD Modeler and GT STRUDL finite element analysis.
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4.2. Open CAD Modeler and start working

Step #1. Launch GT STRUDL by selecting the icon “CAD Modeler” in the Welcome to GT STRUDL
dialog shown below. The version of AutoCAD/BricsCAD selected during the installation will be
automatically launched, together with CAD Modeler’s menus and ribbon bar.

Welcome to GT STRUDL -=0Ox
B Cpen Learn mere about GT STRUDL ) Hide Details o - =] (7] -
@ GT Menu Base Plate Wizard ( ol
Parharm sucean . Analyzs & design com ¥ g CADWor:®
- i e | W HEXAGON QaDwand|
= Optio P Teearats st retural analyet 1sing b Bt akarnant ansk PPM
and swsgn spzerach
What is GT STRUDL?
..... Introduction to GT STRUDL €&
View an informative webinar on the new licensing
syslem presented on January 28, 2020 by cheking
Ctart a Mew Project é
here.
is: GT
Alirmited satesaan af the product thit can be wsed s an
— Hq ﬁh L] X mtroduction to the mast fraquently used features
ﬁﬁ Webinars
<fy —
4| / Q= .,I.,
GF Menu CAD Modeler Commari Mode Motlel Wizard Eate Plate Wizsrd
CAD-Dased Modaling for Struciural Cnginsges:
Working Directory February 20, 2020°
Medem Lean Projact Cracution: Deyvond
\ " " " 2sign 19 Engmeering — Uniting
DAGTOAN Testing\ 2020-04-27_UTC-U3-22-5TVGTS 2020 Shell MOU6Y_gti o Siructurad and Piging Recorded Date: Auguss 13
oL
Racas
i On-Demand Webinar. GT STRUDL Wabinar;
Model Your Way wi STR
Date: December 13. 2015
On-Demand Webinar GT STRUDL Webinar: Lean
g arkfigw with Infergraph Smart I0
Diate; Dciober 18, 2018 i
< b

4.3.  Define the basic geometry of the model

Step #2. Define the correct Units by pressing the icon & Units and select Meters (m) and
KiloNewtons in the Units Form.

Units >
Length Force Angles
() Inches (in) () Poundz (Ibs) (®) Degrees

(i Feet (ft) i Kips () Radians

(®) Meters (m}; (O Tons () Cydes

() Centimeters {cm) () Kilograms

(i millimeters (mm) () Metric Tons Time
Temperature () Newtons (®) Seconds
() Fahrenheit (®) KiloMewtons () Minutes
@ Centigrade O MegaMewtons CI Haurs

Scale non-structural CAD entities

(grids, structural lines, curves etc) Cancel
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Step #3. Create an AutoCAD/BricsCAD Polyline that will describe the outline of the tank. Type
the following commands at the command prompt (each command is followed by an <ENTER>):

PLINE
0,0,0
@10,0
ARC
04,4
0-4,4
LINE
@-10,0
CLOSE

The polyline shown in the picture below is created after entering Zoom and Extents at the
command prompt.

Step #4. Create a Line along the height of the tank: Switch to the isometric view of the structure
by pressing the small house icon in AutoCAD’s Cube or BricsCAD’s Chair.
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; Type the following commands at the command prompt
(each command is followed by an <ENTER>):

W (B LINE
f.'“i 0,0,0
0,04
WCS <ENTER>
i ’ - The line shown at the picture below is created.
3 ' 4
6 | ﬂ ¥ Click on the TOP icon of the AutoCAD’s Cube / BricsCAD’s
“ Chair in order to switch back to floor plan view.
Top Front Left

4.4,  Create the bottom of the tank
Step #5. Generate the Finite Elements inside the polyline, at the bottom of the Tank: Click on

20 Area
the icon ﬁ , under the “2D” Drop Button, located in Meshing at Ribbon Area, and
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when the prompt message Poly Select Boundary Polyline or Circle appears, click on the Polyline

that you have created in the previous step.

Generate

Material | Concrete

Element Attributes

Type |SBHTG " | Thickness

E <

Mesh Geometry

External Boundary ohj-5381

External Boundary Edge Size | 0-000000

Maximum Element Edge Size 0.50

Minimum Element Edge Size 0.000000

< III

Mesh Quality | High

Internal Boundaries Internal Joints

Add +| Remove -

Multi+ | Multi - Add | Remowve
Spacing Extrude Direction
LIniform 4
Variable I:I
Defined by Curve, Size: 3.242418
|:| Sweep Function
Labeling
Mare >>=
Preview Clear Create Close

The Select Mesh Properties form appears
where you have to enter:

- Material : Concrete

- Type: SBHT6, meaning triangular
elements having 6 degrees of
freedom per node

- Thickness: 0.20

- Boundary Maximum Element Edge
Size: 0.50

- Mesh Quality: High

You can press the Preview button to see the
finite elements as they will be generated.

Press the Create button to create the finite
elements and joints on the bottom of the
tank.
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Step #6. Turn OFF labeling and view mesh:

Visible Labels Click on the icon & Options in the ribbon bar and
[ Joints then uncheck the Visible Labels option for Joints,
Members and 2D Elements.
[ |Members
Now labeling is turned off and it is easier and faster to
[ ] 2D Elements control the model.
3D Elements

The finite element mesh, without labeling, is shown in the image below.

Y

f'/J‘

4.5. Create the walls of the tank
Step #7. Generate the finite elements that will model the Wall of the Tank by extruding the

. . . . . _—t 30 BExtrude
polyline: Switch to Isometric view and click on the icon ‘e , under the “2D” Drop

Button, located in Meshing at Ribbon Area (Note: the display of joints and elements previously
created is automatically turned off to make selection of the polyline and extrude line easier).
When the prompt message Select Line, Arc, Circle or PolyLine to be Extruded appears, click on
the Polyline that you have created in a previous step, as shown in the following picture (Click
#1).
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LA +
o ____.-...__.:_ .-.—-_t o !

¥ '
-...__ 39 te # "
oy Theateat we § + v

on Curve (Line or Arc)appears, click on the line

that you have created in a previous step, as shown in the picture below (Click #2).

When the prompt message Select Extrude Directi
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Generate

Material | Concrete

Element Attributes

E <

Type |SBHOG * | Thickness

Mesh Geometry

External Boundary ohj-5381

0.000000

External Boundary Edge Size

Maximum Element Edge Size 0.50

0.000000

Minimum Element Edge Size

Mesh Quality Very Low

Internal Boundaries Internal Joints

Add + Remove -

Multi+ | Multi - Add | Remove
Spacing Extrude Direction

() variable I:I

Defined by Curve, Size: 3.242418
|:| Sweep Function
Labeling
Mare >>=

Preview Clear Create Close

The Select Mesh Properties form appears
where you have to enter:

Material : Concrete

Type: SBHQ6, meaning quad
elements having 6 degrees of
freedom per node

Thickness: 0.2

Maximum Element Edge Size: 0.5
(Note: This must be the same as
when the mesh in the bottom of the
tank was created so the mesh will be
the same along the polyline)

Spacing Extrude Direction: Uniform
and select 8 spaces in the pulldown

You can press the Preview button to see the

finite elements as they will be generated.

Press the Create button to generate the
finite elements and joints on the wall of the

tank

The finite element mesh is presented in the
following image.
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Step #8. Check for duplicate joints: Since both meshing functions described above generated
joints along the polyline, pairs of joints having the same coordinates exist in the model and they
have to be merged together. In order to check for joints having the same coordinates, click on

Dn Joints Duplicates

the icon , under the “Check” Drop Button, located in Find/Change/Check at

Ribbon Area.
For the Merge Tolerance <0.001000>, just press <ENTER> to accept the default value.

The Duplicate Joints form appears where you can see the list of joints having the same
coordinates. Make sure that Merge option is checked for all joint pairs and press OK.
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Merge Joints

List Select Al
loint Duplicate Merge &
1 281 |7 Unselect Al
1 363 v
: = v
3 203 v
4 284 |7 Cancel
5 285 v
6 286 v
7 287 v
8 288 [v
9 289 [v
10 290 [v
1 201 v
12 292 v
13 293 v
14 204 v
15 295 v
16 29 v
17 297 v
18 208 v
19 299 v
20 200 v
21 301 v
2 302 v
23 303 [v
24 304 [v
25 305 v
2% 206 v y
[ mnl

By entering the same command again for the 2" time, you should get the notification that 0
duplicate joints found .

Step #9. Switch to 3D View: Press the house icon (AutoCAD cube) or Top Front Left (BricsCAD
chair) to change the view to Isometric, and type Z and E (Zoom, Extents). Click on the icon

@ Options to set a different color for 2D finite elements. When the Display Options form
appears, click on the white button next to “2D Element”, to define a different color. Using this
form you can also define Object Sizes in the current length units.

157



- Select Color Select Color ?

Index Color Index Color
AutoCAD Color Index (ACI):

B EEEEEET | oo | o
....D 1 . . . . . 254 = ByBlock
. BylLayer
o AN
Tzl Help Index 254

RGB: (214,214,214)
OK Cancel

Select Color (AutoCAD) Select Color (BricsCAD)

Press OK to close the Color Options Dialog. The elements will now have the color that you

selected.

Press the icon 0 (and then type Shade) to display the 3D solid view of the model, replacing

the wireframe view:
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Display Options

L,

Visible Objects Visible Labels
Joints - (] Jints
Members | [ Members
2D Elements - [ ] 2D Elements
3D Elements | 3D Elements
Label Settings - Font Sizes Object Sizes
ey 0.250000 Joint - 0.050000
Members : 0.250000 Load Arrowhead (pts): 10.00000
2D Elements : 0.250000
30 Hemerts » 0, 250000 Display Members [ Elements
Annotation (pts) : 10.000000 Shrink Factor : | 1.0 v
Annotation Format: | Dedmal W []De Net Display Thickness in 3D
Dedmal Places : 2 W Members As: Analytical w
Scale Factors
72.000000

Concentrated Load (pts) :

Distributed Load (pts) : | 72-000000
Cancel
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A, Frame

and AutoCAD’s/BricsCAD’s commands faster.

Press the icon to switch back to wireframe view to be able to process CAD Modeler’s

Step #10. Save your Model: In order to save your model, use AutoCAD’s/BricsCAD’s save
command and store the DWG using any filename that you want.

4.6. Create Supports
Step #11. Support the joints at the base of the model:

Switch to the FRONT View, by clicking on Front on AutoCAD’s cube or BricsCAD’s chair.

Click on the icon & 2UPPO™ 414 select the window by clicking at points 1 and 2 in the following

image. All the bottom joints are selected and press ENTER to finish the selection.
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RS S A A S O O S R e A e e O A U 1
""""""""""""""""""""""""""""""""""""""""""""""""""""""""""""""" Ay |
Restraints & Spring values The Joint Properties [Multiple Selection] form

. appears.
Quick Selection Fin W
Restraint Spring Restraint  Spring
Using the Quick Selection, select Pin and note
Fx [ Imx & Q .
that Fx, Fy and Fz are automatically checked.
Fy CImy
Fz |:| Mz

Press OK.

Press the Isometric (Top Front Left) icon to
change the view to Isometric, and type Z and
E (Zoom, Extents).

All the bottom joints are now pinned and have an orange color instead of green to indicate that
they are supported.
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4.7. Check the model
Step #12. Check for duplicate joints: In order to check for joints having the same coordinates,

Dn Joints Duplicates

click on the icon , under the “Check” Drop Button, located in Find/Change/Check

at Ribbon Area.

For the Merge Tolerance <0.001000>, just press <ENTER> to accept the default value.

You should get the notification that 0 duplicate joints found .

Step #13. Check for floating joints: In order to check for joints not connected to the model, click

on the icon fﬂ» Joints Flosting: , under the “Check” Drop Button, located in Find/Change/Check at
Ribbon Area. If your model was created as described so far, you should get a notification that 0
floating joints found.

Note: You can also run all other checks of the same drop list, to check for Interference Joints,
Duplicate Shells, Duplicate Names and Database Integrity. You should not get any errors or
warnings.

Step #14. View Planar Axes for Finite Elements: In order to check the direction of the planar axes

'+f Shell Planar Axes
of the Finite elements, click on the icon ° in the “GTS Display” Ribbon area
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and then Enter Legend Coordinates(x,y,z): or click at the point where you want the legend to be

displayed.

In the legend, the X axis is displayed in cyan, Y axis in red and Z axis in yellow (AutoCAD) or
orange (BricsCAD). The size of the arrow and its arrowhead is controlled by the value given in

Display Options > Object Sizes > Load Arrowhead and the size of the legend font is controlled by
the value given in Display Options > Label Settings — Font Sizes > Annotation (pts) (shown in

2.6.64).

.—‘IF‘A—‘.A—‘! -.b.‘lb.lhi
e WP VR AR R R e
h‘dl‘l_b‘lb 'y

1"‘"’!!‘&!’?'

h‘ih‘!hﬂ.‘ﬂb.‘ib‘.ﬂ.‘.
X GP LR R YR

AN
" 1}'4}‘4‘”‘

To clear the arrows select & Clear from the GTS Display Ribbon Tab.

Define Groups
Step #15. Create Group Names: It is optional to define Groups in your model but it is strongly

4.8.

recomended to do so since it will be easier to control the display and selection for parts of your

structure.

and the Group dialog

—
—
=
List

In the Groups panel of GTS CAD Modeler ribbon, click on the icon

appears.
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Groups

Group Properties Add Group

1] Mame | Physical
I_ Delete Group

1 Bottom

d1F

Cancel

Press the Add Group button and enter Bottom as Name of the group.
Press the Add Group button and enter Wal I as Name of the group.

Press OK to close the form.

Step #16. Add the elements in the bottom of the tank to the Group Bottom:

Switch to the FRONT View, by clicking on Front on AutoCAD’s cube or BricsCAD’s chair.

s
Select Group B Click on the icon i *Shells 1 4pe Group
Group panel and make sure that the Group Bottom
is selected as the active group.
Bottom v| EI & P

Make a selection by clicking at the points 1
and 2 of the following image and press the
Enter key.

2

All the shell elements located in the bottom of the tank are now selected and added to group
“Bottom”.

Step #17. Add the elements in the tank wall to the Group Wall.

164



Select Group Click on the icon i +Shells and make sure

Group that the Group Wall is selected as the active
roup.
wall W group

Make a selection by clicking at the points 1
and 2 of the following image and press the
Enter key.

All shell elements located in the wall of the = Groups
tank are now selected and added to group
“Wall”.

Inactive --- Remove

Groups that Element belongs

wall

To verify that the group is applied correctly,
you can double click on a element in the wall
and in the Shell Properties form, you will be
able to see its Group definition in the Shell
Properties form.

Press the house icon to change the view to Isometric, and type Z and E (Zoom, Extents).

Click at the icon o to display the 3D solid view as shown in the following image and save your
model.
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49. Define Loads

Step #18. Define Self Weight: Click on the icon L Self Weight gng the Self Weight dialog
appears. Enter:

- SWas Name

- Self Weight as the Load Description

- Negative Z as the Global Axis for the direction of the load
- 1.0 as Factor

- Check Include finite elements

and press OK to create the new loading and close the dialog.
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Self Weight or Dead Loads

Load Information

Mame : W W
o
T p Self Weight
Create Mew save [ Modify Delete

Loads applied parallel to this Global Axis

() Negative ¥ () Positive ¥
(®) Negative Z () Positive Z
() Negative X () Positive X
Focky = 1 Include Finite Elements

cancl

Step #19. Define Load Cases: Click on the icon :-H Load Cases

and the Load dialog appears.
Enter:

- LLas Name
- Live Load as the Load Description
- Las Design Variable

and press Create New.

Load Case >

Load Case Information

Load ID (up to 8 chars) : e

| Live Load | Save | Modify

Description :

Enter:

- PLas Name
- Pressure Load as the Load Description

and press Create New.
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Load Case >

Load Case Information

Load ID (up to & chars) : Design variable : -

Description : | Pressure Load Save | Modify
Load D Lst; Delete

Press Exit to close the dialog.
Step #20. Apply Live Loads: Live Loads will be applied only to the bottom of the tank , therefore
5 Col . . .
click on the icon C Colors . Select the 2" Tab in order to colorize elements by their group and
make only the Group Bottom visible and press OK.
Sections | Groups

Categories

Groups Color |1uri5i|;:lle
Bottom 161 I

Wall 191 |
UnGrouped data |_

Click on the icon L7 Shell in the Loads Panel. Using a full window, select all entities that appear
on screen and press <ENTER> to finish with the selection.

The Element Properties [Multiple Selection] form appears having the tab “Element Loads”
active.

Click on LL at the “Empty Load Cases” list box and then enter:

- Surface as the Force Type

- Zas Direction

- Global as System

- Uniform as Load Distribution
- -40asvl

Press Create New and the number 476 appears next to the $ symbol the Empty Load Cases list
box. This is a notification that 476 elements are loaded in Load Case LL.
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Element Properties [Multiple Selection]

Model | Element Loads

Applied Load Cases Loading
Load Case : L Create New
Description : Live Load Save [ Modify
Loads in this Load Case : v Delete
Force Type Direction System Load Distribution Values (B or 5)
(") Body o Local (@ Uriform oy
) () Planar v
(®) Surface Oy .
) {®) Global () variable Vi
(O Edge @7 (O Projected iy
Empty Load Cases
PL &[0]

Cancel Apply Help

Press OK to close the dialog.

By double clicking on one element and then selecting the Element Loads tab and clicking on LL
at the Applied Load Cases List Box, you will be able to view and edit the existing loading values
of the specific shell.

To clear the arrows select & Clear from the GTS Display Ribbon Tab.
Step #21. Apply Pressure Load: Pressure Load will be applied only to elements in the Group

B Col . .
Wall, therefore click on the icon G “°% Select the 2™ Tab in order to colorize elements by
their group and make only the Group Wall visible and press OK.

Sections | Groups

Categories
Groups Color | Visible |
Bottom 161 [
Wall 191 I .
UnGrouped data [

Click on the icon B Shell in the Loads Panel. Using a full window, select all entities that appear
on screen and press <ENTER> to finish with the selection.
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The Shell Properties [Multiple Selection] form appears having the tab “Element Loads” active.
Click on PL at the “Empty Load Cases” list box and then enter:

- Surface as the Force Type

- Zas Direction

- Local as System

- Uniform as Load Distribution
- 5S5asvl

Press Create New and the number 656 appears next to the $ symbol the Empty Load Cases list
box. This is a notification that 656 elements are loaded in Load Case PL.

Element Properties [Multiple Selection]
Model | Element Loads
Applied Load Cases Loading
Load Case : FL Create New
Description : Pressure Load Save [ Modify
Loads in this Load Case : e Delete
Farce Type Direction System Load Distribution Values (B or 5)
() Body Ox (@) Local (®) Uniform vl 5
B () Planar va
(@) Surface iy
) ) Global () Variable v
(O edge @z () Projected v

Empty Load Cases

LL S[476

Cancel Apply Help
Press OK to close the dialog.

To clear the arrows select & Clear from the GTS Display Ribbon Tab.

fl':- Colors

Click on the icon ™ . Select the 2" Tab and make everything visible.

# Combinations

Step #22. Define a Load Combination: Click on the icon and the Load

Combination dialog appears. Enter:

- (CB1as Name

- Load Combination 1 for the Description of the Load Combination
- Click on SW, Enter 1.3 as the factor and press ADD>>

- Click on LL, Enter 1.5 as the factor and press ADD>>
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- Click on PL, Enter 1.1 as the factor and press ADD>>

- Press Store
- Press Done to close the dialog.

MNew Form Load or Load Combination

Load Information

CBE1

LL iIIE:ive Loadi

Mame Design variable :

Description : | Load Combination 1 |
Combine

SV (Self Weight)

Type

(®) Load Combination

(") Form Load

SW 1,30000
LL 1.50000
PL 1.10000

Delete
Factor : Item
STORE
All Formed Loads or Combinations
Edit Delete
Done

4.10. Create GT STRUDL Input File

Step #23. Create GTI: Click on the icon mand the Create GT STRUDL Input file dialog appears.

Keep the default GTI filename, check the options “Perform Stiffness Analysis”, “Read Joint
Displacements” and “Read Finite Element Results” as shown in the following image and press

OK.
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Create GT.STRUDL Input File

Export to GTI
Create GTI File - JocumentationVersion 2019 Example0 2\ Example0 25tep22.GTI
(@) Export Whole Model (") Export Portion of the Model

{will be prompted for Selection)
Perform Stiffness Analysis

Append Other GTI FilesMacros

+
Up
Down
[ ] copy commands from GTI Fileg/Macros (not CINPUT)
Create Commands to Read Results
Read Joint Displacements
[ |Read Member Forces
[ |Read Section Forces Mumber of Sections: 10
[ |Read Section Displacements Humber of Sechors: 10

Read Finite Element Results

[ |Read Code Chedk Results

Step #24. View/Edit GTI: Click on the icon B Edit GTI

step will be opened by the system’s default text editor.

and the GTI file created in the previous

Step #25. Execute GT STRUDL: Click on the icon .and the GTI file created in the previous
step will be sent to GT STRUDL main program that is waiting in the background.

Stiffness analysis is automaticaly performed and DBX result files are automaticaly created.

In addition, you can enter GTMENU to view the solid model and the results as described in the
GTMENU User Guide. You can also click on Results > Finite Element Results > Contour Sresses,
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Strains, Displacement and display MXX Bending Resultants for load case PL as shown in the
figures on the next page:

7 Grviewt [ Giview [
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7 Grviewt x| GTviewz [T ——

Step #26. Read Results from GT STRUDL: Click on the icon % Read Results and the Read

GT.STRUDL Results dialog appears. Check the options “Read Joint Displacements” and “Read
Finite Element Results” as shown below and press OK.
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Read GT.STRUDL Results
Read DEX Results
F:\00.5TRUCL Europe

GTI Directory :

Read Joint Displacements

[ |Read Member Forces
[ |Read Section Forces Mumber of Sections: 10
[ |Read Section Displacements Mumber of Sections: 10

Read Finite Element Results

Type of element result : <ALL= W
Surface : <ALL= W
[ |Read Code Check Results
GTI Commands

Corresponding GT STRUDL commands:

DEX BIMNARY -
WRITE REPLACE JOINT RESULTS JOINTS EXISTIMG

WRITE REPLACE AVERAGE ELEMENT STRESSES TOP MIDDLE BOTOM ELEMENTS EXIS
WRITE REPLACE AVERAGE ELEMENT STRAINS TOP MIDDLE BOTOM ELEMENTS EXIST
WRITE REPLACE AVERAGE RESULTANTS TOR MIDDLE BOTOM ELEMENTS EXISTIMNG
WRITE REPLACE AVERAGE ELEMENT PRIMCIPAL STRESSES TOP MIDDLE BOTOM ELET
WRITE REPLACE AVERAGE ELEMENT PRIMCIPAL STRAINS TOP MIDDLE BOTOM ELEM
WRITE REPLACE AVERAGE PRINCIPAL MEMBRAME RESULTANTS TOP MIDDLE BOTONM o,

If you get the following error message at the command prompt:

ERROR Loading Results: The following DBX files cannot be found:
STDBX34 - Strains

STDBX37 - Principal Strains

This message informs you that no Strain results are available to be loaded. You can ignore this
message, since the elements used (SBHQ6) do not give strains as output results.

4.11. Display Results

§ Def d
Step #27. Show Displacements: On the Menu Bar, click on TR (ribbon tab “GTS

Display”) and then select PL as the load Case and press ENTER twice. The deformed structure
will be drawn as shown below.
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“I| Annctate Di splacements |

icon,

Note: You can Annotate the Joint displacements by clicking on the

£ Def d
that is located under the | O in the ribbon and the selecting a joint and annotation
possition.

. i Undef d . “ . ,, . .
Click on |i Undeforme (ribbon tab “GTS Display”) to return to the original undeformed position
of the model.

Another alternative is to click on I 1 Displacements (ribbon tab “GTS Display”).
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Select:
- PL as Load Case

Load Case [ Load Combination - 0.1 as Scale Factor
- 10.00 as Font Size (default)

Displacements

FL & Pressure load ¥ . .
- Annotation Format: Exponential
- Check Hide Model
Display Options
Press “Display >>" to view the deformed
Scale Factor (Values) : 0.100 shape.
. 10,00
Font 5 i = " ” .
ont Size (pt) Press “Annotate >” and click on any part of
Annotation Format: | Exponential v the deformed shape curve and then at the
osition that you want the annotation to be
Decimal Places ; 2 b p' y
displayed.
Hide Model .
Press on “Legend >” and click at any part of
the screen to place the legend of the
Display > diagram.
Annotate = Legend =
Animation Options
Frames : 7
Animation Speed % : 10 ~
Generate Animation i
Frames SR
Clear Close
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Displacements M
Load . PL
Pressure Load

In order to display the animation press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

In order to exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.

Step #28. Show Finite Element Results: Click on M Elements (ribbon tab “GTS Display”) and the
Element Results Form appears.
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Select:

Element Results - Plasload Case
- Resultants as the Type of element
Load Case result
PL & Pressure load v - Mxx as the Moment Resultant to
display
Type - Middle as position (Resultants are
only available for the middle surface
Resultants ¥ of a 2D finite element)
Maxc w and press “Display >>"
Middle W

You can also press the “Annotate >” button

and select joints to display the corresponding
Display Options

values.
Scale Factor (Values) 0.100
Font Size (pt) 10.00
Annotation Format: | Decimal W
Decimal Places 2 v
Display =»
Annotate > Legend =

Animation Options
Frames :

Animation Speed % ; 10 W

Generate Animation
Frames

I
{%1)
m

Clear Close

The multi-colored contour image of the structure is displayed and each color corresponds to a
range of Mxx values as shown in the Legend Form. Type Shade to view the contours in shaded
mode as shown on the next page.

NOTE: Hardware graphics accelaration may cause AutoCAD to incorrectly display the colors of
the contour. In such a case it is recomemded that you turn OFF Hardware Accelartion, during
displaying the stress contours, by typing the command GRAPHICSCONFIG. You can turn it
back ON afterwards.
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A Graphics Performance

Hardware Setup

Video Card: NVIDIA GeForce GTX 660M

Driver Version: 9.18.13.697 Virtual Device: gdi13.hdi{Software])
Effacts Settings

Hardware Acceleration

Disable hardware acceleration only if you are experiencing
graphics issues or have an incompatible video card.

PL M-KM/M

-26.30 ... -23.65
-23E5 .. -21.00
-21.00 ... -18.34
1834 . 1568
-15E9 .. -13.04
1304 . -10.39
1039 773
773608
5.08..-243
243023
023.283
288,653
553..813

In order to display the animation press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

4

To exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.
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4.12. Results Datasheets

Step #29. In addition to the graphical display of results there is an option to view them in
datasheets from the item “Results Datasheets” of the menu/ribbon tab “GTS Display”.

Click on the icon @ Displacements and the “GTSTRUDL — Joint Displacement Datasheet” dialog
appears where you can filter, sort, write results to text file or change results units as shown in
figure below;

8" GTSTRUDL - Joint Displacement Datasheet, display Units: Meters Degrees [m| X
File Edit Columns Filter Sort Units Help
Joint Load Trans X | Trans Y Trans Z Rotation X Rotation ¥ | ~
1 SW 0.0000 0.0000 Q.0000 —0.0000132
2 sW 0.oo000 00000 0.0000 0oo0l1s
3 SW 0.0000 0.0000 Q.0000 [afala] 2]
4 SW 0.0000 0.0000 a.0000 000e0
5 5W 0_0ddoa a_ooaa a_oaaa 00074
€ SW 0.0000 0.0000 Q.0000 00108
7 sW 0.oo000 00000 0.0000 00075
a SW 0.0000 0.0000 Q.0000 00541 00053
sW 0.oo000 00000 0.0000 00309 00440
1a SW 0.0000 0.0000 Q.0000 00478 001393
11 sW 0.oo000 00000 0.0000 004ze oozas
1z SW 0.0000 0.0000 Q.0000 0dz83 00210
13 sW 0.oo0o00 00000 0.0000 00511
14 SW 0.0000 0.0000 Q.0000 oo470
15 SW 0.0000 0.0000 a.0000 0o04zo
1€ 5W 0_0ddoa a_ooaa a_oaaa 00307
17 SW 0.0000 0.0000 Q.0000 00394 000le
13 sW 0.oo000 00000 0.0000 00175 oo173
13 SW 0.0000 0.0000 Q.0000 001zs 000EE
z0 sW 0.oo000 00000 0.0000 o03z1 oooz0
21 SW 0.0000 0.0000 Q.0000 00101
22 sW 0.oo000 00000 0.0000 00Zes
23 SW 0.0000 0.0000 Q.0000 00194
z4 SW 0.0000 0.0000 a.0000 00le4 00071
5 SW 0.0000 0.0000 Q.0000 oodlez 000758
Z€ SW 0.0000 0.0000 Q.0000 0013z 0003E
27 5W 0_0ddoa a_ooaa a_oaaa aooes a00Ez
28 SW 0.0000 0.0000 Q.0000 000073 v
< >

Click on the icon Wl Stresses and the “GTSTRUDL — Average Stresses Datasheet” dialog appears

where you can filter, sort, write results to text file or change results units as shown in figure
below.

B GT STRUDL - Average Stresses Datasheet, display Units: KiloMewtons Meters Degrees O X
File Edit Columns Filter Sort  Units Help
Sorted on: Mot sorted Filter: None
Joint Load Surface | 530 SYY SHY VonMises EM
1 SW Top -75_302 1.757
1 SW Middle -€8_964 -0.187
1 SW Bottom -58.427 -2.131
1 LL Top 1€.373
1 LL Middle 0.225
1 LL Bottom -15.528
1 PL Top -13.717
1 L Hiddle 3.725
1 PL Bottom -4 _T&8 -4g.403 21.175
2 SW Top -g.454 -41.15% -3.870
2 SW Middle -E.T71¢€ -3€.815 -3.170
2 SW Bottom -£.935 -3Z.431 =2.470
2 LL Top -2.938 -40.308 -8.Z212
2 LL Middle -0.010 -0.434 1.038
2 LL Bottom Z.3ls 40.033% lo.z88
2 PL Top -11.€37 -30.198
2 PL Middle -g.8l8 0.775
2 PL Bottom -30.731 -5.938 31.743
3 SW Top -41.443 -2.243
3 SW Middle -36.€09 -2.432 v
< >
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4.13. Report Builder

Report
Step #57. Click on the icon Builder to generate the report of this structure by calling Report

Builder. Report Builder is launched in a separate window. You can find more information on how
creating your report in the GT STRUDL® Report Builder Getting Started Guide (Help Icon on the
right top corner on Report Builders’ window).
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Qo) * - oIl
Home Style -
[ﬁ . @ D D Joint Name: AL Loading: ALL a% ®
Member Name: ALL Level: ALL 3
Open  Generate Image Text  RIF Insert Remove Py Apply Filters to | Format || Help
File Overall Report File v Element Name ALL surface: ALL Checked Items | Options
File Insert Header and Footer Print Filters Format || Help
E} [¢] GTSTRUDL Reports ~
D Centents Load Data
-[#] Model Data
] Groups
[]Joint Coordinates Element Loads
Joint Support Restraints
ppo
~ [ Member Incidences Length: M. Force: KN, Angle: DEG, Temperature: DEGC , Time: SEC
- []Member Properties = =
- []Member/Element Constants
Element Incidences
Element Properties Element Loads (Body Force)
¥ Load Data
- [#] Summary of Loadings Flement | Load Case | Coordinate System | Distribution | Joint BX BY BZ
[ Loading Combinations 1 W GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00 | -2.336e+01
; [‘9 ” 2 SW GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00
[JJoint Loads 3 SW GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00
[[] Member Loads 4 W GLOBAL UNIFORM * | _0.000¢+00 | 0.000e+00
5 W LOBAI UNIFORM * e+l e+l
7] Analysis Results 5 W LOBA] UNIEORM * e -1
-.[]Joint Displacements 7 W LOBAI UNIEORM * el e
[ Support Joint Reactions B W LOBAI UNIFORM i B B
7] Member Forces 5 W GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00
] Section Forces al LOBAI UNIEORM i 2! !
W LOBA] UNIEORM * BT BT
E} [7] Average Element Results = LORA] TNIFORM T . -
-[]Stresses W LOBAI UNIFORM * e+l e+l
-[]Stresses Envelope W LOBAI UNIEORM * 241 e
-[] Stresses Summary W LOBAI UNIEORM * el e
[ Resultants 6 W LOBAI UNIFORM i B B
] Resultants Envelope 17 W GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00
] Resultants Summary B W LOBAI UNIFORM * e el
D] Principai Str 0 W LOBA] UNIEORM * BT BT
esses 0 W LOB: UNIEORM * H 1
[] Principal Stresses Envelope . = SBal TEoR = = i
[ Principal Stresses Summary 22 W GLOBAL UNIFORM * | _0.000¢+00 | 0.000e+00
[ Principal Membrane Resultants 23 SW. GLOBAL UNIEORM * | 0000e+00| 0.000e+00
[ Principal Membrane Resultants Er 2 SW GLOBAL UNIFORM * | 0.000e+00 | 0.000e+00
] Principal Membrane Resultants St 2 W GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00
-[] Principal Bending Resultants 26 W LOBAI UNIFORM * e+l e+l
-[] Principal Bending Resultants Enve %’ ‘:‘ LOBAI UNIFORN . Laa et
] Principal Bending Resultants Sum 2 s Lon Uror - < =
Von Mises 30 W GLOBAL UNIFORM * | 0.0006700 | 0.000:700
[ Van Mises Envelope 31 SW GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00
-[]Ven Mises Summary 32 SW GLOBAL UNIEORM * | _0.000¢+00 [ 0.000e+00
- []Member Results Graphs 33 sW GLOBAL UNIFORM | 0.000e+00 | 0.000e+00
-[] Design of Steel Members 34 W LOBAI UNIFORM * e el
33 W LOBA] UNIEORM * BT BT
36 W LOBAI UNIEORM * el e
37 W LOBAI UNIFORM i B B
38 W GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00 | -2.336e+01
39 SW GLOBAL UNIEORM * | 0.000e+00 | 0.000e+00 | -2356e+01
3 20 sW GLOBAL UNIEORM * | 0.000¢+00 | 0.000e+00 | -2336e+01 .
CAP| NUM| sCRL| ;



5.  Tutorial Example #3

5.1. Introduction

The modeling of a frame structure using CAD Modeler shown below is demonstrated in a step-
by-step process.

5.2.  Open CAD Modeler and start working

Step #1. Launch GT STRUDL by selecting the icon “CAD Modeler” in the Welcome to GT STRUDL
dialog shown below. The version of AutoCAD/BricsCAD selected during the installation will be
automatically launched, together with CAD Modeler’s menus and ribbons.

Welcome to GT STRUDL

B Cpen Learn mare about GT STRUDL () Hide Detaits « = =] 17} -
0 Hedp GT Menu CAD Modeler Command Mode Model Wizard Base Plate Wizard ' | *
R L STRUDL sesign & ke B | CADWorx®
desgn uting 3 praphical usr o7 i e w:.‘r:?m i bass panes A HEXAG ON Analysis St
2 Options tatace Tieeacans s e Emacurs analnt Lang & feite sisrrent anals = PPM
and desgn ppecach
What is GT STRUDL?
""" i i Introduction to GT STRUDL £
View an informative webinar on the new licensing
4 Mt syuergrewﬂed on January 28, 2020 by cheking
tart a Mew Project
A hiriteel seesann of the product that can be wsed a5 an
— FF‘ ﬁh L] X mtroduction to the mast fraquently used features.
¥l q‘-?}w = | N
Webinars
<f> —
_| i / Q= =iy
af Menu CAD Modeles Command Mode Mael Wizard Ease Flate Wizsrd
D htodsling for Stryctural Engin
Working Directory Fabnrury 20, ZMOG
Megiem Lean P i
DRVETUAN Testing\2020-04-27_UTL-U3-22-510TS 2020 ShellM00GY_gti Ca rL-'al-, n":c:';ngi,l,';aslg;-',,':H: :SQE'I“;:;MM; UEI‘"E'I‘EQS 17
Pk k]
Ry T
—_— On-Demand Webingr. GT STRUDL Webinar:
i
Date: December 13, 2048
On-Demand Webinar CT STRUDL Webingr: Lean
Structural Workfigw with Intergraph Sman 30
Recorded Date; Orctober 18, 2093 v
< >
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Step #2. Make sure that CAD Modeler’s ribbons and menus are visible.

@n>
0
@

. 840

If AutoCAD’s/BricsCAD’s menu is not visible, type MENUBAR at AutoCAD’s/BricsCAD’s
command prompt, then 1 and press <ENTER>.

If AutoCAD’s/BricsCAD’s ribbon area is not visible, type RIBBON and press <ENTER>.

Ribbon commands will be used in this tutorial example. However, since all ribbon commands
appear in the menu area, you can use the menu bar as well.

5.3. Define the basic geometry of the model

X Units

Step #3. Define the correct Units by pressing the icon and select Feet (m) and Kips in

the Units Form.

Units >
Length Faorce Angles
() Inches (in) () Poundz (Ibs) (®) Degrees
(®) Feet (ft) (®) Kips () Radians
() Meters {m) ) Tons () Cydes
() Centimeters (cm) () ¥ilograms
(i Millimeters (mm) () Metric Tons Time
Temperature () MNewtons (®) Seconds
() Fahrenheit () KiloMewtons () Minutes
(®) Centigrade () MegaMewtons {_JHours
chle n-:un-struu:t.!ral CAD entities i .
(grids, structural lines, curves etc) Cancel

B

Step #4. Define the one level of the model by pressing the icon L&vels | Press the Add Level
button one time to add a level to your model. Modify the height of the 1% level by selecting the
Height cell of the 1% Level and entering 15.

Note: Some Edit Boxes appear in yellow background and green fonts, like the one at the Level
Heights. You can use mixed units in the yellow edit boxes. For more information about Mixed
Units and the valid syntax please read GT STRUDL GT Menu Guide

Make sure that Z Vertical Axis option is checked and press OK to close the form.
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Level Properties >
Level Heights COptions
Levels Height Elevation | Visible | Addlevel |
1 15.000000 | 15.000000 | [«
| Delete Level |
| Detect Levels Automaticaly |
| Merge Levels |

Base Elevation 0.0000

[#]2 vertical Asis (else ¥)

[Jupdate Levels for All Entities

ok | | cancel

Step #5. Enter a Grid that will help you enter the columns quickly by clicking on the icon 5rid
The grid is going to have 2 (20.4167 ft) spaces in the horizontal direction (X) and 1 space (18 ft)
in the sidelong direction (Y). Enter 20Ft-51n in the Distance text box and press the Add button
2 times. The program will automatically convert the distance of 20ft -5in to 20.4167 ft.

Grid

Placement

(®) Horizontal

Spacing

() sidelong

20,4187
20,4167

Distance: | 204167

Then, click on Sidelong in the Placement
area to enter the spacing in the Y direction,
and enter 18 and Add.

By pressing OK you are prompted (command
prompt) to enter the Insert Point for the
grid. Type 0,0,0 and press <ENTER>.

The grid is created, having its upper left corner A-1 at the point 0,0,0.
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D (] [3

You will be able to view the grid by pressing the Top Icon .

in AutoCAD’s Cube or BricsCAD’s Chair, or preferably by ’ ’

typing Z (for Zoom), E (for Extents) and press TP | E " *

<ENTER>. ' =
Top

Note: In order to be able to snap at the intersection of the grid lines, while placing columns,
make sure that the AutoCAD’s/BricsCAD’s Object Snap is ON, and the Intersection mode is
enabled. Type OSNAP for AutoCAD or right click on “ESNAP” setting for BricsCAD to set the
various snap settings. Shown below is the ObjectSnap tab in AutoCAD’s and BricsCAD’s Drafting
settings dialog.

1
Object Snap On (F3) ] Object Snap Tracking On (F11) Endpoint
Object Snap modes Midpoint
Center
O Endpaiit 0 [ Insertion Select Al Node
— d
A [ Midpoint b [ Pemendicular Clear Al (iadiant
Intersection
[ Center 75 [ Tangent Insertion
Perpendicular
@ [ Node =[] Nearsst Tangent
< [ Quadrant B [ Apparent intersection Nearest
Gecmetric center
s Intersection w I:l Parallel Apparent intersection
|:| B Extension
- ensian
Parallel
~ I«] o
N To track from an Osnap point, pause over the point while in a "
éf command. Atracking vector appears when you move the cursar. off
To stop tracking, pause over the point again. £ Settings..

ESNA

AutoCAD’s Snap Setting BricsCAD’s Snap Settings
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Step #6. Click at Top Front Right of the View Cube (AutoCAD) or Chair (BricsCAD) to change the
view of the model.

Wl e < E * .HE;

allly Top Front Right

AutoCAD’s View Cube for Isometric View BricsCAD’s View Cube for Isometric View

XL

Enter the cross-section profiles that will be used at the model by pressing the icon °&ctions
Click on the AISC 14th Edition 2011 list and then on the W-AISC14 table of profiles. Select the
profile W12x50 that will be used for the columns, by double clicking on it.

B " Profile Browser >
MW A15C 15th Edition 2016 ~ W-AISC15
g ALSC 15: E:!h.'m 2018 TET' & o |[wisxs7 W14x132 W1Zx106 W1Dx33 W5x19
“EJ AISC 15th Edition Spedial Tables for AID85 2 ||y 16,59 W14x120 W12x96 W 10x30 W5x16
#-] AISC 15th Edition Special Metric Tables for A ||y 1545 W 14x 109 W12xa7 W 10x26 W13
=--E] AISC 14th Edition 2011 W16x40 W14x99 W12x79 W10x22
----- T w-AISC14 W1sx36 W14x90 W12x72 W10x19
..... T M/sHP14 W1Bx31 W14x82 W12x55 W10x17
..... [ recHsS 14 W1Gx25 W1dx74 W12x53 W10x15
..... C c-ascid W14x873 W14x68 W12x53 W10x12
..... T wrascia W14x308 Widx61 W 12%50 WEKET
W14x730 W14x53 W12x45 WEx58
""" W LEQ-14 W14x565 W14x43 W12x40 WEx48
----- o L-UN-14 W14x605 W1dx43 W12x35 Wax40
----- v L-ALL-14 W14x550 W1dx33 W12x30 Wax35
..... ar 2-£0-14 W14x500 W14x34 W12x26 Wax31
,,,,, e 2l-14 W14x455 W14x30 W1mx22 WEx28
_____ ——— W1dx426 W14x26 W12x19 Wax24
..... - oLALL14 W1dx398 Widx22 W12x16 Wax21
W14x370 W12x335 W1x14 Wax1s
""" O RDHS514 W1idx342 W12x305 W1i0x112 Wax15
----- I WBEAM-14 W14x311 W12%279 W10x 100 Wax13
----- T wcoL-14 W14x283 W12x252 W10x83 Wax10
-] AISC 14th Edition Metric W14x257 W12x230 W10x77 WEX25
-] AISC 13th Edition 2005 W14x233 W12x210 W10x63 Wex20
5-E] AISC 13th Edition 2005 Metric '.:r 14x211 W12x190 W10x50 WEx15
i £] AISC 3th Edition 1985 W14x193 W12x170 W10x54 WEx15
= W14x176 W12x152 W10x49 Wex12
#-f] AISC LRFD 3rd Edition W14x159 W12x138 W 10x45 Wex3g
EJ'"Q AISC 5th Edition Metric v || W1dx145 W12%120 W10x39 WEXE. 5
< > < >
Cancel
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Member Sections The profile is added to the project and it appears in the left list-

— AISC15th Ediion 2016 A box having a black dot in front of it.
= AISC 15th Edition 2016 Me
= AISC 15th Edition Special Using the same procedure, add 2 additional profiles: W10x45,
= AISC 15th Edition Special | .
=& AISC 14th Edition 2011 for beams and WT6x15 for the bracing from the table
I waiscid WTAISC14. Press OK to close the form.
* W20

® 10445
T WSJHP;; Note: You can add additional profiles at any time by following

L[] RECHSS14 this procedure and also view the full list of profiles used in your
C c-aisci4 _ .
T wialsCle model and add more profiles if needed (left image).
® WTES
~ L-EOQ-14
o LUN-14
v LALL-14
ar 2LEQ-14
ar 214
- 2514
—r 2LALLT4
O RDHS513
T 'wBEAM14
I wiooL14
= AISC 14th Editinn Metric

5.4. Create Columns

i

Step #7. Start entering the columns by clicking on the icon Vertical  The dialog Place Member
appears that helps you to quickly select properties for the members that are going to be
entered.

Cross Section Select W12x50 as the cross section for the
Table Section: columns. Make sure that Material is set to
W1250 W-AISC14 AISC 14th Edition 2011 v Steel, Releases to Fix-Fix and the Beta angle is
or Member Dimensions: 90. There is no need to close this dialog
<Select Shape > W manually.

or 5ame as Member:
Press the “Place Member(s) >>" button.

<Select Existing Member = W
Material Click at the intersection point between line A
aterial
- - and line 1 (point A-1) and the column will be
placed at this position.
Releases Beta (o)
Repeat the same procedure by clicking at the
Fix-Fix v 90 v .
points B-1, C-1, A-2, B-2 and C-2.
When you are done, press ESC to exit the
Vertical column command. The Place
Place Member(s) => Member form is automatically hidden.
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Note: Each time you create a member, the orientation of the cross section will appear in the
middle of the element, unless you clear it with command “Clear” (see 2.6.84).

Step #8. As you can see in the isometric view below, column members 1 to 6 were created
together with joints 1 to 12 at their ends. Each column is 15 ft long, as defined in Level
Properties (height of the first floor).
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]
LS B

&P
¥

n

5
e Ay
12
5
= 5]
/

@
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5.5. Create beams and girders

Y

Step #9. Start entering the beams, along X axis, by clicking on the icon Generate The Place

Member form appears.

Cross Section

Table Section:

W12%50 W-AISC 14 AISC 14th Edition 2011

or Member Dimensions:
=5elect Shape =

or Same as Member;

<Select Existing Member =

Material

Steel

Releases Beta (o)
Fix-Fix W a0

Split Intersecting Members
Split Ending Members

Place Member(s) ==

Physical Member

Select W12x50 as the cross section and
make sure that Material is set to Steel,
Releases to Fix-Fix and the Beta angle is
90. You have to set the Beta angle equal
to 90 degrees in order to orientate the
local Y axis of the W12x50 cross section
along the Z global axis. Make sure that
the option Split Intersecting Members is
checked and then uncheck Split Ending
Members.  Moreover, check the
“Physical Member” option, so that you
also define the physical member and not
only the analytical members.

Press “Place Member(s) >>" button.

Starting Point (x,y,z) message appears,
asking you to enter the coordinates or
click on a specific point on screen. Click
on Joint 2 at the top joint of column 1 at
position A-1.

Then you have to define the Ending Point (x,y,z) so click on Joint 6, as shown in the picture

below.

190



]

=\

¥

=

‘sb’
10 > Jljﬁ

3
/\‘;
= 5]

]
a

AV

Members 7 and 8 will be created.

The two beams along X axis were generated with only two clicks of the mouse: at Joints 2 and 6.
The beam from Joint 2 to Joint 6, was split into two parts, between Joints 2, 4 and 6, since Joints
4 (column at positions B-1) intersect this member.

Since the command is still active, you are prompted to enter the Starting Point (x,y,z), repeat the
same procedure by clicking on Joint 8 (top of column at position A-2), and then click at Joint 12
(top of column at position C-2). Members 9 and 10 will be created.
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Step #10. Enter the beams, along Y axis. The command Generate Beams should be still active,

.

else you can call it again by clicking again on the icon Generate | Keep the same settings at the
Place Member Form, as in the previous step, regarding the cross section and Beta angle, but do
NOT click on Split Intersecting Members. Press the “Place Member(s) >>" button.

The prompt message Starting Point (x,y,z) appears, asking you to enter the coordinates or click
on a specific point on screen. Click on the Joint 8, that is the top of column at position A-2. In
order to define the Ending Point (x,y,z), click at Joint 2 (top of column at position A-1). Member
11 is generated.

Repeat the same procedure by clicking on the Joints 10 and 4 to generate Member 12, Joints 12
and 6 to generate Member 13. Then, press ESC to terminate the command.
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5
12
15
5
417

Step #11. Hide Grid: Since the Grid is no longer needed it can be hidden using
AutoCAD/BricsCAD commands to freeze the layer GRID_LAYER. This can be done by clicking on
the Home Tab and then selecting the GRID_LAYER from the drop down list of layers and clicking

on its freeze icon.

GTS CAD Modeler
.0 File Edit View Insert Settings Tools Draw Dimension Modify Parametric Window Help GTSModeling GTS Display
CREP2I 28 a2 |4DRH0o o £ AW o8 % 57| orafng
"_“ Home Insert Annotate % %Q . 0 Colaborate GTS Modeling GTSL
A Higher Level O Gener{ © %& . Defpoints _IQuad . Find ~
| R units E{EE

<]

GRID_CIRCLES
| om T W Lower Level d Atle T . - Triangle B Change +
&= Materials Levels  Grid u Soil
@ All Levels OM B, Suppol I Reverse Springs % Check -
a2 [ sro_LeTERs
Model Levels Jointg o Shells Foundation | Find/Change/Chedk
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7

Step #12. Split horizontal members: Click on the icon 5plit and click on the members 7,8,9
and 10, and then press <ENTER>.

i

In order to define the Distance for spliting the member or the number of parts (negative
number), enter -5, so that the beams will be split into 5 equal parts.
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Step #13. Turn OFF labeling:

Visible Labels Click on the icon @ Options in the ribbon
_ bar and then uncheck the Visible Labels
[ 30ints option for Joints and Members.
[ IMembers Now labeling is turned off and it is easier
20 Elements and faster to view and control the model.
3D Elements

ANl

] Clear

Press the icon
member:

to remove the informative cross section shapes in the middle of each
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5.6. Create girders

Y

Step #14. Place girder members along Y axis: Click on the icon Generate gnd Place Member form
appears.

Cross Section Select W10x45 W-AISC14 14th
Table Section: Edition 2011 as the cross section
W 10x45 W-AISC14 AISC 14th Edition 2011 W[ | ... and make sure that Material is set

to Steel, Releases to Pin-Pin and
Beta angle is 90. Uncheck Split
Intersecting Members, Uncheck
Split Ending Members and Check
Physical Member

or Member Dimensions:

<Select Shape = W

or Same as Member;

<5Select Existing Member = W
Press the “Place Member >>"
Material button.
Steel W
Click on the Joint located at the
Releases Beta (o) point 1 of the following image.
Click on the joint at point 2 and
e d 20 v the girder member is generated.
[ ] split Intersecting Members [+] Physical Member Having the command still active,

click on the Joints at points 3 and 4
and another girder member is
Place Member(s) == generated.

[ 1split Ending Members

196



Continue by clicking on Joints at points 5 and 6 and another girder member is generated.

Continue by clicking on Joints at points 7 and 8 and another girder member is generated.

Press ESC to terminate the Generate Beam Command.
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Press the icon <& Clear to remove the informative cross section shapes in the middle of each
member.

Step #15. Switch between analytical and physical view.

Turn ON labeling:

Visible Labels Click on the icon %} Options in the ribbon
[ Joints | bar and then check the Visible Labels

option for Members and press OK
[+] Members |

2D Elements

3D Elements

The labels of all members are visible now.

Press the icon = Anebtical/Physical |5 ated in Display at Ribbon Area to switch from Analytical to
Physical View as displayed in the picture bellow.

Analytical View Physical View

Physical Members, with the prefix PM, were generated while placing the analytical member,
since the “Physical Member” option was checked. By double clicking on a Physical Member, in
example PM1, you are able to see its properties, including the set of analytical members that
define it. In example for PM1 the set is: 7,14,15,16,17,8,18,19,20,21 as created by placing the
beam, and splitting it afterwards.
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Physical Member Properties
Model  Section Properties  Member Loads
General Section Properties Releases & Elastic Connection spring values
Mame : Section : | W12x50 W-AISC14 AISC 14th Quick Selection : A
Level: ax: | 0101389] . [8.2%53005| st spring End  Spring
ay: | oosm2| o [ o.0027158] [ | o] Jrx | 0]
Type - Incidences Az | 0.0478815 | Iz: | 0.018856 | DFY | a | DFY | o |
0.00804397 . 0 0 0
Type SR E - Sy: | | Ey: | | [JFz | | [JFz | |
Start 2 5 | 0'03?1528| Bz | D| Cmx | D| Cmx | D|
. 1.01667 . 0.508333
End: 5 Yd: I IYC' I I Cmy | o Ow | 0|
0.673333 0.336667
d: Zc:
Beta Angle : c Cmz | . | Cmz | . |
1.0
Shape Code : | o]
Physical Member |FM1 ape Lode
End Sizes OR Member Eccentricities (Offsets)
Groups Start End
Material Properties
Inactive Remove es: | 0] | 0]
Material : |Steel - Sizes :
Analytical Members
7 " g, | #17ees00s | 0.489543 | x: | o] . | 0]
14
15 . | 1.58399e+006| ) | 1.17e-005 | . | 0 | ) | 0 |
15 G: CTE: e e
17 .
: ¥| | paisson z: | o] 2. | o]
Corcel | [ il

Step #16. Copy Physical Members

Having the physical member view ON the last 4 physical members created will be copied. If the
COPY command is performed on physical members then the physical member is copied with its
set of analytical members. If the COPY command is performed on analytical members, then only
the analytical members are copied, without the physical member definition.

Type AutoCAD/BricsCAD COPY command and when asked to Select objects/entites: click on the
members PM6, PM7, PM8 and PM9. You will get a notification about the selected entities and
press <ENTER>.

In order to Enter base point: click on Point A of the following image.

In order to Enter second point: click on Point B of the following image.
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Press ESC to exit from copy command. Another four girders, as physical members PM10, PM11,
PM12 and PM13, are generated.

™

d
4 1o T
Ny y
Iy
g
3

Switch back to analytical view by pressing the icon = “nebticalPhysical g g +yrn OFF member
labeling (as explained in Step #13).

Press the icon <& Clear
member.

to remove the informative cross section shapes in the middle of each

Step #17. Place bracing members.
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Set ESNAP to Midpoint and not Intersection: Right-click at ESNAP at the bottom of the screen

and deselect “Intersection” and select “Midpoint” option.

"

Endpoint
Midpoint

Center

Mode

CQuadrant
Intersection
Insertion
Perpendicular
Tangent

Mearest
Geometric center
Apparent intersection
Extension

Parallel

On
Off

Settings...

Y

w

Endpoint

~ Midpoint

w

Center

Mode

Quadrant
Intersection
Inserticn
Perpendicular
Tangent

Mearest
Geometric center
Apparent intersection
Extension

Parallel

On
Off

Settings...

Click on the icon Generate and Place Member form appears.
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Cross Section Select W16x15 WTAISC14 14th
Table Section: Edition 2011 as the cross section
WT6x15 WTAISC14 AISC 14th Edition 2011 v | | ... and make sure that Material is set

to Steel, Releases to Pin-Pin and

or Member Dimensions: Beta angle is 0.

<5elect Shape = W
Make sure that the option “Split

or Same as Member: Intersecting Members” is ON, so

«<5elect Existing Member > i that common joints will be created
along the previously created Y-
Material direction girders. Uncheck Physical
Steel LVl [ Member option.
Releases Beta (o) Press the “Place Member >>
button.
PinFin W 0 W
Click on the Joint located at the
[#] 5plit Intersecting Members [|Physical Member point 1 of the following image.

Click on point 3, that will snap to
the middle of the member, and the
Flace Member(s) == bracing member is generated.

Split Ending Members

Having the command still active, click on the Joints at points 2 and 3 and another member is
generated.

Continue by clicking on Joint at point 4 and midpoint 6 and another member is generated.
Continue by clicking on Joints at points 5 and 6 and another member is generated.
Continue by clicking on Joint at point 7 and midpoint 8 and another member is generated.
Continue by clicking on Joints at points 4 and 8 and another member is generated.
Continue by clicking on Joint at point 9 and midpoint 10 and another member is generated.

Continue by clicking on Joints at points 5 and 10 and another member is generated.
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%] Clear

Press ESC to terminate the Generate Beam Command and click on the icon to remove

the informative cross section shapes in the middle of each member.

Step #18. Split Girders
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7

Click on the icon el and click on the members marked as A, B and C, and then press

<ENTER>. In order to define the Distance for spliting the member or the number of parts
(negative number), enter 5, so that the beams will be split at location 5 ft (current length units)
from the start of the members.

Note: Spit command can be used in two different ways. If you enter a negative value (eg. -5), the
member is spit into equal parts (eg. 5 equal parts). The value (absolute part) that you entered is
used to set the number of equal parts. If you enter a positive value (eg 5), then the member is
always spit at two parts, at the point that is 5ft (current length uints) from the start of the
member. The value that you entered is used to set the distance from start.
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Select member marked in D and delete it, by pressing DEL key and then and click on the icon

& Clear to remove the informative cross section shapes in the middle of each member.

Step #19. Add additional members along X

Y

Click on the icon Generate gnd Place Member form appears.
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Cross Section

Table Section:
W 10w45 W-AISC 14 AISC 14th Edition 2011

or Member Dimensions:

<5elect Shape =

or Same as Member:

«5elect Existing Member =

Material

Steel

Releases Beta (o)
Pin-Rin v S0

Split Intersecting Members
Split Ending Members

Flace Member(s) ==

Physical Member

206

Select W10x45 W-AISC14 14th Edition
2011 as the cross section and make sure
that Material is set to Steel, Releases to
Pin-Pin and Beta angle is 90.

Make sure that the option “Split
Intersecting Members” is ON, so that
common joints will be created along the
previously created Y-direction girders.
Check Physical Member option.

Press the “Place Member >>" button.

Click on the Joint located at the point 1
of the following image. Click on the Joint
at point 2 and two members are
generated along X axis.

Press ESC to terminate the Generate
Beam Command.




g

Step #20. Split Girders: Click on the icon 5plit  and click on the member marked in A (of the
following image) and then press <ENTER>.

In order to define the Distance for spliting the member or the number of parts (negative
number), enter 4.5, so that the beam will be split at the location 4.5ft from the start of the
member (see Notes of Step #18 for more information about the split command).
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7

Again, click on the icon 5elit and click on the member B (of the previous image) and then
press <ENTER>. In order to define the Distance for spliting the member or the number of parts
(negative number), enter 9, so that the beam will be split at the location 9ft from the start of the
member (see Notes of Step #18 for more information about the split command).

Click on the icon & Clear to remove the informative cross section shapes in the middle of each

member.
/)

Step #21. Create additional braces: Click on the icon Generate and Place Member form appears.
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Cross Section Select WT16x15 WTAISC14 14th
Table Section: Edition 2011 as the cross section
WTEx15 WTAISC14 AISC 14th Edition 2011 v | | .. and make sure that Material is set

to Steel, Releases to Pin-Pin and

or Member Dimensions: Beta angle is 0.

=5elect Shape = W
Make sure that the option “Split

Ll ies Intersecting Members” is ON and

<Select Existing Member > ¥ “Split Ending Members is also ON.
Uncheck Physical Member option.
Material
Press the “Place Member >>"
Steel W
button.
Releases Beta (o) Click on the Joint located at the
Fin-Fin W ] W point 1 of the previous image. Click
on the Joint at point 2 and the
[] Split Intersecting Members [ | Physical Member brace member is generated.
[#] Split Ending Members Having the command still active,

click on the Joint at point 2 and
midpoint 3 and another brace
member is generated.

Place Member(s) ==

Repeat the same procedure to generate two more members from points 3 to 4 and 4 to 5.

Press ESC to terminate the Generate Beam Command and click on the icon & Clear to remove
the informative cross section shapes in the middle of each member. The created model is
displayed in the following image.
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Step #22. Switch to 3D View

. . Col . .
Click on the icon C Colors to set different colors for each profile.

Color Options

Sections Gmups

Categories
Sections Color Visible
W12%50 161 [v
W10md5 191 [v
WTEx15 [v

Press OK to close the Color Options Dialog. Each cross section will now have a different color.
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Press the icon 97 to display the 3D solid view of the model, replacing the wireframe view:

F
Press the icon A to switch back to wireframe view to be able to process CAD Modeler’s
and AutoCAD’s/BricsCAD’s commands faster.

Step #23. Save your Model: In order to save your model just use AutoCAD’s or BricsCAD’s save
command and store the DWG using any filename that you want.
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Step #24. Change member releases: Press the / Releases icon (in GTS Display Tab of the

ribbon) to show releases for each member.

x) Clear

Click on the icon to clear the annotations and zoom at the area of the following image.

. Releazes | ] '
Again, press the / Release icon to show releases for each member. Click on the icon < Clear

to clear annotations.

1

4%)? A

Yz
(1
%? B

A
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Select member marked in A by double clicking on it and uncheck the My and Mz Releases of the
member at its End. Note that this member belongs to Physical Member PM14.

Member Properties

Model  Section Properties  Member Loads  Member Temperature Loads  Member Distrortions
General Section Properties
Mame : Section : | W10x45 W-AISC14 AISC 14th
Level : s | 0.0923611 | - | 7.282022-005 |
Ay | 0.0245436 | Iy | 0.00257524 |
Type - Incidences Az | 0.0460408 | Iz: | 0.01135%3 |
. 0,007595675 . 1]
Type : SPACEFRAME  ~ Sy | | By: | |
33 Sz | 0.0254144 | Ez: | 0 |
Start -
5 vd: | 0.84166?| ve: | 0420833 |
End:
2 | 0.668333 | 2. | 0334167 |
Beta Ange :
1.0
Shape Code : D
Physical Member |PM14 "
Groups
Material Properties
Inactive Remave
Material : | Steel ~
Groups that Member belongs
P14 £ | 4,176e+006 | Densiw| 0,489543 |
| 1.58399e+006| J— | 1.1?’e-DDS|

G:

posson | 03

®

Releases & Elastic Connection spring values

Quick Selection : ~
Start  Spring End  Spring

OF | °| O | °
Oy | o O | 0]
OF: | ° O | 0]
DMX | D| DMX I D|
MMy | D| [y I D|
vz | o] Owe | e
End Sizes OR. Member Eccentridties (Offsets)

Start End
Sizes : | g | | b |
L | © | W | g |
¥ | g | ¥ | . |
z: | o 2. | 0]
Cancel Apply

By pressing OK, you get an error message, saying that the Physical Member PM14, has its
analytical member 54 (is the member marked in B in the image above) with internal releases at
its start. Physical members are now allowed to have internal releases at their internal joints but
only at their starting and ending joints.

Note: This error can also be located using the Check Physical Member command as well, as
explained in 2.6.26 and this command will be used in a following step.

Error!l!

Physical Member PM14: Ending Member 54 has internal RELEASES at its

start

In order to fix the physical member PM14, select member marked in B by double clicking on it
and uncheck the My and Mz Releases of the member at its Start and press OK.
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Member Properties x

Model  Section Properties  Member Loads  Member Temperature Loads  Member Distrortions

General Section Properties Releases & Elastic Connection spring values
Mame : Section ; W10x45 W-AISC14 AISC 14tk Quick Selection : ~
Level : . | 0.0923611 | I |7.28202e—0[)5 | Start  Spring End  Spring

ay: | ooasses| [ ooozsTsae] [ | o] Jrx | 0]
Type - Incidences AZ: | 0.0460408 | Iz: | 0.0113538 | Cry | o | Cry | o |
Type : SPACEFRAME Sy | o.o07e%eTe | By: | ° | Lre | 0 | Lrz | 0 |
start 34 5z | 0'0284144| Ez: | 0 | [Imx | 0 | [Cmx | a |
. . vd: | 0.84166?'| ves | 0.420833| e | 0| vy | 0|

' |

24 | 0.668333| - 0.33416?|
Beta Angle : ' I

Shape Code :
End Sizes OR Member Eccentricities (Offsets)

Groups Start End
Material Properties

Physical Member |FM14

Inactive m Remove

Material ; | Steel | faee Sizes : | . | | 0 |
Groups that Member belongs
Mg c. | 4,176e+006 | Densiw| 0.489543 | . | 0 | . | 0 |
e | 1.58399e+006| e | 1.17e-005 | v, | 0 | v, | 0 |
Poisson Z: | 0 | Z: | 0 |

Cancel Apply

No errors are reported now.

Select member marked in C by double clicking on it and check the My and Mz Releases of the
member at its Start. Note that this member does not belong to any Physical Member. It was
belonging to PM7, but when a part of it was deleted (Step #18) the PM7 definition was deleted
as well. Press OK to close the properties form.
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Member Properties

Model
General
Mame :
Level :

Type - Incidences

Type: |SPACEFRAME ~
Start 4
End - 18
Beta Arge :

Fhysical Member

Groups
Inactive Remove

Groups that Member belongs

Section Properties

Section Properties  Member Loads  Member Temperature Loads  Member Distrortions

Section : | W10x45 W-AISC14 AISC 14t

i | 0.0923611| - |7.28202&—005|
Ay | 0.0245486| Iy | 0.0025?524|
. | 0.0460403 | - | 0.0119598 |
Sy | 000769676 | - | 0 |
- | 0.0284144| s | o|
vd: | 0.84166?’| ves | 0.420833|
24 | 0.668333| - | 0.33416?|
Shape Code :

Material Properties

Material : |Steel -
c. | 4,176e+006 | Denm| 0.489543|
e | 1.58399e+006| e | 1.17e-005 |

Poisson

Releases & Elastic Connection spring values

Quick Selection : ~
Start  Spring End  Spring
Oe | o] Oex | 0]
Ory | o O | d
OF: | o O | d
Ol | o] Do | 0]
Ry | o Aw | o]
= o] B | °
End Sizes OR Member Eccentricities (Offsets)

Start End
Sizes : | g | | . |
¥ | . | L | 0 |
L | L | ¥ | 0 |
Z: | 0 | Z: | 0 |

Cancel Apply

Fel
Press the / Releases

Click on the icon

x) Clear

g

\\\ﬁ'\ >

wi

to clear annotations.
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5.7. Define supports

Step #25. Create supports: Use AutoCAD’s Cube or BricsCAD’s’ Chair to change the view to

B Support

Front. Press the icon (in GTS Modeling Tab of the ribbon), select all Joints at the

bottom, by clicking at points A and B of the following image, and press ENTER.

At the Joint Properties [Multiple Selection] dialog box select Fx, Fy, Fz and Mz as supports for the
selected joints and press OK.

Joint Properties [Multiple Selection] X

Model  Joint Generalized Loads

General Joint Coordinates and Offsets

Mame : l:l Coordinates
Level: 1 «
A

Z:

1]

Rotation
theta X : Restraints & Spring values
theta ¥ :
Quick Selection : ~
wewz: [ ]
Restraint Spring Restraint  Spring
Groups Fx | | lE‘MX |
Inactive Remove Fy =]y
Groups that joint belongs Fz Mz

concal | [ il
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& Joint Supports

Switch the view to Top Front Right (as in Step #6), and press the icon (in GTS

Display Tab of the ribbon) to view Joints supports.

P
>.

-

-

-

x) Clear

Click on the icon to clear annotations and symbols.

5.8. Define Loads

Step #26. Change UCS: At the command Z
window, type UCS and then give w, to
change to World UCS. "’ﬂ/
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Step #27. Define self-weight: Click on the Self Weight or Dead Loads X
« __ wrees i = . .
icon & 3elf Weight 4 define self-weight Load Information
load case. Glye a Name and a Description. Neme:  [L Y]
Select Negative Z. Descrption : | S¢If Weight
. .. Create Mew 5 Modi Delete
Make sure that the option “Include Finite = ==l =
Elements” is ON. Loads applied parallel to this Global Axis
(O Megative ¥ () Positive Y
@Negaﬁve z OPosih’ve Z
ONegaﬁve X OPosih’ve X
e (A Indude Finite Elements
Cance

5.9. Perform analysis

Step #28. Overview the model and run checks.

B Joints Duplicates
Check for duplicate joints: Click on the icon 2 et , under the “Check” Drop Button,

located in Find/Change/Check at Ribbon Area. For the Merge Tolerance <0.001000>, just press
<ENTER> to accept the default value. You should get the verification that:

0 duplicate joints found
Check for floating joints: In order to check for joints not connected to the model, click on the

icon 'E»JomtEFlmngE , under the “Check” Drop Button, located in Find/Change/Check at Ribbon
Area. If your model was created as described so far, you should get a notification:

0 floating joints found

wma Physical Members

Check Physical Members: Click on the icon , under the “Check” Drop
Button, located in Find/Change/Check at Ribbon Area. ). This check applies to Physical Members
having two or more analytical members. The output should be (press F2 to extend the command
line height and see all of it.

Physical Member PM1: OK
Physical Member PM2: OK
Physical Member PM3: OK
Physical Member PM5: OK
Physical Member PM6: OK
Physical Member PM8: OK
Physical Member PM10: OK
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Physical Member PM14: OK
0 Errors Found

Note: You can also run all other checks of the same drop list, to check for Interference Joints,
Duplicate Members, Zero Length Members, Duplicate Names and Database Integrity. You should
not get any errors or warnings.

View physical members: Click on the icon & Options in the ribbon bar and in the Display
Options Form check Visible Labels for Members, set Font Size for Members equal to 0.5, Set
Shrink Factor to 0.9 and display members as “Physical”.

Display Options >
Visible Objects Visible Labels
Joints - [ Joints
Members - Members |
2D Elements 2D Elements
30 Elements 3D Elements
Label Settings - Font Sizes Ohject Sizes
Joints : 0.820210 Joint : 0.184042
Members ; 0.500000 Load Arrowhead (pts): 10.00000
2D Elements ; 0.820210
D Blements - 0,820210 Display Members [ Elements
i : 0.9 b
Pl ot 10.000000 S_hrlnk Factor :
Aot Famat: T » [ ] Do Mot Display Thickness in 30
Dedmal Places : 2 W Members As: Physical

Press OK to close the form and to see the physical members in wireframe view.
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Click on the icon CE Colors and select the 2" Tab in order to colorize members by their group.
Member do not belonging to any Physical Member are in the “Ungrouped data”. Their default
color is BYLAYER (256), meaning use the color from Display Options Form, but you can set any
other color. Press OK to close the Color Options Form.

Color Options X Display Options *
Sections | Groups visible Objects visible Labels
Categories
Joints - [ 3nints |
Groups Color ‘ Visible =
PM4 50 |7 Members - | Members |
PM35 |7
PME |7 2D Elements | 2D Elements |
PM7 |7 3D Elements | 3D Elements |
PME 130 [
PM9 |7
PM10 |7
PM11 |7
PM12 v
PM13 [v
PM14 21 v
UnGrouped data 256 |7 ©

Mote: If you set a color to 256 (BYLAYER)then the color is defined by the color set
at View > Options Dialog

If a member/shell/joint belongs to mare than one groups, the one that appears last
in this list is the one that defines its” color and visibility

Uncheck ALL Check ALL Reset Colors

Cancel Boply

Now each physical member has a different color and you can also press icon I to display the
3D solid view, as in the image bellow.
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By clicking on the icon = #nabvticalPhysical 'y can switch between physical view (image above)
and analytical view (image below). Note the difference between the physical view, where each
physical member is a single object, and the analytical view, where you can control each
analytical member individually.
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Click on the icon @ Options and turn off labels for members, set shrink factor back to 1.0,
display members as “Analytical” and press OK.

0 Colars

Also cick on the icon and select the 1°* Tab in order to colorize members by their

section and press OK.

& Fram

Press the icon . to switch back to wireframe view.

Step #29. Create input file: Click on the icon to create GTl input file. At the dialog box
“Create GT.STRUDL Input File” check the following and click OK.

e Perform Stiffness Analysis

e Read Joint Displacements

e Read Member Forces

e Read Section Forces

e Read Section Displacements
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Create GT.STRUDL Input File >

Export to GTI
Create GTI File : D:\GTSTRUDL\CAD_Modeler\Examples\Example 3\ Example 3. gti
(®) Export Whole Model () Export Portion of the Model
(will be prompted for Selection)
Perform Stiffness Analysis

Append Other GTI Files/Macros

+
Up
Down
[Jcopy Commands from GTI Files/Macros {not CINPUT)
Create Commands to Read Results
Read Joint Displacements
Read Member Forces
Read Section Forces Number of Sections:
Read Section Displacements Number of Seciions:
[JRead Finite Element Results
[JRead Code Check Results

2 Edit GTI

Step #30. View/edit input file: Click on the icon to view/edit GTl input file.
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E Example3_13.gti - Notepad - m] X

File Edit Format View Help
ETRUDL ' *

% This GTSTRUDL file created from GTS CAD Modeler on Wednesday, 1@ April, 2@19
53

LARGE PROBLEM SIZE 5
SET ELEMENT HASH

UNITS FEET KIPS DEGREES CENTIGRADE SECONDS

JOINT COORDINATES GLOBAL

1 a. +008 @. +2e0 @, +aee
2 a. +280 @. +8e0 1. +@81
3 2.84167BRE+RE1 @.00QBEERE+EER ©.0BRORROE+0ER
4 2.8416700E+001 ©.000BEERE+202 1.S500000BE+08L1
5 4.8B833399E+001 @.0000000E+200 O.0000000E+000
6 4,8833399E+001 @.0000000E+200 1.5000800E+E81
7 a. +888 -1. +Ba1 @, +aa8
8 a. +ee8 -1. +eel 1. +eal
a 2.8416700E+001 -1.3000800E+201 ©.000B0RBE+D00
1le 2.e416700E+001 -1.0000000E+201 1.5000000C+001
11 4,8833399E+001 -1.3000000E+201 O.00000Q0E+E0E
12 4.8B833399E+001 -1.8000000E+201 1.5000000E+881
13 4,B833399E+008 0.0REEEREE+RER 1.5800880E+EA1
14 8.1666801E+000 @.000RGBRRE+200 1.S500B00BE+0G8L1
15 1.2250820E+001 @.000000QE+2G2 1.5000000E+001
16 1.6333360E+001 @.0000EERE+202 1.5000000E+081
17 4.8B833399E+0008 -1.8000000E+201 1.5000000E+881
18 8.16668B1E+R08 -1.3000000E+2081 1.5000000E+081
19 1.2258020E+001 -1.3000800E+201 1.S500000BE+08L1
28 1.5333360BE+001 -1.300800QE+H2A1 1.50008B80E+081
21 2.4500040E+001 @.000000QE+202 1.5000000E+081
22 2.8583380E+001 0.0000000E+202 1.5000000E+081
23 3.2666720E+001 @.0000GEERE+202 1.5000000E+081
24 3.6758059E+001 ©.000REEEE+EG2 1.S500000BE+0G8L1
25 2.450@840E+001 -1.300000QE+H281 1.50008080E+081
26 2.8583330E+001 -1.3000800E+201 1.S500000BE+08L1
27 3.2666720E+001 -1.3000000E+281 1.5000000E+081

Step #31. Execute GT.STRUDL: Click on the icon to perform the stiffness analysis.
GT.STRUDL window will appear with information about analysis.

Srg GT STRUDK 2019 Beta (Hot for commestial uee) - = - O X
File [dt Modeling Anslysic Rewls SteslDesign RC Design Took View Help
DEH-& @8 2 R EDBW - TN

= 0.00 seccnds.

> DEX

S\GTSTR D_Modeler\Examples\Example3tExanpl ' REFLACE
» WRITE REPLACE SECTION FORCES N3 10 AUTOMATIC ‘DiGTSTRUDLACAD Modeler \Exampled\E ied.iat
© INFO_WRSAST SECTION FORCE 3 have been wzitten te file
b Exanpled\L: 1e3_1

far B0 membars and L leads,

¢ INFO_WRSAST -- Time to
= 0,00 s

AD_Modeles\Examples'\Exa=ple3\Example3.09' REFLACE

PO\ GTSTRODLY S

sr\Exanples\ Exampled\Exanpled. 001 MEMHERS EXIS

<+ INFO_WRSASD --

601 SECTION DISPLACEMENT records

" INFD_ WRSASD

S FEET HIPS DEGREES CENTIGRADE

Feet | Wips Degress | Centigrade  Seconds Apl 10, 2019 1:29 PM
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5.10. Read analysis results

%3 Read Results

Step #32. Read GT.STRUDL results: Click on the icon to read GT.STRUDL results.

Read GT.STRUDL Results *

Read DBX Results

GTI Directory : D: \GTSTRUDLVCAD _Maodeler\Examples\Example3

Read Joint Displacements

Read Member Forces

Read Section Forces Number of Sections:

Read Section Displacements Mumber of Sections: !

[JRead Finite Element Results

Type of element result : <ALL=
Surface : <ALL=>
[ read Code Chedk Resuilts
GTI Commands

Corresponding GT STRUDL commands:

DEX BINARY

WRITE REPLACE JOINT RESULTS JOINTS EXISTING

WRITE REPLACE MEMBER. RESULTS MEMBERS EXISTING

WRITE REPLACE SECTIOM FORCES NS 10 AUTOMATIC MEMBERS EXISTING
WRITE REPLACE SECTIOM DISPLACEMENTS GLOBAL NS 10 MEMBERS EXISTING

Cancel

_GTSResultsarl
Results Loaded Successfully

5.11. Display analysis results

Step #33. Graphical display of analysis results: Click on the icon |/ Deformed , under the

“Deformation” Drop Button, located in “Display Results” at Ribbon Area, to display deformed
shape of the model for Self Weight load case and press ENTER two times.
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Select Load Case n

Load Case

s self weight v

A Annotate Displacements

Step #34. Annotate displacements: Click on the icon ©=- , under the
“Deformation” Drop Button, located in “Display Results” at Ribbon Area, to annotate
displacements of the deformed model at specific Joints of interest.
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& Clear 4o clear additional generated symbols. Click on the icon

Click on the icon
: Undef d . .
li Undeforme to display undeformed model again.

Step #35. Display Section Displacements: Click on F'? Displacements (ribbon tab “GTS Display”).
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Displacements

Load Case [ Load Combination

1 & Self Weight W

Display Options
Scale Factor (Values) : 0.100
10.00

Font Size (pt) :

Annotation Format: | Exponential w

Decimal Places : P ~
Hide Model
Display ==
Annotate = Legend =

Animation Options

Frames : 7
Animation Speed % : 1 v
Generate Animation )
Frames Animate ==
Clear Close

Select:
- 1asload Case
- 0.1 as Scale Factor
- 10.00 as Font Size (default)
- Annotation Format: Exponential
- Check Hide Model

Press “Display >>” and zoom at the upper left
end of the structure as shown in the image
below.

Press “Annotate >” and click on any part of
the deformed shape curve and then at the
position that you want the annotation to be
displayed.

Press on “Legend >” and click at any part of

the screen to place the legend of the
diagram.
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Displacements FT
Load @ 1
Self Weight

In order to display the animation, press “Generate Animation Frames” and then “Animate >>".
To terminate the animation press “Stop” button.

In order to exit the command, uncheck “Hide Model”, press “Clear” Button and “Close”.

D
Step #36. View member diagrams: Click on the icon W Hagrams to view member diagrams. In

the dialog box “Member Diagrams”, select MZ Moment as Values, 2 as Decimal Places and click
on “Display”.
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Member Diagrams n

Load Case [Load Combination

[ 15 self weight v]

[JEnvelope I /

Values {1 LY | -
'

v A N

Display Options

.l';l
Scale Factor (Values) 0.100 / -
Font Size {pt) 10.00 é s

Annotation Format: | Decmal d

Decimal Places : 2 i

[JLabel Max &Min ] Positive Sian

Display =>
Annotate = Legend >

Clear Close

You can also annotate moments at specific Joints by clicking “Annotate” in the dialog box
“Member Diagrams” and select the desired precision (decimal places) as well as the annotation
format (decimal, exponential, generic).
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Select “Clear” and “Close” to clear the diagram/annotations and terminate the command.

Bl Displacements

Step #37. Display results in datasheets: Click on the icon , on Results

Datasheets area, to view analysis results in datasheets.
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GTSTRUDL - Joint Displacement Datasheet, display Units: Feet Degrees
File Edit Columns Filter Sort Units Help

- o N

Joint I Load I Trans X I Trans ¥ I Trans Z I Botation X I Rotation ¥ I Rotation Z I
1 1 0.0000 0.0000 0.0000 —-0.0003353 -0.0048571 0.0000000
2 1 0.0000 —-0.0000 —-0.0001 0.0008845 0.0107201 0.00000Z8
3 1 0.0000 0.0000 0.0000 -0.0035857 0.0024511 0.0000000
4 1 0.0000 —0.0000 -0.0001 0.0080282 -0.0051456 0.0000033
=) 1 0.0000 0.0000 0.0000 -0.0004337 0.0012434 0.0000000
3 1 0.0000 —0.0000 —0.0000 0.0008740 -0.0025284 0.0000005
7 1 0.0000 0.0000 0.0000 0.0003335 -0.0050872 0.0000000
a8 1 0.0000 0.0000 —-0.0001 —-0.000&6B842Z 0.0111001 0.0000014
k] 1 0.0000 0.0000 0.0000 0.0033877 0.0025457 0.0000000

10 1 0.0000 0.0000 —-0.0001 —-0.00B80Z74 -0.0052484 0.0000022
11 1 0.0000 0.0000 0.0000 0.0004335 0.0012438 0.0000000
1z 1 0.0000 0.0000 —0.0000 -0.0008738 -0.0025Z80 0.0000013
13 1 0.0000 0.0000 -0.0011 0.0021532 0.0120130 —0.0000007
14 1 0.0000 —0.0000 —-0.0017 0.0038220 0.0044458 —0.00000z22
15 1 0.0000 —-0.0000 —-0.0017 0.0050507 -0.0058013 —0.0000005
1s 1 0.0000 —-0.0000 —-0.000% 0.0085535 -0.011747% —-0.000004%
17 1 0.0000 0.0000 -0.0001 0.008535%8 0.000&018 0.0000072
1a 1 0.0000 0.0000 —0.0001 0.0050423 0.0007&10 —0.0000003
15 1 0.0000 0.0000 -0.000Z 0.00381Z21 0.0013782 -0.000000%
z20 1 0.0000 0.0000 —-0.0003 0.0022431 -0.001545¢& —0.0000012
21 1 0.0000 0.0000 -0.0011 —-0.002152% 0.012&8&8 —0.0000010
2z 1 0.0000 —-0.0000 —-0.0018 —-0.0036215 0.0045080 —-0.0000018
23 1 0.0000 —-0.0000 —-0.0017 —0.0050302 -0.0081876 —0.00000z8
24 1 0.0000 —0.0000 -0.000% —-0.0085588 -0.0120713 0.00000458
25 1 0.0000 0.0000 —0.0001 —0.0085343 0.0005332 —0.000001&
Ze 1 0_0000 0_000a0 -0_0001 -0_0050424 0.0007877 0_000000%
27 1 0.0000 0.0000 —-0.0002 -0.0038117 0.00135%02 —-0.0000014
zs 1 0.0000 0.0000 —-0.0003 —-0.0022428 -0.0015455% —0.0000004
239 1 0.0000 —-0.0000 —-0.0001 0.0000001 0.010&2&7 0.0000055
30 1 0.0000 0.0000 —-0.0001 0.0000001 -0.002455% 0.0000042
31 1 0.0000 0.0000 —-0.0002 0.0042368 0.0012625 —0.0000008
EF3 1 0.0000 0.0000 -0.0002 -0.00423981 0.001z843 -0.0000007
33 1 0_0000 0_000a0 -0_00Z& 0.0118327 0.012Z002 —-0_000008&
34 1 0.0000 —0.0000 —-0.0031 0.0115485 0.0042854 —-0.0000017
35 1 0.0000 —-0.0000 —-0.0032 0.0118804 -0.005758¢6 0.0000170
38 1 0.0000 0.0000 -0.0012 0.0107857 -0.0003520 0.00001&8
37 1 0.0000 0.0000 -0.0012 -0.0107855 -0.0003550 —0.00000%8
38 1 0.0000 —0.0000 —0.0010 0.0000003 -0.00376584 0.0000033

Click on the icon

Member Forces

to view member forces results in datasheets.

- N

L] GTSTRUDL - Member End Force Datasheet, display Units: Feet Kips
File Edit Columns Filter Sort Units Help
Mexber Load Joint Force X I Force ¥ I Force I I Moment X | Moment ¥ Moment Z | ~
1 1 1 z.1786 -0.1308 0.0018 -0.0000 -0.0000 -0.0001
1 1 z -1.4341 0.1308 -0.0018 0.0000 -0.0270 -2.8618
Z 1 2 2.6514 0.0s22 0.0z11 -0.0000 -0.0000 0.0000
Z 1 4 -Z2.9068 -0.0822 -0.0211 0.0000 -0.3170 1.35394
3 1 5 1.4375 0.0481 0.00z23 -0.0000 -0.0000 0.0000
3 1 L3 -0.7530 -0_0481 -0.0023 0.0000 -0.0345 0_6308
4 1 7 2.1738 -0.1375 -0.0018 -0.0000 -0.0000 -0.0001
4 1 a -1.4351 0.1375 0.0018 0.0000 0.0270 -2.9626
s 1 2 3.6544 0.0952 -0.0z11 -0.0000 0.0000 —-0.0000
5 1 10 —-2.909% -0.0952 0.0z11 0.0000 0.3171 l.4z282
L3 1 11 1.4384 0.0482 -0.00z23 -0.0000 0.0000 0.0000
L3 1 1z -0.7533 -0.0482 0.00z23 0.0000 0.0345 0.69Z3
7 1 z 0.1308 1.2581 -0.0000 -0.0008 0.0002 Z_8618
7 1 13 -0.1308 -1.0535 0_.0000 0.0008 -0.0002 1.8538
14 1 13 0.1306 0.4071 -0.0000 -0.0008 0.0002 -1.8537
14 1 14 -0.130% -0.2044 0.0000 0.0008 0.0000 2.10z1
1s 1 14 0.1350% 0.2044 -0.0000 -0.0008 -0.0000 -3.10z1
15 1 15 -0.1308 -0.0017 0.0000 0.o008 0.000Z 3.5Z30
le 1 15 0.1308 —-0.6447 0.0002 -0.0008 -0.0002 -3.52z23
1é 1 18 -0.1308 0.8474 -0.0002 0.0008 -0.0006 0.4787
17 1 16 0.1308 -1.2543 -0.0005 -0.0008 0.0006 -0.4766
17 1 1 -0.1508 1.4570 0.0005 0.0008 0.0014 -5.0588
e 1 4 0.0978 0.s1z3 0.0008 0.0008 -0.0011 2.6590
8 1 17 -0.0375 -0.7039¢ -0.0005 -0.0008 -0.0008 -0.347¢
le 1 17 0.0378 0.2118 -0.0002 0.o008 0.0008 0.3481
18 1 18 -0.037& -0.00%31 0.0002 -0.0008 0.0000 0.1030
z0 1 13 0.0460 0_2453 -0.0000 0.0008 0.0000 -0_6225
zo 1 20 -0.0460 -0.0427 0.0000 -0.0008 0.0000 1.2104
z1 1 20 0.0460 —-0.3643 —-0.0000 0.0008 -0.0000 -1.2104
z1 1 L3 -0.0480 0.5689 0.0000 -0.0008 0.0001 -0.6508
-] 1 -] 0.1375 1.2571 -0.0000 0.o008 0.000Z Z.96Z7
-] 1 Z1 -0.1375 -1.0545 0.0000 -0.0008 -0.0000 1.7568 v

Click on the icon

B Section Forces

to view section forces results in datasheets.
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L] GTSTRUDL - Section Force Datasheet, display Units: Feet Kips = B -
File Edit Columns Filter Sort Units Help

Membe r | Load I Section I Axial | Y shear | Z shear I Torsion | Y bending I Z bending I "
1 1 0.000 0.1s308 -0.001e 0.0000 0.0000 0.0001
1 1 0.111 0.1308 -0_001& a_0000 -0.0030 -0.317%
1 1 0.z2z22 0.1308 -0.0018 0.0000 -0.0080 -0.6353
1 1 0.333 0.1308 -0.0018 0.0000 -0.0030 -0.353%
1 1 0.444 0.1308 -0.0018 0.0000 -0.0120 -1.2713
1 1 0.558 0.1308 -0.0018 0.0000 -0.0150 -1.585%
1 1 0_&&7 0.1308 -0_001& a_0000 -0.0180 -1.307%
1 1 0.778 0.1308 -0.0018 0.0000 -0.0210 -2.2258
1 1 0.gees 0.1308 -0.0018 0.0000 -0.0Z40 —-Z.5438
1 1 1.000 0.1308 -0_001& a_0000 -0.0270 -2 _8618
3 1 0.000 -0.0832 -0.0211 0.0000 0.0000 -0.0000
3 1 0.111 -0.0933 -0.0z211 0.0000 -0.0352 0.1555
F3 1 0.z2z2 -0.0333 -0.0211 0.0000 -0.0704 0.3110
3 1 0.233 -0.0832 -0.0211 0.0000 -0.105% 0.466€5
z 1 0_444 -0.0333 -0.0211 a_0000 -0.140% 0.621%
F3 1 0.558 -0.0333 -0.0211 0.0000 -0.17¢81 0.7774
3 1 0.887 -0.0933 -0.0z211 0.0000 -0.Z113 0.53Z3
z 1 0.778 -0.0333 -0.0211 a_0000 -0_2488 1.0884
3 1 0.ees -0.0832 -0.0211 0.0000 -0.2818 1.2439
3 1 1.000 -0.0933 -0.0z211 0.0000 -0.3170 1.3554
3 1 0.000 -0.0461 -0.0023 0.0000 0.0000 -0.0000
2 1 0.111 -0.04%1 -0.00z2 0.0000 -0.0038 0.0767
3 1 0.z222 -0.0481 -0_0023 a_0000 -0.0077 0.1535
3 1 0.333 -0.0461 -0.0023 0.0000 -0.0115 0.z2303
3 1 -0.0481 -0.00z3 0.0000 -0.0153 0.3070
3 1 -0.0481 -0_0023 a_0000 -0.0132 0.3838
2 1 -0.04%1 -0.00z2 0.0000 -0.0z30 0.4805
3 1 -0.0481 -0.00z3 0.0000 -0.0Z&3 0.5373
3 1 -0.0461 -0.0023 0.0000 -0.0307 0.6141
2 1 -0.04%1 -0.00z2 0.0000 -0.0245 0.63908
4 1 0.1375 0.0018 a_0000 a.0000 0.0001
4 1 0.13975 0.0018 0.0000 0.0030 -0.3231
4 1 0.1375 0.0018 0.0000 0.0080 -0.8583 v

B Reactions

Click on the icon to view reaction results in datasheets.

- - - P - N
L] GTSTRUDL - Joint Reactions Datasheet, display Units: Feet Kips -
File Edit Columns Filter Sort Units Help
Joint I Load I Force X I Force Y I Force Z IHument X IHumen: ¥ Moment Z I
1 1 0.151 -0.242 2.70%9 —-0.000 0.000 0.000
3 1 0.400 -0.021 4.511 -0.000 -0.000 -0.000
5 1 -0.530 -0.237 2.955 -0.000 -0.000 0.000
7 1 0.1s8 0.242 2.710 0.000 —-0.000 -0.000
k] 1 0.352 0.021 4.508 0.000 —-0.000 0.000
11 1 -0.551 0.237 2.957 0.000 —-0.000 -0.000

Step #37. Display results in Report Builder: Click on the icon
Builder.

to view results in Report
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N LFGE)
| Home sy - @
% . @ n D { b, | Joint Name: AL Loading: ALL v @™ @
F ™| Member Name: ALL Level: AL 0
Open  Generate Image Tedt RIF Insert Remove Print ApplyFiltersto | Format || Help
File Overall Report File v Element Name |ALL Surface: |ALL Checked ltems || Options
File Insert Header and Footer Print Filters Format Help
GTSTRUDL Reports ~
[ Contents Analysis Results
. [] Model Data
L] Groups
] Joint Coordinates Joint Displacements
L] Joint Support Restraints
L] Member Incidences Length: FEET. Force: KIP. Angle: DEG, Temperature: DEGC . Time: SEC
] Member Properties = =
[[]Member/Element Constants
] Element Incidences Joint Load X msZ | RotationX | RomtinY | K
] Element Properties 000 00003399 | -0.004897 000
' [ Load Data 023 51 006345 0107201 026
] Summary of Loadings . “;zf;; 491 gg’g
] Loading Combinations T Ty ; 5
- []Joint Loads 3 e D o0 -
- ] Member Loads 7 00 0003399 | 0.005067.
- []Element Loads B 640 | 0.0006842 11001
1. [7] Analysis Resufts 9 00 39877 25457
163 | 00080274 | 0.0052484
- [[] Support Joint Reactions Ll 04335 2498
- [] Member Forces 396 | -0.00087 -0.0023280
] Section Forces b 2 01
6359 22 a5 | 1 7
L] Average Element Results = 5601 s T S
] Member Results Graphs 5 5 027 65595 | i 9
] Design of Steel Members 7 70, 63336 5 2
8 45 50429 7 [ g
9 Al 1 37 K 9
5 1] 000L5: - H
227 o K 9 6363 | 0
1208 7 0.0036213 5 E 8
189 7071  0.0050902 | D.0061676 | 28
g 04 00065588 | 0.012071 8
7 0.0063349 5932 | 5
6 I 0.0050424 7877 g
7 24 0.0036117 3002 | - 4
8 72| 00022428 00015499 | 04 ©

Ready
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6. Appendix — List of Commands

Command

Units

Materials

Sections

Prismatic Sections

Levels

Higher Level

Lower Level

All Levels ON

Grid

Change Grid

Generate Joint

At Level (Joint)

Find (Joint)

Support

Change (Joint)

Generate
(Member)

Icon

N Units

- .
= Materials

XL

Sections

=

Levels
A Higher Level

W Lower Level

&7 All Levels ON

Grid

## Change Grid

B Generate

H At Level

& Find Joint
8 Support
®. Change Joint

Y

Generate

Menu

GTS Modeling>Units

GTS Modeling>Materials

GTS Modeling>Cross
Sections>Table

GTS Modeling>Cross
Sections>Prismatic

GTS Modeling>Levels

GTS Display>All Levels ON

GTS Modeling>Grid>Create

GTS Modeling>Grid>Change

GTS
Modeling>Joint>Generate
Joint

GTS
Modeling>Joint>Generate
Joint at Level

GTS Modeling>Joint>Find

GTS Modeling>Joint>Support

GTS Modeling>Joint>Change

GTS Modeling>
Members>Generate Beam
Members
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Command Prompt

GTSUnits

GTSMaterials

GTSParams

GTSPrismatic

GTSLevels

GTSLevelUp

GTSLevelDown

GTSSetAllVisible

GTSGrid

GTSGridChange

GTSJoint

GTSJointLevel

GTSFJID

GTSJointSupport

GTSJointChange

GTSBeam

Link

N
(o2}
[y

N
(92}
N

N
(o2}
[}

N
(92}
o

N
(92}
w

N
(o2}
w

!\)
<))
w

!\)
<))
w

N
o
>

N
)}
N

N
(o2}
w

N
(o2}
w

N
(92}
()}

N
(o2}
~

N
(o2}
[oe]



Vertical (Member)

Find (Member)

Split (Member)

Split to Crossing

Members

Merge (Member)

Change (Member)

Filter (Members)

Generate Quad

Generate Triangle

Reverse Incidence
Order
Find (Shell)

Change (Shell)

Locate Duplicates

Locate Floating

Joints
Interference

Members
Duplicates

Members Zero
Length

i

Vertical

. Find Member

x Split to Members

"7 Change Member
Y Filter

: : Cuad

d-“'-h Triangle

I Reverse

1] Find Shell

[1 Change Shell

I:|n Joints Duplicates

E Joints Floatings

/ loints Interference
@ Mermbers Duplicates

<§> Members Zero Length

GTS Modeling>
Member>Generate Vertical
Member

GTS
Modeling>Member>Find

GTS
Modeling>Member>Split
Member

GTS
Modeling>Member>Split to
Crossing Members

GTS Modeling>
Member>Merge Members

GTS Modeling>
Member>Change

GTS Modeling>
Member>Filter

GTS
Modeling>Shell>Generate
quad at joints

GTS
Modeling>Shell>Generate
triangle at joints

GTS Modeling>Shell>
Reverse Incidence Order

GTS Modeling>Shell>Find

GTS
Modeling>Shell>Generate
triangle at joints

GTS Modeling>Checks>Joints
Duplicates

GTS Modeling>Checks>Joints
Floatings

GTS Modeling>Checks>Joints
Interference

GTS
Modeling>Checks>Members
Duplicates

GTS
Modeling>Checks>Members
Zero Length
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GTSColumn

GTSFMID

GTSSplitMember

GTSSplitToMembers

GTSMergeMembers

GTSBeamChange

GTSFilterMembers

GTSShell

GTSShellT

GTSShel IReverse

GTSFeid

GTSShelIChange

GTSCheckDuplicateJoints

GTSCheckFloatingJoints

GTSChecklInteferenceJdoints

GTSCheckDuplicateMembers

GTSCheckMembersZeroLength

2.6.12

2.6.14

2.6.17

2.6.17

2.6.18

2.6.19

2.6.20

2.6.24



Physical Members

Shells Duplicates

Names Duplicates

Renumber Names

Database Integrity

1D Curve
(Meshing)

2D 2Curves
(Meshing)

2D 4Curves
(Meshing)

2D Area (Meshing)

3D Extrude
(Meshing)

2D 3Curves
(Meshing)

Array 3D
Advanced

Soil Springs

Export STR

Convert
Lines/Polylines to
Members/Shells

m=o=u Physical Members

Shells Duplicates
Mames Duplicates

BLE

FARE!
.4, Renumber Names

Database Integrity

R

1D
Curve

B .2
2Curves
: B
ACurves
2
Area

4w
N Eoirde

oy, 3D
MC ICurves

Array 30
Adwvanced

i3

Soil
Springs

DXF|Convert Lines to Members

GTS
Modeling>Checks>Physical
Members

GTS Modeling>Checks>Shells
Duplicates

GTS
Modeling>Checks>Names
Duplicates

GTS
Modeling>Checks>Renumber
Names

GTS
Modeling>Checks>Database
Integrity

GTS Modeling>Mesh
Generation>1D Along Line or
Curve or Circle

GTS Modeling>Mesh
Generation>2D Between 2
Lines or Curves

GTS Modeling>Mesh
Generation>2D Between 4
Lines or Curves

GTS Modeling>Mesh
Generation>2D Between 4
Lines or Curves

GTS Modeling>Mesh
Generation>3D Extrude
PolyLine

GTS Modeling>Mesh
Generation>3D Between 3
Lines or Curves

GTS Modeling>Soil Springs

GTS Modeling> CAESAR
II>Export STR

GTS Modeling> Convert

Lines/Polylines to
Members/Shells
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GTSCheckPhysicalMembers

GTSCheckbDuplicateShells

GTSCheckNames

GTSRenumber

GTSCheckDatabase

GTSMesh1D

GTSMesh2D2L

GTSMesh2D4L

GTSMesh2DPoly

GTSExtrudePoly

GTSMesh3D3L

GTSArray3D

GTSFoundationSprings

GTSEXportSTR

GTSDXFRead

2.6.28

2.6.29

2.6.34

2.6.35

2.6.36

2.6.37

2.6.39

2.6.40



Model Wizard

List (Group)

+Joints (Group)
+Members
(Group)
+Shells (Group)
Self Weight
Load Cases
Load
Combinations
Standardized

Combinations

Joint Load

Member Load

Shell Load

Area Load

Wind Load ASCE
705

Wind Load ASCE
710

Seismic Load

Steel Design
Parameters

Create Input File

Edit GTI

_/‘. Madel Wizard

List
:'ij +loints

b=t +Members

i0; +Shells

&t Self Weight
;'El Load Cases

#8 Combinations
% Standardized Combinations

* loint Load
- * 5 Member Load

m Shell Load

¥ 2rea Load
_— Wind Load ASCE 705

==' Wind Load ASCE 710

-4l|lw- Seismic Load

Axsin

GTS

2 Edit GTI

GTS Modeling>Model
Wizard

GTS
Modeling>Groups>Manage

GTS Modeling>Groups>Add
Joints

GTS Modeling>Groups>Add
Members

GTS Modeling>Groups>Add
Shells

GTS Modeling>Loads>Self
Weight

GTS Modeling>Loads>Load
Cases

GTS Modeling>Loads>Load
Combinations

GTS
Modeling>Loads>Standardiz
ed Combinations

GTS Modeling>Loads>Joint
Load

GTS
Modeling>Loads>Member
Load

GTS Modeling>Loads>Shell
Load

GTS Modeling>Loads>Area
Load

GTS Modeling>Loads>Wind
Load ASCE 705

GTS Modeling>Loads>Wind
Load ASCE 710

GTS
Modeling>Loads>Seismic
Load

GTS Modeling>Steel Design
Parameters

GTS Modeling>Create Input
File

GTS Modeling>Edit GTI
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GTSModelWizard

GTSGroups

GTSGroupJoints

GTSGroupMembers

GTSGroupShells

GTSSelfWeight

GTSNewLoadCase

GTSLoadCombination

GTSLoadCombinationStandardized

GTSJointLoad

GTSBeamLoad

GTSShellLoad

GTSArealLoad

GTSWindLoadsASCE705

GTSWindLoadsASCE710

GTSSeismicLoading

GTSSteelDesignParameters

GTSExportGTI

GTSEditGTI

2.6.42

2.6.42

2.6.42

2.6.42

2.6.43

2.6.44

2.6.45

2.6.46

2.6.47

2.6.48

2.6.49

2.6.54

2.6.55

2.6.56



Execute GT
STRUDL

Read Results

Import GTI

Set View

3D View

Analytical/Physical

Frame View

Options (View)

Colors

Annotate

Select

Display Member
Local Axes

Display Member
Releases

Display Shell
Planar Axes

Display Joint
Supports

Display Joint
Loads

Display Member
Loads

Display Shell
Loads

Display Area
Loads

Deformed
Structure

Undeformed
Structure

Annotate
Joint
Displacements

GTS

%5 Read Results
[4 Import GTI

@ Set View

= Analytical/Physical

A Frame
& Options
cl':- Colors

[7] Annotate

B Select

> Member Local Axes
/ Releases

Iif Shell Planar Axes
M Joint Supports
g Joint Loads

.t Member Loads

M Area Loads
I shell Loads
|# Deformed

|| Undeformed

", A Annotate Displacements

GTS Modeling>Execute

GTS Modeling>Read Results

GTS Display>Set View

GTS Display>3D Sections

GTS
Display>Analytical/Physical

GTS Display>Frame

GTS Display>Options

GTS Display>Colors

GTS Display>Annotate

GTS Display>Member Local
Axes

GTS Display> Member
Releases

GTS Display> Shell Planar

Axes

GTS Display> Joint Supports

GTS Display>Joint Loads

GTS Display>Member Loads

GTS Display>Shell Loads

GTS Display>Area Loads

GTS Display>Deformed

Structure

GTS Display> Udeformed
Structure
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GTSExecuteGTI

GTSResultsGTI1

GTSGTIRead

GTSSetView

GTSSet3D

GTSDisplayPhysicalMembers

GTSSetlD

GTSDisplay

GTSColorView

GTSAnnotate

GTSSelect

GTSDisplayLocalAxes

GTSDisplayReleases

GTSDisplayPlanarAxes

GTSDisplaySupports

GTSDisplayJointLoads

GTSDisplayMemberLoads

GTSDisplayElementLoads

GTSDisplayArealoads

GTSDisplayJointDisplacements

GTSDisplayJointDisplacements

GTSAnnotateJointDisplacements

2.6.62

2.6.64

2.6.63

2.6.68

2.6.73

2.6.74

2.6.75



Displacements

Member Diagrams

Finite Element
Results

Finite Element
Results Selection

Member Code
Check Results

Displacements
Datasheets

Member Forces
Datasheets

Section Forces
Datasheets

Reactions
Datasheets

Stresses
Datasheets

Code Check
Datasheets

Report Builder

Clear Results
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